
PLMJobManager: What's New

Date Version User Issue-Nr Categorie Additional Info Type Description

20.11.2025 3,2 S.Gueth GUI UpdDb=No New: Press 'Ctrl + H' in the property collection editor to replace text

07.11.2025 3,2 S.Gueth GUI UpdDb=No Change: implemented new user control for Object Attribute Filters 

to enhance filter capability and match the other object filters

04.11.2025 3,2 S.Gueth CheckBox UpdDb=No New: added new lists for tif merge collection files  

_TcDatasetUidList.txt -> stores all the datase puid from tif merge collection files  

_TcDatasetUidList.txt -> stores all the item reevision IDs from tif merge collection files  

_TcDatasetResultsOverview.csv -> stores the object properties and ppm values for tif merge collection files

04.11.2025 3,2 J.Fes ObjectList UpdDb=No Change: Exception Issue happend when  

Button clicked Object List -> P.Dat -> Res.Msg   

Issue is now solved by code changes

05.09.2025 3,2 S.Gueth GUI UpdDb=Yes Change: added new extended wildcard functionality for CadDataSearch (Drawing Index Search)

02.09.2025 3,2 S.Gueth GUI UpdDb=No Change: changed JobManager UI for correct scaling in windows

15.08.2025 3,2 A.Stein GUI Import Settings UpdDb=Yes 

Check.Settings

Change: Now its possible to turn ImportFs_HashCode on and off in SiteDef Settings 

Implemented by code extensions, for performance gain

15.08.2025 3,2 A.Stein GUI Settings Check.Settings Change: Select OpeFileRule from JobManager GUI

20.05.2025 3,2 S.Gueth GUI ObjectList UpdDb=No New: added view type selection for drawing index search (in Objects list DRW filter) 

Nested -> will view the drawing results as nested items of the objects 

Flat -> will view the drawing results as a flat list together with the object informations

28.03.2025 3,2 S.Gueth JobControl Change: if the path to PLMPerf Settings json file is not available on the JobClient, JobClient won't stop anymore 

JobClient will now print the following message: 

ERR: PLMPerfSettings Load: please check if path to PLMPerf Settings json file is available! 

     PLMPerfSettings Load: Waiting 10 seconds --> try to reload settings

11.03.2025 3,2 J.Fes Settings CheckBox Check.Settings Change: Changed default values for "MD.Volume Deviation Result Rules" in CB Settings 

OK:  0,000 mm^3 - 0,010 mm^3  

WRN: 0,010 mm^3 - 0,100 mm^3 

ERR: 0,100 mm^3 - ...

11.03.2025 3,2 J.Fes Settings CheckBox Check.Settings Change: Changed default values for Component.TranslationMatrix' from 0.00001 mm to 0,001 mm 

OK:   0,000 mm - 0,001 mm 

ERR: >0,001 mm - ...

22.02.2025 3,2 A.Becker CommandLineArgs 

Settings

New: New command line argument "/PLMPerf_Root_DP" for JobClient available. 

Specifies the root directory for the PLMPerfV4 structure. Requires /PLMPerf_ProfileName to be specified. 

Doc Info: If not set, the environment variable %PLMPerf_Root_DP% will be used if available. 

 

#Example: /PLMPerf_Root_DP "V:\JobManager\ProgEntw\Ver03\PLMPerfV4"

18.02.2025 3,2 A.Stein Scripts/Params. 

ObjectJobResults 

Settings JCT CheckBox

Check.Settings Doc: ResultClassification extendet with MultiLine Check (MLC) 

When MultiLine Check (MLC) is activ 

the result analysis is performed on the basis of multiple lines. 

Collection of the lines are done by RegEx pattern criteria 

 

Enhancement implemented by code extensions

04.02.2025 3,2 J.Fes JobControl Ver.Info New: Time Sheduler supports now definition TOVerLap=n (sec)  

 

When for example in Scheduler def TOVerLap=120 is set then TimeScheduler evaluation 

is using 120 sec as MaxTimeOverlab to calulate RightTime(max) 

 

#Exa: [TP=10:30 TOVerLap=120] then LeftTi.me(min)=10:30 .RightTime(max)=10:32 

#Exa:   

#Exa: if TPc=10:31:00 OK is returend -> process will be triggerd because TPc is btw. LeftTime(min) and  RightTime(max) 

#Exa: if TPc=10:29:59 NO is returend -> process will !NOT! be triggerd because TPc is before LeftTime(min) 

#Exa: if TPc=10:32:10 NO is returend -> process will !NOT! be triggerd because TPc is after RightTime(max) 

 

Enhancement implemented by code extensions

18.12.2024 3,2 J.Fes Admin Ver.Info New: -Action "SystemTools_2017_07" -SubAction "UserData*" 

With this methode you can save and restore user data into a File. 

 

List of new SubAction: 

  -UserDataInputByUserAndSaveToFile 

  -UserDataRestoreFromFile 

  

New Methodes are implemented by code extensions
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28.10.2024 3,2 A.Becker CommandLineArgs New: New command line argument "/ServerNameOrIP" for JobClient available. 

Specifies the server to connect to by hostname or ip address.  

 

#Example: /ServerNameOrIP "servername" 

#Example: /ServerNameOrIP "servername.domain.tld" 

#Example: /ServerNameOrIP "192.168.1.53"

28.10.2024 3,2 A.Becker CommandLineArgs New: New command line argument "/PLMPerf_RootL_DP" for JobClient available. 

Specifies the root directory for local work data.  

Doc Info: If not set, the environment variable %PLMPerf_RootL_DP% will be used if available. 

 

#Example: /PLMPerf_RootL_DP "C:\tmp\ProfileX"

28.10.2024 3,2 A.Becker CommandLineArgs New: New command line argument "/PLMPerf_ServerTcpPort" for JobClient available. 

Specifies the port to be used for /PLMPerf_ServerNameOrIP. Default: 36143 if not set. 

Doc Info: If not set, the environment variable %PLMPerf_ServerTcpPort% will be used if available. 

 

#Example: /PLMPerf_ServerTcpPort 12345

28.10.2024 3,2 A.Becker CommandLineArgs New: New command line argument "/PLMPerf_ServerNameOrIP" for JobClient available. 

Alternative for /PLMPerf_Root_DP to specify the PLMPerf service server when no access to the configuration file is available. 

Doc Info: If not set, the environment variable %PLMPerf_ServerNameOrIP% will be used if available. 

 

#Example: /PLMPerf_ServerNameOrIP "plmserver.domain.local" 

#Example: /PLMPerf_ServerNameOrIP "192.168.99.21"

28.10.2024 3,2 A.Becker CommandLineArgs New: New command line argument "/PLMPerf_ProfileName" for JobClient available. 

Specifies the profile to be used within the PLMPerfV4 structure.  

Doc Info: If not set, the environment variable %PLMPerf_ProfileName% will be used if available. 

 

#Example: /PLMPerf_ProfileName "CustomerNameShort"

28.10.2024 3,2 A.Becker CommandLineArgs New: When /PLMPerf_Root_DP and /PLMPerf_ProfileName (%PLMPerf_Root_DP% and %PLMPerf_ProfileName%) are available, 

the JobClient switches to PLMPerf Configuration mode. 

In this mode, the ServerSettingsXML is ignored and the service is parsed from the PLMPerf_config.json instead. 

 

Alternatively /PLMPerf_ServerNameOrIP [/PLMPerf_ServerTcpPort] (or the same named environment variables) can be used.

25.10.2024 3,2 S.Gueth Admin UpdDb=No Change: changed download addresses in updater to new web folders

26.09.2024 3,2 J.Fes ObjectList Ver.Info Doc: Solving Issue exporting Data to Excel list when data in datagrid where listed in 'Group by Row mode'. 

Issue is now solved by code changes 

 

 - more details about export data are printed into InfosSys. 

 - The method for naming export files has been intensively updated. 

   - JobMgr supports now NameSchema as global default  

   - And also defined by Process Groups ExportDocNameSchema 

   - see ProcessGroup -> "Process Group: default 'Name Schema' when exporting data"

18.09.2024 3,2 S.Gueth CheckBox UpdDb=Yes Change: removed 7 columns from Attribute_CheckBoxDataCollection.xlsx file 

Removed Columns: 

CadVerPre 

CadVerPost 

OnSite 

OnComputer 

Date 

Time 

PacketName

17.09.2024 3,2 S.Gueth ObjectList UpdDb=No Change: if you switch the process column without reloading the data, it could happen that sometimes the wrong JobLink / JobLog from a 

different process column has opend 

Issue is now solved by code changes

29.07.2024 3,2 S.Gueth Admin UpdDb=No added new query to get CPU utilization for oracle SQL Server from v$sysmetric_history table
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25.07.2024 3,2 J.Fes Import Sites/Data 

Import ObjectList 

Settings

Ver.Info New: JobServer Enhanced setting for import conditions  

 

see: Sites/Data Import  

       |-> Import Settings 3  

            |-> 1 - Import DS Types 

                |->  1.10-Import Dataset Active 

                |->  1.11-BOM Analyse check if IR has a BOM 

                |->  1.12-BOM Analyse get BOM Data do execute 

 

This methode is implemented to be able to import only Items+Revision metadata 

#Doc: if you set 1.10+1.11+1.12=false then only Item+Revision metadata is imported no BOM Analyses will be done 

New Methode implemented by code extensions

24.07.2024 3,2 J.Fes Reports 

Scripts/Params. 

ObjectList

Ver.Info Change: Application Datagrid enhanced 

- Columes containing Day Data only are now sortable by day value 

- all Columes in datagrids shows summary button

03.07.2024 3,2 J.Fes Ver.Info New: JobClient allows now only to execute one instance at a time 

pointing to same JobClient root directory. 

 

This behaviour avoids:  

 - unexpected JobClient-JobServer communication 

 - unexpected JobResults 

 

In case 2 second start is done:  

 - a beep is emitted  

 - a red message is written to the cmd windows  

 - the cmd window will close after 10 sec or after a key press 

 

Enhancement implemented by code extensions

13.06.2024 3,2 J.Fes Import Sites/Data 

Import

Ver.Info Change: During Data Import/Update IR(n) counter value where always = 1 

For this reason, the estimate of the duration and the  

calculation of the percentages were incorrect. 

 

Issue is now solved by code changes

31.05.2024 3,2 J.Fes Import Sites/Data 

Import

UpdDb=Yes Change: Method for updating selected data in the JobServer has been revised 

 

Now JobServer checks also existing data found in JobMgr.DB. 

With this enhancment the datasync is improved when using. 

 - Objects List -> Extra -> Inport Data of Items/IRs 

 

 

Changed Methode implemented by code extensions

24.05.2024 3,2 J.Fes Import Sites/Data 

Import

Ver.Info Change: JobServer Data Sysnc via  

 -> Sites/Data IMport -> Sync.Site.Data -> 10 - Sync.Site [Irs Only in JM.DB] 

Stoped with Exception convert DBNull into Typ String  

 

Issue is now solved by code changes

09.05.2024 3,2 J.Fes JCT Ver.Info New: -Action "SystemTools_2017_07" -SubAction "StopProcess" 

with this methode you can stop a process base on folowing conditions: 

 

 -StopProcessByPid  

 -StopProcessByProcessName  

 -StopProcessByFileSearch 

  

New Methode implemented by code extensions
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08.05.2024 3,2 J.Fes JCT Ver.Info Change: ProcessTryStop support's now usage of ProcessObj.CloseMainWindow() 

Methode is used in CMM,and in StopProcess  

 

Details:   

 P.Kill.M1 try stop via: ProcessObj.CloseMainWindow() 

 P.Kill.M2 try stop via: ProcessObj.Kill()  

 P.Kill.M3 try stop via: shell: taskkill /F /T /PID #PID#  

 P.Kill.M4 try stop via: shell: wmic process where processid="#PID#" delete  

 Hint:P.Kill.M3 is only used if wmic found on host

26.04.2024 3,2 J.Fes CheckBox Ver.Info Doc: -Action "GB_SAPIntegration_2017_01" -SubAction "GB_SAPNxCBProcessVari1" 

"CB-Step1" now uses NXVer1 

 

Enhancment is implemented in JobMgrCmdTools.exe via code changes

17.04.2024 3,2 J.Fes JCT Ver.Info Doc: -Action "NxDataProcessing_2013_09" -SubAction "NXMacroExecute;NXJournalExecute" 

 search pathes for run_journal.exe ugs_router.exe ugraf.exe updated  

 search pathes are now %UGII_BASE_DIR%\NXBIN;%UGII_NXBIN_DIR%;%UGII_ROOT_DIR%;%UGII_BASE_DIR%\UGII" 

 

changes implemented by code extensions

17.04.2024 3,2 J.Fes DB UpdDb=Yes Doc: JobMgr Database performance optimised, when searching Data via O.need.Update + O.CO.Status 

 |-> 'Object List' -> 'Spec' -> 'O.need Update' 

 |-> 'Object List' -> 'Co'   -> 'O.Check.Out.Status' - And-Or - 'IR.Check.Out.Status' 

  

And Sync/Update data in JobMgr via 

 |-> 'Sites/Data Import' -> 'Sync.Site.Data' -> '30 - Sync.Site [Data with O.Need.Upd]' 

 |-> 'Sites/Data Import' -> 'Sync.Site.Data' -> '31 - Sync.Site [Checked Out Objects Only]' 

 |-> 'Sites/Data Import' -> 'Sync.Site.Data' -> '32 - Sync.Site [DataO.NeedUpd + Checked Out Obj]' 

 

Enhancement is done by create new Index Objects_tbl_IDX46 + Objects_tbl_IDX47 in JobMgr DB

15.04.2024 3,2 S.Gueth GUI ObjectList UpdDb=No Change: behavior for sorted columns in 'Objects List' grid has changed because of performance issues: 

when you have more then 10000 objects loaded and sort the columns, cells with the same value will NOT merge into one big cell 

anymore 

HINT: you can hold Shift + Ctrl Keys while pressing 'Search & List' button to force the cell merging, regardless of the amount 

of objects

25.03.2024 3,2 S.Gueth Settings CheckBox UpdDb=No 

Check.Settings

New: added setting '05.00 CB Data Collection Extension Name (short: #CBDataCollExt#, optional)' in CheckBox config settings  

If defined, this extension name will be added to the data collection directories for 'attribute diffs', 'prototype volume 

diffs' and 'tiff merge collection' 

Example directories and files: 

#JobMgrDataOrg_Root_DP#\#SiteId#_TifMergCollection(#CBDataCollExt#) 

#DataRootDir#\#Site#_DataCollection(#CBDataCollExt#)\Attribute_CheckBoxDataCollection(#CBDataCollExt#).xlsx 

#DataRootDir#\#Site#_DataCollection(#CBDataCollExt#)\GeometricVolumeAnalyse_CheckBoxDataCollection(#CBDataCollExt#).xlsx

18.03.2024 3,2 S.Gueth GUI UpdDb=No New: added new option in JobServer ObjectsList context menu 

copy process data to text window (short) 

copies process data of selected process columns into the text window in a shorter form (only res code, message and extended 

message)

29.02.2024 3,2 S.Gueth CheckBox New: added CB Compair Section CB1Xml and CB2Xml

16.02.2024 3,2 J.Fes Settings CheckBox Ver.Info 

Check.Settings

Doc: CheckBox Manager CheckBox:Compare 

A problem occurred when starting or recalculating data with the CheckBox Manager. 

 

Issue is now solved by code changes

13.02.2024 3,2 A.Stein GUI UpdDb=Yes New: new parameter '/TaskInst' for JobServer 

if set, the taskschedular will only process tasks assigned to TaskInst 

if not set, all tasks without defined TaskInst will be processed 

wildcard (*) and multiple values are valid (seperated by ;) 

 

#Exa: /TaskInst 'TcSync;TcUpdate*'
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13.02.2024 3,2 A.Stein GUI UpdDb=Yes New: new column 'AssignedToTaskInst' for TaskSchedulerDef 

if set, the task will only be processed by the given TaskInstance 

 

#Exa: 

Task with value AssignedToTaskInst='TcSync' -> will only be processed when JobServer Parameter /TaskInst is set to TcSync 

empty column -> will only be processed when JobServer Parameter /TaskInst is not 'defined' or 'empty'

12.02.2024 3,2 A.Stein JobControl UpdDb=Yes New: JobControl -> JobComputer settings extendet 

Now you can manage the AutoReboot mode for each JobClient. 

Please look at: JobControl -> JobComputer -> New Colume: [C.AutoRebootDo]

09.02.2024 3,2 A.Stein New: Enhancement implemented by code extensions 

JobClient Console now prints Information about the Host Uptime and Reboot Requirements 

JobClient -> Press key I

09.02.2024 3,2 A.Stein Ver.Info Change: Shutdown.exe from windows system folder now will be used for rebooting JobServer/JobClient

08.02.2024 3,2 J.Fes JCT Ver.Info Doc: -Action "JobDataEdit_2012_09" -SubAction "JobData2ResultsSetProcessValue+JobData3TempSetProcessValue" 

Is now setting the correct results values for entire JobData ('JobData1ToProcess.xml') 

and save this into JobResult File: 'JobData2Result.xml' 

Issue is now solved by code changes

08.02.2024 3,2 J.Fes JCT Ver.Info Doc: Content in JobResult File: 'JobData2Result.xml' is minimced 

Now about 331 (n) lines less in any JobData2Result.xml  

Optimisation is implemented by code changes

29.01.2024 3,2 S.Gueth Settings UpdDb=No 

Check.Settings

Change: JobMgr Mail Server configuration was moved from 

JobServer -> Extra -> Setup -> 94 - JobManager Mail Server Configurations 

to 

JobServer -> Extra -> 11 - JobManager Mail Server Configurations

19.01.2024 3,2 J.Fes JobControl Ver.Info Doc: JobServer JobControl Methode to generate JobPacketes is optimiced 

Optimisation is implemented by code changes

19.01.2024 3,2 S.Gueth Settings CheckBox UpdDb=No 

Check.Settings

New: added CheckBoxSetting for Entities 

EN.TXT.DisplayValue difference for ignored attributes [Cond:WRN/ERR/NO] 

defines how to evaluate different text display values for entities texts that contains attributes that should be ignored 

this rule is only active when 'EN.Entity ignore attributes defined in '01 PH.Attributes ignore List' is on 

and only for entities that contain attributes that are defined in '01 PH.Attributes ignore List' 

 - DiffReport_as_WRN: Differences will be reported as Waring (default) 

 - DiffReport_as_ERR: Differences will be reported as Error. 

 - DiffReport_NO....: Differences will NOT be reported. Nothing will be written to the report file.

19.01.2024 3,2 S.Gueth Settings CheckBox UpdDb=No 

Check.Settings

New: added CheckBoxSetting for Entities 

EN.Entity ignore attributes defined in '01 PH.Attributes ignore List' [Cond:YES/NO] 

defines if Entity data, that contains attributes in the text blocks, should be ignored when the same attribute is defined in 

the attributes ignore list [Default=false]" + vbCrLf + 

Example:"+vbCrLf+ 

         PH.Attributes ignore List: NX_MassSource"+vbCrLf+ 

                                    BEARBEITER"+vbCrLf+ 

                                    PRKT"+vbCrLf+ 

         Entity 25 Text:"+vbCrLf+ 

                        <Texts>"+vbCrLf+ 

                           <Text>&lt;WREF8*0@PRKT&gt;</Text>"+vbCrLf+ 

                        </Texts>"+vbCrLf+ 

-> this entity 25 will be ignored, because it contains attribute PRKT that is defined in PH.Attributes ignore List" 

   furthermore text value (not display value) has to be equal

10.01.2024 3,18 A.Stein JobControl Settings Check.Settings New: Added JobRules->JobDefExtended2->5.3 Minimum free memory on JC for Job (MB) 

Now its possible to define at JobRule miminum free memory on JobClient to get a new Job. 

#Doc: If the avaialable memory on the JobClient is lower than the defined value, 

      |-> no job of this rule will be send to JobClient.

05.01.2024 3,18 A.Stein JobControl Ver.Info Change: Filtering of JobControl Rules via JC.J.Rule.filter by:'J.JobName' 

now can also be defined in multilines

04.01.2024 3,18 A.Stein GUI UpdDb=No New: Added RowEditTemplate for JobComputers

15.12.2023 3,18 A.Stein GUI UpdDb=No New: The global standard grid layouts can be updated and restored using the View->Save Global functions 

Enhancement implemented by code extensions
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11.12.2023 3,18 J.Fes Import Sites/Data 

Import ObjectList

Doc: When importing TC metadata into JobMgr 

Check: ERR_302_DSHasMultibleCADFiles where missing the count  

how many times the DS contains CADFiles in Dataset Named references. 

 

Issue is now solved by code changes 

 

Also the incorrect spelling is corrected  

from:ERR_302_DSHasMutiCADFiles to:ERR_302_DSHasMultibleCADFiles

11.12.2023 3,18 S.Gueth GUI ObjectList New: in JobManager Objects List you can now select an Object and hold 'P + Ctrl' 

this will print the selected job result of the current selected object 

you select different process columns to switch beween different results 

Hint: 

changed load behavior: Before you could only see the last job result, now you see the selected job result

28.11.2023 3,18 J.Fes ObjectList Ver.Info Doc: During eding Object status and using additonal option 

inc..AP-BOM Component + inc. Data of Item  

JobMgr stopped with an exception message. 

  

Issue is now solved by code changes

24.11.2023 3,18 J.Fes Scripts/Params. Ver.Info Doc: Partupdate process paramter '-compression=compresses/uncompresses' 

is now avilable also for part_utility.exe process

21.09.2023 3,18 A.Stein GUI JobControl 

Settings

UpdDb=No 

Check.Settings

New: Now it's possible to activate automatic reboot when a JobServer/JobClient requires a reboot after windows-update. 

JobClient turns into FinishAndReboot state, so the reboot will not start until all running jobs are processed. 

JobServer will start the reboot after a timespan of 3 minutes. In this timespam the reboot can be canceled interactiv in the 

JobControl-UI 

Settings-Control: Extra->JobServer Active Control->Check Pending Reboot 

New Methode implemented by code extensions

13.09.2023 3,18 J.Fes Import Sites/Data 

Import

UpdDb=Yes Ver.Info Doc: During TC.Data Import/Update process JobServer check's now if ItemId with different  

puid is to insert to JobMgr Database.  

When this happens, the item is updated, the process data is restored and  

attached to the 'new' item. 

This enhancement avoids having duplicate items with same ItemId entries in the JobMgr database. 

 

Note: This issue occurred in TC.Databases where items were deleted and recreated with the same ItemId. 

Enhancement implemented by code extensions

07.09.2023 3,18 J.Fes DB Import Sites/Data 

Import Reports 

ObjectList

Ver.Info Doc: During some JobMgr.DB SQL operation the operations has faild  

because an SQL CommandTimeout were thrown. 

Now JobServer is using MSSQL_DB_CommandTimeout time as set in JobServer configurations. 

Enhancement implemented by code extensions

05.09.2023 3,18 J.Fes Import Sites/Data 

Import

UpdDb=Yes Ver.Info Doc: SiteData 'DataSync' checks now if ItemId is to be removed from JobMgr.DB 

Enhancement implemented by code extensions

25.08.2023 3,18 A.Stein Import Sites/Data 

Import Settings

UpdDb=Yes 

Check.Settings

New: added NativeBackupRoot_DP to SiteDef_cls 

NativeBackupRoot_DP can be used to backup files by dedicated processes 

Enhancement implemented by code extensions

25.08.2023 3,18 A.Stein Settings JCT UpdDb=No 

Check.Settings

New: -Action "PartUtility_2018_04" -SubAction "PartUpdateNativeViaFromToDir" 

 

Enhancement implemented by code extensions 

Added new Cla Parameters NativeBackup_Archiv_DP and NativBackupMethod 

Now its possible to backup files before partupdate 

NativeBackup_Archiv_DP defines the root to copy the files to 

when NativeBackup_Archiv_DP is not set, no backup will be done 

NativBackupMethod defines the folderstructure in the backup root 

possible values for NativBackupMethod: 

ViaPacketName (Default) -> backup files will be copied in #Archiv_DP#/PacketName 

ViaFolderStructure -> whole folderstructure will be recreate in Archiv_DP

14.08.2023 3,18 S.Gueth ObjectList UpdDb=No Change: Object Groups in JobManager have not been updated in the database on changing the user column value 

Issue is now solved by code changes
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10.08.2023 3,18 J.Fes Admin Import 

Sites/Data Import

Ver.Info New: New Methode implemented for checking JobMgr DB Import Performance 

How to Use:  

 - Activtate Extra -> '05 - Log ON/OFF'  

 - Now Log2Console should be active 

 - Start Importing Data  

 - PerfImport SQL File is now generaded in "#JobMgr_Root_DP#\91-

DATA.TempTransfer\JobMgr_Datasets_and_Irs_Import_PerfTest_230810_17h26m.sql"  

 - This SQL contains all sql statments that where used during 'Imnport Process' 

 - Hint:search in Log2Console for 'Datasets_and_Irs_Import SQL.TestFile written in:' ther is the Infor where .sql file is 

written in 

 - Alternative you can open the folder via JobMgr.'File' -> 'Open Folder 91-DATA.TempTransfer' 

 

New Methode implemented by code extensions

02.08.2023 3,18 S.Gueth CheckBox UpdDb=No Change: get correct sheet names for checkbox cgm files (.cgm) 

Issue is now solved by code changes

27.07.2023 3,18 S.Gueth GUI UpdDb=Yes Change: PLMPerfAnalyse tool crashed after generating a new event when visible was not defined 

Issue is now solved by code changes

19.07.2023 3,18 S.Gueth CheckBox New: If extract files are not found on opening CheckBox links via JobManager 

the replacing rules from the JobManager settings will now be used to find the extracted files

13.07.2023 3,18 J.Fes CheckBox Ver.Info Change: -Action "CBTools_2012_05" -SubAction "CBMoveCBFilesToCBArchiv"  

 

CheckBox extract returns for CGM result now  

- how many CGM files where extrated and moved into CBArchiv 

  

#Example 2 CGM's where found [CGM:ff:YES] Extendet Message [CGM:ff:2] 

#Example 0 CGM's where found [CGM:ff:NO] Extendet Message [CGM:ff:0] 

 

Change implemented by code extensions

06.06.2023 3,18 J.Fes Admin JobControl Ver.Info Doc: JobControl support's now use of JobDef.P.Stat(N,M) for setting O.P.Stat values  

 

#Example: if setting JobDef.P.Stat(N,M)='RUN.PStatKey1' is set  

then following Results will be evaluated: 

 

 in case JobResult      O.P.Status will be set to  

    "OK"           =    D.PStatKey1.OK  

    "WRN"  =            D.PStatKey1.WRN  

    "ERR"  =            D.PStatKey1.ERR  

 

intent of this enhancment is that former setting [PStatKey=CB1.3] is not anymore required but still supported 

 

Enhancement implemented by code extensions

06.06.2023 3,18 J.Fes CheckBox Ver.Info Doc: -Action "CBTools_2012_05" -SubAction "CBMoveCBFilesToCBArchiv" 

 

Intensive software recoding where done to support existing and new CheckBox requirements. 

Enhancement implemented by code refactoring

21.04.2023 3,18 S.Gueth GUI UpdDb=No New: added function 'paste from clipboard' into centext menu of grid cells in the JobManager

27.03.2023 3,18 J.Fes CheckBox Ver.Info Doc: -Action "CBTools_2012_05" -SubAction "CBMoveCBFilesToCBArchiv" 

When using new NxCheckBox_*V.2.0.1.35.exe or higher (Example: NxCheckBox_64_CR2212_V.2.0.1.35.exe) 

then CB evaluation has been only evaluate Sections [JC:OK][NX.Syslog.END:OK][Move2Archiv:OK] 

all other sections [PL:OK][UF:OK][UD:OK][PH:OK][MD:OK][AS:OK][DR:OK][EN:OK][CBXml:OK] has been missing. 

Now all sections are avilable again. 

Issue solved by code changes

24.03.2023 3,18 J.Fes JobControl Ver.Info Doc: JobClient StartgUp Control enhanced 

Now it is possible to run multiple JobClients  

on the same JobComputer using the same JobServer instance. 

 

Enhancement implemented by code extensions
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20.03.2023 3,18 S.Gueth GUI UpdDb=No New: added functionality to add or sync an top assembly and its components to JobManager Groups 

group name shema is: AP-{ItemRevOfTopAssembly}_#{counter} 

Example............: AP-4711/A_#001 

 

In JobServer select:  

Objects List -> Extra -> View all Datasets of NXAssembly 

Now there are 3 New options:  

- add Objects to New JobMgrGroup 

- add Objects to existing JobMgrGroup 

- sync Obj's with existing JobMgrGroup

10.03.2023 3,18 S.Gueth Install and Setup UpdDb=No Doc: JobManager Updater enhancements: 

 - added JobManager root directory to title 

 - added button to reload local zip files 

 - zip file size is shown in gui 

 - directly update 10-Documentation.Application folder (nor archiving of this folder anymore)

10.03.2023 3,18 S.Gueth CheckBox UpdDb=No Change: get correct names for checkbox *_zz_NXSection.syslog file by using generic naming method 

Issue solved by code changes

10.03.2023 3,18 S.Gueth CheckBox UpdDb=No Change: get correct names for checkbox archive files (.cgm) by using generic naming method 

issue solved by code changes

10.03.2023 3,18 S.Gueth Settings CheckBox UpdDb=No 

Check.Settings

New: CheckBox Manager' -> 'CB Config' -> '01.3 CB Naming and Compare Setting' 

added option 'NamingV2_ByAutomation' 

 

Get Extract CheckBox File Names and CheckBox Compare Files By Automation 

- Extract CheckBox File Names are set automatically with 'NXVersion' and 'Version Change Info' 

  'Version Change Info' describes if the NXVersion on CheckBox load and NXversion on last save are equal or not 

  Example file Name for CheckBox Extract: Object1_#NX1992_#VCN.xml 

 

- For more information and how it behavs, see description in CheckBox Manager' -> 'CB Config' for: 

  -> '01.3 CB Naming and Compare Setting' 

  -> '02.01.1 CB1 Extract File Identifyer' and '02.04.1 CB2 Extract File Identifyper'

09.02.2023 3,18 A.Stein JobControl UpdDb=Yes New: JobControl -> JobComputer settings extendet 

Now you can set the JobClient in FinishAndReboot Mode from JobServer 

Please look at: JobControl -> JobComputer -> New Colume: [C.Reboot]

16.12.2022 3,17 J.Fes TaskScheduler UpdDb=Yes Doc: Tasksheduler Data definition colume 'ProcessTaskParameterPacket' // 'P.Param' remove 

because this data are not used but needet a lot of resources. 

 

Change implemented by code and SQL Scripts

08.11.2022 3,17 J.Fes ProcessGroups 

Settings

UpdDb=Yes 

Check.Settings

Doc: JobServer: Number of ProcessGroups increased to 40. 

Now 40 generic process groups are avilable. 

Enhancement implemented by code extensions

31.10.2022 3,1602 J.Fes JCT Ver.Info New: -Action "JobDataExtract_2013_10" -SubAction "InputListExtract"  

New option -orderBy is avilabel  

 -orderBy 'NOT' Defines the output file not to order.  

            The contend Is Like as the order in JobData1ToProcess.xml (Default) 

 -orderBy 'DES' Defines if the output file content is in 'descending' order 

 -orderBy 'ASC' Defines if the output file content is in 'ascending' order 

 

This methode can be used to order the output file content 

Enhancement implemented by code extensions

24.10.2022 3,1602 J.Fes JobControl Ver.Info Doc: JobServer -> JobControl JobRules improved 

 

When JobContol-> JobRules do selects Class 'Items' 

and JobRule where using Assembly sort order by Levels/Component where aktive then, 

JobControl rule did end with the Issue that no Job where created. 

The reason for this was that an incorrect SQL was generated for the selection of JobObjects. 

Issue is now solved by code changes.
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20.10.2022 3,1602 J.Fes ObjectList Ver.Info Doc: On delete Data from JobMgr a Messagebox  

where displayed for 'eatch deleted Datarow' 

with Text: 'unable to convert from ('null') to System.Int32' 

 

Now the Messagebox is not displayed anymore 

Issue is solved by code changes

20.10.2022 3,1602 A.Stein CommandLineArgs New: -Action "PartUtility_2018_04" -SubAction "EXTRACT & EVALUATE" 

 

 

Enhancement implemented by code extensions. 

Added Parameter MFKKeyUse to process MFKDate in PU. 

Important: MFK Definitions has to be added in ImportSettings3 for the Site. 

Example: MFKKeyUse=Yes =>  @DB/4911/00 => @DB/%#MFK#%,=item_id=4911,object_type=Z9_DesignStd/00.

18.10.2022 3,1602 S.Gueth JobControl UpdDb=No New: JobControl 'Extendet Process State Control' support's now usage of J.ResMsgExt   

Example: 

  [RuleID=ERR] [O.Type=*] [J.ResCode<>0] [J.ResMsg=*] [J.ResMsgExt=*SUCCESS*] [J.ResWarn=*] [P.Stat=D.ERR] 

[P.Control=DeactivateJobRule]

13.10.2022 3,1602 S.Gueth CheckBox UpdDb=No Change: CheckBox Compare enhanced  

skip ViewPartName check in Drawing Data, if one of the part names is nothing -> in older CheckBox Versions there was no 

partname 

 

Issue is now solved by code changes

11.10.2022 3,1602 S.Gueth Settings CheckBox UpdDb=No 

Check.Settings

New: added setting '03.4 CB Compair File Custom Directory (optional)' in CheckBox Config Settings 

will add a custom directory only for CheckBox Compair file (*CBDif.txt) at the end of the default path 

Example 

C:\root\path\site\12345\1234567\A\#CustomCBCompairDir#\NX12_NX10_CBDif.txt

07.10.2022 3,1602 S.Gueth Settings CheckBox UpdDb=No 

Check.Settings

New: added CB.Config PartHeader Setting 'PH.Attribute do Compare [Cond:YES/NO]' 

defines if all Attribute data is to be compared [Default=True] 

If false entire Attribute Section will !! NOT !! be compared

05.10.2022 3,1602 J.Fes JobControl Ver.Info Doc: JobControl Job generation output optimiced: 

The output now contains fewer messages and is easier to read. 

 

Enhancement implemented by code changes.

27.09.2022 3,1602 S.Gueth GUI UpdDb=Yes New: added ability to set an Event to Visible or Not Visible and to change the Event Color in PLMPerf Analyse

26.09.2022 3,1602 A.Stein GUI ObjectList New: Shortcuts has been added to ObjectList 

ctrl+L => opens J.Log 

ctrl+shift+L => opens JobLink 

ctrl+E => opens ProcState EditWindow

22.09.2022 3,1602 S.Gueth GUI UpdDb=No New: parameter '/DefaultTab' for JobServer 

sets the given tab as the default tab, that is shown on JobServer startup 

possible values: 

ObjectList 

JobControl 

TaskScheduler 

Reports 

Scripts 

ProcessGroups 

Sites 

 

Example: 

/DefaultTab JobControl
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22.09.2022 3,1602 S.Gueth GUI UpdDb=No New: parameter '/TabsVisible' for JobServer 

If set, only given tabs will be visible in the JobServer 

If not set, all tabs will be visible in the JobServer 

multiple values are valid (seperated by char '+' -or- ';' -or- ',') 

possible values: 

ObjectList 

JobControl 

TaskScheduler 

Reports 

Scripts 

ProcessGroups 

Sites 

 

Example: 

/TabsVisible ObjectList+JobControl+TaskScheduler

20.09.2022 3,1602 S.Gueth Install and Setup 

Admin

UpdDb=No Change: changed archiv structure for JobManager Updater

16.09.2022 3,1602 A.Stein CommandLineArgs UpdDb=No New: Now its possible to start PLMPerf with the Parameter -Config 

PLMPerf will use the Settings in the -Config directory (ImportConfig;SettingsGlobal) 

e.g. "..JobMgrStart.cmd -Config addPLM" => 01-PLMPerf.Custom.addPLM

14.09.2022 3,1602 J.Fes JCT Ver.Info New: -Action "JobDataExtract_2013_10" -SubAction "InputListExtract"  

New filters are avilabel via new parameters 

 -includeDataFilter: Defines include filter where #DataFilterFormat#.Value is like 'includeDataFilter' 

 -excludeDataFilter: Defines exclude filter where #DataFilterFormat#.Value is NOT like 'excludeDataFilter' 

 -DataFilterFormat.: Defines the content where include/exclude DataFilter is used to filter the Data 

 

This methode can be used to filter the extracted data from JobData1ToProcess.xml 

Enhancement implemented by code extensions

04.09.2022 3,1602 J.Fes JobControl Ver.Info Doc: JobServer -> JobControl JobRules improved 

 

When JobContol-> JobRules do selects Items 

then Item J.Packet size (count) was not exactly adopted. 

Also it is expected that Item selection performance is improved, 

because the item data SQL could be simplified (Join Revision Data deactivated).

29.08.2022 3,1602 J.Fes CheckBox Ver.Info Doc: -Action "CBTools_2012_05" -SubAction "Compair2XmlFiles" 

 

CheckBox: Assembly find reference component enhanced. 

Now following matching conditions are used for all components 

 

- 1st C1_HandleAndCompProps both comp has same Handle ID + Properties:Matrix+ComponentLevel+Callout+InstanceName 

- 2nt C2_CompProp           both comp has same Properties:Matrix+ComponentLevel+Callout+InstanceName  

- 3rd C3_Handle             both comp has same Handle ID  

- 4th C4_FileProp           both comp has same FileProp:Matrix+File_PN+File_PRN 

 

If 2-components did match then comparation for this 2 matching compoents will be done.

29.08.2022 3,1602 J.Fes Settings CheckBox Ver.Info 

Check.Settings

Doc: -Action "CBTools_2012_05" -SubAction "Compair2XmlFiles" 

 

CheckBox: Compair settings enhanced. 

Now it is posible to contol via CheckBox compare settings: 

  - if Assembly Handle.ID is to be compared [On diff:Default=WRN] 

  - if Assembly Instance.Handle.ID is to be compared [On diff:Default=WRN] 

 

 

If 2-components did match then comparation for this 2 matching compoents will be done. 

Enhancement implemented by code extensions

24.08.2022 3,1602 S.Gueth CheckBox UpdDb=No Change: changed display names in the CheckBox Manager (select combo box) from filename to cli name

23.08.2022 3,1602 S.Gueth Install and Setup UpdDb=No Change: Changed logic of Jobmanager Updater for faster updates and checking for readonly files

22.08.2022 3,1602 S.Gueth New: logged in users for PLMPerf measurement are now fetched from the TeamCenter database by default  

HINT: the TC Site settings must be provided in the JobRule for the perf measurement
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18.08.2022 3,1602 J.Fes JCT Ver.Info Change: NX.syslog section parser optimized 

Now the NX.sections will be better selected and interpreted. 

Also the content is easier to read.  

because Not required Nx.syslog data lines are filtered out.  

 

Also Syslog file naming syntax changed  

 - from: '#CLIName#_zz_NXSyslogSection.txt' 

 - to..: '#CLIName#_zz_NXSection.syslog' 

 

Enhancement implemented by code extensions

09.08.2022 3,1602 J.Fes JCT Ver.Info -Action "PartUtility_2018_04" -SubAction "EVALUATE"  

Resultsection NX.Section PU.NX.Syslog where not correct interpreted   

when TC.Side is defined as MFK site  

Please check new setting '05-Use for MFK Objects - MFKKey for NX.syslog section identification' 

 

Issue is now solved by code changes

05.08.2022 3,1602 J.Fes JCT Ver.Info Change: -Action "CBTools_2012_05" -SubAction "CBMoveCBFilesToCBArchiv"  

Since NxCheckBox V2.0.2.33 (NX CR2007) CB_RunExtractDataLog.txt file content changed 

For this reason CB_RunExtractDataLog.txt section parser needed to be enhanced. 

Now Sections are identifed by Key Start Check at 

 

Issue is now solved by code changes

26.07.2022 3,1602 S.Gueth JCT CheckBox Change: on CheckBox Extract and CheckBox Compair it will be checked if length of object cli name is bigger then 45 chars  

if yes, the puid of object will be added at the front of the extracted xml file and the base name will be cut to 10 

characters 

Example:  

old xml name: PSLL.Forklift_truck_LINDE_like_H100_1200_large_AA_master_PSLL.Forklift_truck_LINDE_like_H100_1200_large-

AA_#NX2206.xml  

new xml name: RoLAlgqpYrm$UB-PSLL.Forkl-AA_#NX2206.xml

25.07.2022 3,1602 S.Gueth JCT CheckBox UpdDb=No Change: added 'Move2Archiv' result section in CheckBox extract process

21.07.2022 3,1602 S.Gueth DB UpdDb=Yes Change: changed length of column 'Value' in datatable 'DrawingIndexingSearch_tbl from length from 2000 to max,pleas update datatable

20.07.2022 3,1602 J.Fes JCT Ver.Info New: -Action "JobDataExtract_2013_10" -SubAction "JobDataList" 

Is new -SubAction "JobDataList" enables you to list JobData contained in JobData1ToProcess.xml.  

Please see also Parameter: '-JobDataFilter_ObjectClass=I,IR,DS,Nativ' 

Please see also Parameter: '-JobDataFilter_SiteOwning=O,R' 

 

New Methode implemented by code extensions

05.07.2022 3,1602 J.Fes JobControl 

Scripts/Params.

Ver.Info Change: JobServer #Variables# extendet with: 

  Variable                         Example: 

  #DateNow#                        10.12.2021 

  #DateTimeNow#                    10.12.2021 11:15         

  #DateTimeNow_DDMMYYYYHMS#        10.12.2021 11:15:20 

  #DateTimeNow_ForSqlServer#       Convert(datetime,'2021-12-10 11:15:24',120)  

  #DateTimeNow_ForFileExtend#      2022-07-05_09h15m24s 

  #DateTimeNow_yyyy-MM-dd-HH-mm#   2022-07-05-09-15 

  #DateTimeNow_yyyyMMdd-HHmmss#    20220705-091524 

  #DateTimeNow_yyyyMMdd#           20220705 

 

The new #Variables# can be used to insert current DateTime into .cmd .txt .sql files JobServer Datum 

 see also 95-JobServer_Scripting_Help\10-JobManagerV3_Docu_Setup_GitterVariablen.txt 

Enhancement implemented by code extensions

04.07.2022 3,1602 J.Fes Admin UpdDb=No New: Executing SQL via SQLCMD support's now SSL Encryption  

IMplemented via adding '-N' to SQLCMD comandline parameter 

 

Enhancement implemented by code extensions

28.06.2022 3,1601 J.Fes ObjectList UpdDb=Yes New: JobServer now analyses if TC Object contains MFK Keys 

Enhancement implemented by code extensions
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28.06.2022 3,1602 J.Fes JCT CheckBox Ver.Info New: CheckBox Compare enhanced  

New setting for disable AUID Check in ViewPartName comperation 

Please see Cat04_DrawingData-> DR.View.ViewPartName check USE AUID Cond[True/False] 

 

Enhancement is implemented by code extensions

12.06.2022 3,1601 J.Fes ObjectList Ver.Info Doc: JobServer did throw an Issue when data has been filterd in Datagrid. 

Issue is now solved by code changes

10.06.2022 3,1601 J.Fes ObjectList UpdDb=Yes Change: JobServer 'Object Liste' -> 'Obj.in.Gr(s)' now sorted 

 

In JobServer 'Object Liste' Data in Colume 'Obj.in.Gr(s)' are now Alpha Numeric sorted. 

Example Data in 'Obj.in.Gr(s)' = GR01, GR10, GR20, GrZZ100 

Enhancement implemented by SQL Script changes --> please Update Database

10.06.2022 3,1601 J.Fes GUI Ver.Info Change: JobServer file menu was reorganized 

Change is done to get more easy to the subdirectory used via PLMJobManager solution 

 

Enhancement implemented by code changes

24.03.2022 3,1601 S.Gueth ObjectList UpdDb=Yes New: You can now edit the ObjectAttribut01..10 directly in the Objectjects list of the JobServer

21.03.2022 3,1601 J.Fes Import Ver.Info Change: JobServer did not read the 'File Size' correct.  

Issue is now solved by code changes

28.02.2022 3,1601 S.Gueth GUI New: Object's can be searched via  

- Process Category

18.01.2022 3,1601 J.Fes Import Sites/Data 

Import ObjectList

UpdDb=Yes Change: JobServer Attributes Definitions enhanced 

 

It is now Posible to define in each AttrDef  

if the Attributes Def is used for 'Item' 'ItemRevision' 'Datasets'. 

More Details please review infos in Sites Attribute def. 

 

Searching data via Attributes values supports now: 

 - on Items Attributes finds data only on Items 

 - on ItemRevision Attributes finds data only on ItemRevision 

 - on Datasets Attributes finds data on Datasets and on ItemRevision 

 

Enhancement implemented by code extensions

29.12.2021 3,1601 J.Fes JCT Ver.Info Change: -Action "CMM2NX_2021_06" -SubAction "CMM_InpListGen" 

Rules for comandline arg '-SkipBOMCheckBeforeCMM_YESNO' is now handelt independet of comandline arg '-force' 

If comandline arg -SkipBOMCheckBeforeCMM_YESNO='NO' then BOM Check result will be used and not anymore overwritten by 

comandline arg '-force' 

 

Hint: if you want to force inserting all Data into CMM input list then please set 

comandline args:  -SkipBOMCheckBeforeCMM_YESNO='YES' and  -force 

 

New Methode implemented by code extensions

22.12.2021 3,1601 J.Fes Import Ver.Info JobServer did not analysed NX.prt via ugpc.exe 

 

Issue is now solved by code changes

16.12.2021 3,1601 A.Stein CommandLineArgs UpdDb=No New: -Action "CMM2NX_2021_06" -SubAction "CMM_InpListGen" 

 Added Commandlineparameter for SubAction CMM_InpListGen: GroupKeyNameForMissingSubComps 

 if GroupKeyNameForMissingSubComps is defined, a Group will be created/updated with all missing SubComps 

Enhancement implemented by code extensions

13.12.2021 3,1601 J.Fes JCT Ver.Info New: -Action "TcExtractData_2013_10" -SubAction "*" 

JobClient gets now automatically deactivated when try to get Data from TC 

but an issue appiears while connecting to TC.DB 

 

Enhancement implemented by code extensions

07.11.2021 3,1601 J.Fes ObjectList Ver.Info Change: JobServer Objects List supports data row hight resizing. 

Each datarow can have individual row hight. 

Enhancement implemented by code extensions
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07.11.2021 3,1601 J.Fes ObjectList 

ObjectJobResults

Ver.Info New: JobServer Objects Liste contains now new Data Colume: P.Time Dur sec 

 

Show values are: 

 If 'P.Time.Start' not set or not valid value = -1 

 If 'P.Time.End'   not set or not valid value = -2 

 If 'P.Time.End > P.Time.Start' is valid = datediff(SECOND,['P.Time.Start'],['P.Time.End']) 

 in any other case value = -3 

 

Enhancement implemented by code extensions

26.10.2021 3,1601 A.Stein Admin Settings JCT Check.Settings Doc: option "Ensuring parsing value" added in result classification rules 

If this property is set to true, it is ensured that the value is parsed from the sourec text.

20.10.2021 3,1601 J.Fes JCT Ver.Info Doc: -Action "TCTools_2019_07" -SubAction "TCPBDataImport" 

Process result evaluation enhanced when Option -NamedRefFileNameSchema is used. 

During result evaluation methode is now searching/checking  

in 'IR' -> 'Dataset' -> 'NamedReference' for referenced NamedRefFile 

 

Enhancement is implemented by code extensions

16.10.2021 3,1601 J.Fes JCT Ver.Info Doc: -Action "CMM2NX_2021_0" -SubAction "CMM_ResultEval" 

Methode to find Object CMMReports.xml improved 

  

Enhancement implemented by code extensions

15.10.2021 3,1601 J.Fes JobControl Ver.Info Doc: JobServer Object need update trigger (before/after the Job) where not correct handelt. 

In case the JobRule setting for  

  'Job Def Extended 2' -> '3.1 New Job Process DataHandel' where set to 'AddEdit0No' 

 

Issue is now solved by code changes

24.09.2021 3,1601 A.Stein Settings JCT Ver.Info 

Check.Settings

New: -Action "CMM2NX_2021_06" -SubAction "CMM_OptionFileEdit" 

 New Option -CMMOpt_TemplateEdit_YESNO avilabel 

if 'YES' then Model,Assembly,Drawing-TemplateNames will be edit in CMM-Optionfile. Default = NO  

 

New Option implemented by code extensions

24.09.2021 3,1601 A.Stein Settings JCT Ver.Info 

Check.Settings

New: -Action "CMM2NX_2021_06" -SubAction "CMM_OptionFileEdit" 

 New Option -CMMTimeOutInMinutes avilabel 

 If this Timespan will be reached the CMM Process will terminate for this Object. 

 When this timeout is reached, then Process-ResCode is set to='CMMLog-004' 

New Option implemented by code extensions

14.09.2021 3,1601 J.Fes JobControl Ver.Info Change: When a new 'JobControl.Rule' is created then Max  

Default values for:   

  AP.O.Min.Comp  'SelObjectsBy_MinComponents' (Old default=0) 

  O.Max.Comp     'SelObjectsBy_MaxComponents' (Old default=6000) 

not set anymore  

 

Change is done by code extensions

26.08.2021 3,1601 J.Fes JCT Ver.Info Change: During result evaluation any R.Msg containing linefeeds (vbCrLf,vbLf)  

will be replaced with following rules  

 - vbCrLf '!CrLf!'  

 - vbLf   '!Lf!'   

 

Enhancement implemented by code extensions

12.08.2021 3,1601 S.Gueth Settings JCT Check.Settings New: -Action "CMM2NX_2021_06" -SubAction "CMM_ResultEval" 

added Fidelity check of CMMReport XML file

28.07.2021 3,1601 J.Fes ObjectList Ver.Info Change: NXBOM_Analyse is now parsing correct pathes from UGII_LOAD_OPTION file  

Issue is now solved by code changes

14.05.2021 3,1503 S.Gueth Scripting New: JobClient will set the number of current running Jobs to the Environment Variable JobMgr_ProcessesJobsN 

this can be used in the JobScripts cmd files

 13 / 73
Release Date/Time: 25.11.2025 08:48

Relase Version: 3.2000.2511.2025



PLMJobManager: What's New

Date Version User Issue-Nr Categorie Additional Info Type Description

21.04.2021 3,1503 J.Fes Import Sites/Data 

Import Settings

Ver.Info 

Check.Settings

New: JobServer TC.Site definitions enhanced 

It is now posible to define TC Table mappings.  

 

Please see settings:  

Sites/ Data Import -> SiteDef -> 7.02 - TC Table mapping 

  

Settings can be used to map to correct project table via define setting  

PPROJECT_LIST=PPROJECT_LIST_0 

  

Enhancement implemented by code extensions

21.04.2021 3,1503 J.Fes Import Sites/Data 

Import

UpdDb=Yes Doc: Site Data Import support now import TC.Project data for 'Items' and 'Item Revisions' 

Befor this enhancment TC.Project data where only supported for TC Datasets  

Enhancement implemented by code extensions

20.04.2021 3,1503 S.Gueth Import Sites/Data 

Import

UpdDb=Yes New: added import filter for projects in: 

Sites/Data Import -> Import Settings 2 -> Import Project Search Names 

you can define project filters for the import

19.04.2021 3,1503 S.Gueth JobControl Settings UpdDb=No 

Check.Settings

New: now you can define email configurations in JobServer under Extra -> 12 - JobManager EMail configurations 

this EMail configs can be used to send EMails for JobControl Aciv Status Rules 

check settings under  Extra -> 09 - JobControl Activ Status Rules Edit

13.04.2021 3,1503 J.Fes Settings JCT Ver.Info 

Check.Settings

Change: -Action "CMM2NX_2021_06" -SubAction "CMM_InpListGen" 

Option -CMM_InpList_DPNE removed and replaced by CMM_InpListMetr_DPNE 

 

Issue is now solved by code changes 

New Methode implemented by code extensions 

Enhancement implemented by code extensions

13.04.2021 3,1503 J.Fes Settings JCT Ver.Info 

Check.Settings

Change: -Action "MigIdeas2NX_2013_10" -SubAction "CMM_InpListGen" 

Option -CMM_InpList_DPNE removed and replaced by CMM_InpListMetr_DPNE 

 

Issue is now solved by code changes 

New Methode implemented by code extensions 

Enhancement implemented by code extensions

12.04.2021 3,1503 J.Fes Settings JCT Ver.Info 

Check.Settings

New: -Action "MigIdeas2NX_2013_10" -SubAction "CMM_InpListGen" 

New rule avilable commandline for CMM commandline options 

  

 -Status_CMMInitial 

 -Status_CMMApproved 

 -Status_CMMFailed 

  

If value is set to 'CMM_Status$NotUsed' then status is not used and not evaluated 

This value is to be set when CMM process do not uses CMM status rules. 

  

Enhancement implemented by code extensions

12.04.2021 3,1503 J.Fes Settings JCT Ver.Info 

Check.Settings

New: -Action "MigIdeas2NX_2013_10" -SubAction "CMM_InpListGen" 

New rule avilable commandline for CMM commandline options 

  

 -Status_CMMInitial 

 -Status_CMMApproved 

 -Status_CMMFailed 

  

If value is set to 'CMM_Status$NotUsed' then status is not used and not evaluated 

This value is to be set when CMM process do not uses CMM status rules. 

  

Enhancement implemented by code extensions

30.03.2021 3,1503 J.Fes ObjectList UpdDb=No Change: Removing Item Data from Groups did end in an exception  

Issue is now solved by code changes

18.03.2021 3,1503 S.Gueth CommandLineArgs 

Settings

Check.Settings New: added JobClient paremeter JobMgr_JCAliasName for JobClient 

defines the name of the current jobclient, if not set, the current computername will be used 

Exa1: /JobMgr_JCAliasName "%Computername%.TCPLMT" 

Exa2: /JobMgr_JCAliasName "%Computername%.TCPLMP"
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16.03.2021 3,1503 J.Fes Import Sites/Data 

Import Settings

Check.Settings New: added new option in: JobServer -> Sites -> ImportSettings 3  

 5.04 - JM-TC.Sync:Check only addNew and to remove Data (Quick Sync) 

 If the value is 'true' Sync will: 

  - only search for new data or data need to be removed 

  - propertys values (LastMod Date..) will not be compared 

 If the value is false this setting is ignored 

 Hint: This setting is desinged for getting fast: 

  - missing data to JobMgr 'chk add new' 

  - remove data from JobMgr not exist in TC anymore

16.03.2021 3,1503 J.Fes Import Sites/Data 

Import Settings

Check.Settings New: added new option in: JobServer -> Sites -> ImportSettings 3  

 5.03 - JM-TC.Sync:include LastSaveDate check 

  If the value is true, LastSaveDate is used when comparing JM.DB with TC.DB data. 

  If the value is false, LastSaveDate is NOT used

03.03.2021 3,1502 S.Gueth GUI ObjectList New: added filter Imp. WRN/ERR Msg. to JobManager Objects List Filter 

  -> Objects List 

      -> Spec 

          -> OImp. WRN/ERR Msg.:

03.03.2021 3,1502 S.Gueth JobControl Settings UpdDb=Yes 

Check.Settings

New: JobControl Rules enhanced  

new setting '3.5: JobMgr Activ Control - Percentage ERR Rate' and '3.6: JobMgr Activ Control - Absolute ERR Count' 

you can define rules to control active status for JobControlRules // ProcessGroups // JobClients // Site 

that rules will be triggered when the percentage/absolute error rate of the Job is higher than the defined value

05.02.2021 3,1502 S.Gueth ProcessGroups 

Settings

Check.Settings New: ProcessGroups Enhanced with new option JobGenreation Active 

Defines if 'JobGeneration' which belonging to Process group is active. 

#Doc:  

if value 'False' no new job will be generated (Default is 'True') 

Hint: 

Process Group must also be active to enable JobGeneration.

04.02.2021 3,1502 S.Gueth JobControl UpdDb=No Ver.Info New: JobControl 'Extendet Process State Control' support's now usage of P.Control definition  

Syntax [P.Control=#RuleName#] 

Can be used to trigger a specific JobControlActivRule that is defined in 'Job Control Rules' -> 'Job Def Extended 2' -> '3.4: 

JobMgr - Activation Status Control' 

Example: 

  [RuleID=ERR] [O.Type=*] [J.ResCode<>0] [J.ResMsg=*] [J.ResWarn=*] [P.Stat=D.ERR] [P.Control=DeactivateJobRule] 

  --> this will trigger the rule 'DeactivateJobRule' when an object has result code <> 0

04.02.2021 3,1502 S.Gueth JobControl Settings UpdDb=No 

Check.Settings

New: JobControl Rules enhanced  

now you can define rules to control active status for JobControlRules // ProcessGroups // JobClients // Sites in a JobControl 

Rule 

this rules will be triggered by "JobControl Rule" -> "Extendet Process State Control" -> [P.Control=#RuleName#] 

Example: 

  [RuleID=ERR] [O.Type=*] [J.ResCode<>0] [J.ResMsg=*] [J.ResWarn=*] [P.Stat=D.ERR] [P.Control=DeactivateJobRule] 

  --> this will trigger the rule 'DeactivateJobRule' when an object has result code <> 0

14.12.2020 3,1502 S.Gueth Import Sites/Data 

Import Settings

UpdDb=No 

Check.Settings

New: added setting '9-Import All Dataset Types' in Sites -> ImportSettings3  

if set to TRUE, all dataset types will be imported (default is FALSE)

09.12.2020 3,1502 A.Stein JCT New: -Action "??" -SubAction "??" 

 

 

Issue is now solved by code changes 

New Methode implemented by code extensions 

Enhancement implemented by code extensions

18.11.2020 3,1502 J.Fes JobControl Ver.Info New: Replacment Variable extendet with 

 - #JobRule.JobName# it replaces JobControlRules J.JobName 

 - #Exa: if used JobRule has Name 'JobUpdatePart' then #JobRule.JobName# is replaced by 'JobUpdatePart'  

 - #JobRule.ProcessDataPState# it replaces JobControlRules 'P.' + 'J.JobName' 

 - #Exa: if used JobRule has Name 'JobUpdatePart' then #JobRule.ProcessDataPState# is replaced by 'P.JobUpdatePart'  

This extendet variable can be used in Extendet JobObject selection 

 

Enhancement implemented by code extensions
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12.11.2020 3,1502 J.Fes Settings JCT Check.Settings New: -Action "PLMPerfSyslogParser_2012_01" -SubAction "ViaNxSyslog" 

 

If in PLMPerfApplication 'Setup Data Import' setting  

Import Type is set to value: 'PerformanceLog with UserCount'  

then this SubAction will also trigger to collect UserCount value 

 

Enhancement implemented by code extensions

14.10.2020 3,1502 S.Gueth JCT UpdDb=No New: -Action "PLMPerfSyslogParser_2012_01" -SubAction "ViaNxSyslog" 

Parameter -importConfigName can now have wildcards 

 

Example: '3* [AL*][4711/A]' 

 

ImportConfigName supports now hashvariables  

 to replace JobManager Object values in -importConfigName 

 

Example: '3* [AL*][#IR.ItemNameRev#]' -> '3* [AL*][4711/A]' 

 

All properties from class ObjectData_cls can be replaced with #PropertyName# 

Example: #ObjectCliName# , #ObjectUgMaster_Type# 

 

All properties from class ObjectData_cls.Ir_cls can be replaced with #IR.PropertyName# 

Example: #IR.ir_puid# , #IR.ItemName# , #IR.Rev# , #IR.ItemNameRev#

01.10.2020 3,1502 S.Gueth CheckBox UpdDb=No Change: Outputformat of CheckBox result report enhanced 

Parthistroy list will now show from the latest part history entry, even if cb1 data has a newer entry then cb2 data

26.08.2020 3,1502 J.Fes JobControl Ver.Info New: Replacment Variable extendet with 

 - #JobRule.ProcStateCol+1# #Exa: if current ProcStateCol05 it return ProcStateCol06 

 - #JobRule.ProcStateCol-1# #Exa: if current ProcStateCol05 it return ProcStateCol04 

 - #JobRule.ProcStateCol+2# #Exa: if current ProcStateCol05 it return ProcStateCol07 

 - #JobRule.ProcStateCol-2# #Exa: if current ProcStateCol05 it return ProcStateCol03 

This extendet variable can be used in Extendet JobObject selection 

 

Enhancement implemented by code extensions

19.08.2020 3,1502 S.Gueth Settings JCT CheckBox Check.Settings New: -Action "CBTools_2012_05" -SubAction "CBMoveCBFilesToCBArchiv" 

Export CheckBox duration times to excel file for PLM Performance Analyse 

Check CBMgrConfig Settings: 

'05.4 CB Durations to CSV for PLMPerf Analyse' 

'05.5 CB Durations CSV File PLMPerf Root Dir (full path)'

17.08.2020 3,1502 S.Gueth JCT CheckBox UpdDb=No Change: -Action "CBTools_2012_05" -SubAction "CBResultGen" 

if a cgm file or tif file is missing on CheckBox Compare, an error will be set to the compair result

14.08.2020 3,1502 S.Gueth Import Sites/Data 

Import Settings

Check.Settings New: added new settings in: JobServer -> Sites -> ImportSettings 3  

 5.01 - JM-TC.Sync:Print Sync Info after N Objects 

   Defines how often an info will be printed to GUI by syncing TC Objects with JobManager 

  17 - TC Objects Packet size on Sync 

   Defines how big the package of TC Objects should be on syncing the TC Site to JobManager

05.08.2020 3,1502 J.Fes JCT Ver.Info Change: -Action "MigIdeas2NX_2013_10" -SubAction "CMM_InpListGen" 

 cmm inputlist.xml element names changed  

 from.: DSpuid 

 to...: dataset  

 #todo: check if format is correct for CMMTypes: 'i-deas ProE SolidWork'   

Change is implemented by code extensions

05.08.2020 3,1502 J.Fes Import Sites/Data 

Import

Ver.Info Doc: Sites/Data Import -> Sync.Site.Data Actions failed with Exception 

when dulicated ID's is found  

Issue is now solved by code changes

05.08.2020 3,1502 J.Fes JCT Ver.Info Change: -Action "CMM2NX_2021_06" -SubAction "CMM_InpListGen" 

 cmm inputlist.xml element names changed  

 from.: DSpuid 

 to...: dataset  

 #todo: check if format is correct for CMMTypes: 'i-deas ProE SolidWork Catia'   

Change is implemented by code extensions
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03.08.2020 3,1502 J.Fes Import Sites/Data 

Import

Ver.Info During Process Sites/Data -> Import * - Sync.Site an Issue happend comparing LastSave Date.  

More data as needet has been identified to sync. 

Issue is now solved by code changes

16.07.2020 3,1501 S.Gueth Import Sites/Data 

Import

UpdDb=No Change: Issue happend on import when Owning Site ID is empty 

Issue is now solved by code changes

02.07.2020 3,1493 S.Gueth Import Sites/Data 

Import

UpdDb=No New: added sync Option in Sites/Data Import -> Sync.Site.Data -> 41 - Sync.Site [Checked Out Objects] 

syncs JM.DB Data that is checked out in TC and finishs Import process 

 

added sync Option in Sites/Data Import -> Sync.Site.Data -> 42 - Sync.Site [Data O.NeedUpd>0 + Checked Out Obj] 

syncs JM.DB Data that has O.Need.Upd flag and is checked out in TC and finishs Import process

02.07.2020 3,1493 S.Gueth Import Sites/Data 

Import

UpdDb=Yes New: New settings in JobServer -> Sites -> ImportSettings 3 -> '4.16 - Set Analyse IR 'is used' in BOM (n) times' 

If set to 0 the count how often the ItemRevsision is used will NOT be analysed (default) 

If set to -1 the count how often the ItemRevsision is used will be imported 

You can define a custom number, until it should be analyzied how often an Item Revision is used  

Hint:As higher the number, as more time is needed to get the count.

02.07.2020 3,1493 S.Gueth Import Sites/Data 

Import

UpdDb=Yes New: added new settings in JobServer -> Sites -> ImportSettings 3 -> 4.15 - Import Check out Info true/false 

If set to true the check out informations on Items, ItemRevisions and Datasets will be imported 

default is true

25.06.2020 3,1493 S.Gueth Settings JCT UpdDb=No 

Check.Settings

New: -Action "MigCmm3D2NX_2013_10" -SubAction "CMM_InpListGen" 

added parameter '-CheckOutStatusAnalyse' 

if set to true, it will be checked if the Dataset, ItemRevision or the BomViewRevision is checked out in Teamcenter 

if any of these 3 items is checked out, thy will not be processed (default is true)

25.06.2020 3,1493 S.Gueth Settings JCT UpdDb=No 

Check.Settings

New: -Action "MigCmm3D2NX_2013_10" -SubAction "CMM_InpListGen" 

added parameter '-CheckOutStatusAnalyse' 

if set to true, it will be checked if the Dataset, ItemRevision or the BomViewRevision is checked out in Teamcenter 

if any of these 3 items is checked out, thy will not be processed (default is true)

24.06.2020 3,1493 S.Gueth DB ObjectList UpdDb=Yes New: added parameters for objects 

O.isCheckedOut 

O.CheckOut.User 

O.CheckOut.Date

22.06.2020 3,1493 S.Gueth Import Sites/Data 

Import

UpdDb=No Change: fixed bug, that import was not interuppted, when tc database was no accessible 

this could lead to the issue, that item revisons whee deleted when tc database dissappeared during the import 

this is now fixed by code changes

16.06.2020 3,1493 S.Gueth JobControl Settings UpdDb=No 

Check.Settings

New: added two JobRule settings in JobControl Rule -> Job Def Extended 2 -> 5 Level Controller Rules 

 

5.1: Inculde Objects only from same level 

Defines if only objects from the same level (minimal level) should be incuded in the jobpacket 

Example: 

Object 1 (Ap with 3 levels) --> include in packet: yes 

Object 2 (Ap with 3 levels) --> include in packet: yes 

Object 3 (Ap with 4 levels) --> include in packet: no  

Object 4 (Ap with 5 levels) --> include in packet: no 

 

5.2: Level controller rules 

defines the level controller rules for the current job (look at description in the rules for detailed information) 

 

5.3: Stop job gen if LevelControlRules apply 

Stops using futher JobRules to generate new Job, if this JobRule finds data but level controller rules lead to the result not 

to generate a new Job

28.05.2020 3,1493 J.Fes ObjectList Ver.Info New: ProE add Data Type  

 SWPrt (SolidWorks-SinglePart) 

 SWAsm (SolidWorks-Assembly) 

 SWDrw (SolidWorks-Drawing)

18.04.2020 3,1492 J.Fes Import Sites/Data 

Import

Ver.Info Change: Importing data for 'Nativ Sites' is now more robust 

Now import contiunes even when during directory cycling Exception happend  

In case an Exception happend an Exception message will be printed into the message box 

 

Issue is now solved by code changes
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10.04.2020 3,1491 J.Fes JCT Ver.Info New: JobClientTools extendet with -Action "RefileNative_2016_02" -SubAction "PartUpdateNative" 

With this Methode it is possible to Update 'Native NXParts'

08.04.2020 3,1491 J.Fes Import Sites/Data 

Import

Ver.Info New: List of Site where not displayed in 'JobServer -> Sites/Data Import'   

If all Site definitions where deactivated. 

 

Issue is now solved by code changes

27.03.2020 3,1491 J.Fes CheckBox Ver.Info Change: Checkbox Manager could not carry out the comparison  

if CheckBox Text Data from Entity_Type25/Entity_Type26 did not contained DisplayedTextValues properties  

Issue is now solved by code changes

25.03.2020 3,1491 J.Fes Import Sites/Data 

Import

Ver.Info Change: TC SiteDef did not created SideDef specific sql  

if for example table 'PNX0APPLICATIONINFOSTORAGE' not exist in TC.DB 

Depending on TC.schema this table is not existing 

New definition is implemnted to turn this case into a waring only information  

Now SiteDef specific sql are created in this case 

 

Enhancement implemented by code extensions

13.03.2020 3,1491 J.Fes JobControl Ver.Info New: JobControl 'Extendet Process State Control' support's now usage of P.StatKey definition  

Syntax [PStatKey=#KeyName#] 

PStatKey can be used for esay generate PStatus for OK/WRN/ERR 

 

#Example: insert into JobControl -> 'Extendet Process State Control' only following P.StatKey definition  

[P.StatKey=R1] 

 then O.PGr.(01..20).PStat will be set if process result 

 - is OK   O.PGr.(01..20).PStat='D.R1.OK'  

 - has WRN O.PGr.(01..20).PStat='D.R1.WRN'  

 - is ERR  O.PGr.(01..20).PStat='D.R1.ERR'  

 

Enhancement implemented by code extensions

12.03.2020 3,1491 J.Fes JobControl Ver.Info New: JobControl 'Extendet Process State Control' support's now  

to set P.Status releative to current P.Group via Condition [P+n.Stat=XX] 

                                                             |-> +n=+1..9 PGroups UP  

#Example: 'Extendet Process State Control' 

[RuleID=OK]   [O.Type=*] [J.ResCode=0]  [J.ResMsg=*] [J.ResWarn=0] [P.Stat=D.OK]  [P+1.Stat=RUN.CB2] 

[RuleID=WRN]  [O.Type=*] [J.ResCode=0]  [J.ResMsg=*] [J.ResWarn=1] [P.Stat=D.WRN] [P+1.Stat=RUN.CB2] 

[RuleID=ERR]  [O.Type=*] [J.ResCode<>0] [J.ResMsg=*] [J.ResWarn=*] [P.Stat=D.ERR] [P+1.Stat=X.CB2] 

 Current Process Group = 'P.02'  

 If condition apply to 'RuleID=OK'  then Object P.Group.Status  P.02=D.OK  // P.03=RUN.CB2 

 If condition apply to 'RuleID=WRN' then Object P.Group.Status  P.02=D.WRN // P.03=RUN.CB2 

 If condition apply to 'RuleID=ERR' then Object P.Group.Status  P.02=D.ERR // P.03=X.CB2 

Enhancement implemented by code extensions

08.03.2020 3,1491 J.Fes Import Sites/Data 

Import Settings

UpdDb=Yes 

Check.Settings

Change: JobServer Native Data improved 

 

Now NX BOM Analyse via NX Utility '%UGII_BASE_DIR%\NXBIN\ugpc.exe' is improved 

Utility is now using the part path search logical implemented by NX load option file.  

To Support this following new Optins are avilabel 

 - BOM Data read from NX.prt 

 - Nativ NX Load Option File 

Following options are now avialabel in 'Sites/Data Import' -> 'Edit Site def.' -> 'Native Settings' 

 - write CAD.MetaData files  

 - Nativ Data Clean -> avialabe in 

 

Enhancement implemented by code extensions

19.02.2020 3,1491 J.Fes JCT Ver.Info Change: -Action "GB_SAPNxCBProcess" -SubAction "GB_SAPNxCBProcess*" Option: -COLocCiMode "TestMode" 

 

If Option: -COLocCiMode "TestMode" has been used then SAP Unlog has been used if Process lead to issue. 

Now if TestMode is active then SAP Unlog is not used anymore 

Issue is now solved by code changes
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05.02.2020 3,1491 J.Fes Import Sites/Data 

Import

UpdDb=Yes New: Site/Data Import enhanced: 

Now JobMgr support on TC Sync (Item/ItemRevision): 

 1. Object 'Last Save Date' 

 2. Object 'Last Mod User' 

 3. Object 'Owing Groups'  

 

1*  'Last Save Date' for Item/ItemRev/Datases are stored in JM.DB. 

     With this extension syncronisation between JobMgr.DB and TC.DB is optimiced. 

     Because in some TC-Tools/Methodes TC do not update LastMod date but 

     a change is registerd in LastSavDate 

Hint 'Last Save Date' is avilable for TC.Site with Teamcenter Unified Architeture (TCUA) 

 

Enhancement implemented by code extensions

03.02.2020 3,1491 J.Fes JobControl Settings Ver.Info 

Check.Settings

New: JobControl rule do supports also selection criteria for sel: O.IrType 

Job Control -> Edit JobControl Rules -> Job Def Extended 1 -> sel: O.IrType 

Enhancement implemented by code extensions

29.01.2020 3,1491 S.Gueth GUI Scripts/Params. New: added Button to edit result classifications in Scripts/Params 

Result Classification files must be in the ClientScript folder or in any subfolder 

Result Classification files must have one of the following formats: 

*ResultClassification*.xml 

*ResClRule*.xml 

*ClRule*.xml

15.01.2020 3,1491 J.Fes JobControl Ver.Info Change: JobControl Rules Generating JobPacket's performance optimiced   

 

- New posibility to define in JobRule if JobData selection is using 'ORDER' methodes. 

  #Doc: see settings in:  

        'Edit JobControl Rule' -> 'Job Def Extended 2' -> '4 Job Object Selection Rules -> 4.0..4.4' 

  #Doc: In the case that JobData order not needed in the JobProcessing sequence, this option can be switched off. 

        This will accelerate the creation of jobs. 

        Usage example:  Switch off 'Order'  

                        If order Then Of Singleparts - Assembly Parts has no impact On JobProcessing sequence 

 

- Object selection SQL methodes improved specialy for 

  #Doc: see settings in:  

        'Edit JobControl Rule' -> 'JobDefinition' -> 'sel:O.Special:' DS of IR (DS Only) 

 

Enhancement implemented by code changes.

21.11.2019 3,149 J.Fes Settings CheckBox Check.Settings New: CheckBox methodes enhanced 

-Action "CBTools_2012_05" -SubAction "Compair2XmlFiles/CBResultGen" 

Now you can define compair condition for CB1 Data - CB2 Data 

 - CB1_Younger_CB2 -or- CB2_Younger_CB1 

 - Max days diff beween CB1 - CB2 extract date 

 - CB1/CB2 Extracte Date must bee in time range 

 

see CB.Mgr -> 'CB Config' -> '02 Extract / Report Settings' -> '02.11 CBDBc CheckBoxData.Base.Compair defs.' 

 

Enhancement implemented by code extensions

30.10.2019 3,149 J.Fes CheckBox UpdDb=No Doc: -Action "CBTools_2012_05" -SubAction "CBMoveCBFilesToCBArchiv" 

in case Object TC Names did contained special caracters  

move of CB.xml files did end into an exception. 

Issue is now solved by code changes

16.10.2019 3,149 S.Gueth GUI ObjectList UpdDb=No New: In JobManager -> Objects Filter -> P.Dat -> Res.Msg 

by default only errors will be listed on drop down 

hold Shift key to list all results

18.09.2019 3,1489 J.Fes Settings CheckBox Check.Settings Doc: New settings avialbel for CheckBox compair process 

 - DR.View.ViewPartName check 

 - EN25.Name Do compare 

 - EN26.Name Do compare

11.09.2019 3,1489 S.Gueth Scripts/Params. UpdDb=No New: added row template for Scripts/Parameters to edit the script settings

11.09.2019 3,1489 S.Gueth Scripts/Params. UpdDb=No New: it is now possible to edit 'Scripts/Params' parameter in an external form 

  --> press the drop down button in the 'JC.Script(cmd).ParamExt' cell
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09.09.2019 3,1489 S.Gueth 6468 Admin DB UpdDb=Yes New: added ability to store custom/generic values in the JobManager Database 

 

see following functions in the class 'MyAppl_DataSource_cls' 

GenericValueStoreInDatabase() --> stores or updates a generic value in th JobManager DB 

GenericValueReadFromDatabase() --> get generic value from database,  when there was an issue to get the value or there is no 

value with the given name, nothing will be returned 

GenericValueDeleteFromDB() --> function to delete generic value from datatable

06.09.2019 3,1489 S.Gueth Scripting UpdDb=No New: added Pause and Stop buttons fpr Task Sheduler Scripts 

you can implememt methodes to pause or stop your custom script like this: 

 

 

Example for Stop Script: 

 

If JS_ScriptingInterface.ScriptStopButtonWasClicked() Then 

   Dim stopMsg As String = "Script was stopped by user!" 

    InfoSysProtocol.PrintInfoLine(stopMsg) 

    ScriptReturn_r.ErrMsg = stopMsg 

    Return ScriptReturn_r 

End If 

 

 

Example for Pause Script: 

 

JS_ScriptingInterface.ScriptPauseCheck(InfoSysProtocol)

22.08.2019 3,1489 S.Gueth Import Sites/Data 

Import ObjectList

UpdDb=Yes New: added setting 'Analyse Multi-Cad Assemblies' 

in JobServer -> Sites -> Import Settings 3 -> 13 - Analyse Multi-Cad Assemblies 

If set to true (default is false), it will be analysed on import if an assembly has multicad components (only working for NX 

assemblies) 

If the assembly has an ItemRevision in first BOM level with no UGMaster but with a JT dataset, the AP is marked as 

'MultiCad_in1LevelBOM' 

If the assembly has an ItemRevision in multi BOM level (not 1 BOM level) with no UGMaster but with a JT dataset, the AP is 

marked as 'MultiCad_inMultiLevelBOM' 

check column 'O.AP.has Multi-CAD' in objects list to determin if the AP is Multi-CAD or not 

check column 'O.AP.Multi-CAD IRs' in objects list to see the installed Multi-CAD Item Revisions 

 

Search for Multi-CAD AP in Objects List -> Filter -> AP -> Multi Cad AP

12.08.2019 3,1489 S.Gueth ProcessGroups New: it is now possible to reset a process group to its default values 

 JobServer -> ProcessGroups -> Extra -> Reset selected Process Group to default values...

12.08.2019 3,1489 S.Gueth GUI Import Sites/Data 

Import JobControl 

Scripts/Params.

UpdDb=No New: copy / duplicate lines in JobManager Gui 

1. via context menu on the grid 

2. via shortcuts: 

   Ctrl + D 

    --> Duplicate selected rows in the current grid 

   Ctrl + Shift + C 

    --> Copy selected datarows to the clipboard (serialized as xml string) 

   Ctrl + Shift + V 

    --> Paste serialized xml string to the grid

07.08.2019 3,1489 J.Fes JCT Ver.Info New: -Action "PartUtility_2018_04" -SubAction "EVALUATE_TCDataSetNamedRefCleanUp" 

New evaluation avilable for Action TCDataSetNamedRefCleanUp 

Limitation: Evaluation is until now done only for UGPART-BBOX UGPART-ATTR UGPART-ATTRIBUTES Trushape-Data 

New Methode implemented by code extension

12.07.2019 3,1489 J.Fes Settings CheckBox Check.Settings New: -Action "CBTools_2012_05" -SubAction "CBResultGen" 

New Compair condition avilable: 

 MD08.1 Condition if NO reference found for RefSet and RefSet is Empty (MD:Ref.nf:RefSet.Empty) 

Enhancemnt is implemneted via code changes

04.07.2019 3,1489 J.Fes JobControl Ver.Info Change: Enhanced: JobData1ToProcess  

Now JobData1ToProcess.xml and JobData2Result.xml   

contains  .ObjectIr.ir_Rank data 

Enhancement is done by code changes
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04.07.2019 3,1489 J.Fes JobControl Ver.Info Change: Optimisation: JobData1ToProcess reduced 

Now JobData1ToProcess.xml and JobData2Result.xml   

do not contains SiteDef_cls.Import_Settings3_Obj in this .xml files 

Enhancment is done by code changes

27.06.2019 3,1489 S.Gueth Import Change: on Import with ReleaseDate the ImportIrLastReleaseDateBegin will be set to ImportIrLastReleaseDateBegin 

when the last release date is newer then the last mod date

03.06.2019 3,1489 J.Fes Settings CheckBox Check.Settings New: -Action "CBTools_2012_05" -SubAction "CBMoveCBFilesToCBArchiv" 

On extract NXCheckBox data now it is analysed if part contains Component View's  

See also settings at:  

 'CheckBox MGR' -> 'CB Config' 

                    -> '05.7 CB DR.CompView Info add to Process ResMsgExtendet' 

Hint: required NXCheckBox.Version >= V.2.0.1.25 

Hint: avilable only for Data extracted with TC integration 

Enhancment is done by code extension and NXCheckBox extract software

01.06.2019 3,1489 J.Fes Settings CheckBox Check.Settings New: CheckBox analyse enhanced  

Now we do read and compair:  

 - APComp.IsDraftingComponent 

 - View.ViewPartName 

 - In case an Error happend P.Result Section returns [AS:ERR:IsDraft.Comp] 

For using this methode CheckBox data need to be extracted with NXCheckBox Version V2.0.1.25

27.05.2019 3,1489 J.Fes TaskScheduler Ver.Info Doc: Issue at TaskScheduler Process not correct handelt if  

In case of Date-Span in combination with Timepoint did not worked  

Issue has been that Schedule got deactivated even when Date-Span has been still valid. 

#Example: 

[DA=27.05.2019-30.05.2019 WD=1 WD=2 WD=3 WD=4 WD=5 WD=6 WD=7 TP=21:22] 

Issue is now solved by code changes

23.05.2019 3,1489 S.Gueth Settings CheckBox Check.Settings New: added setting 'MD05 Centre of Gravity do compair' to checkbox settings 

defines if 'Centre of Gravity' should be compared or not [Default=true]

23.05.2019 3,1489 S.Gueth Settings CheckBox Check.Settings New: added setting 'MD00.Model data do compair' to checkbox settings 

defines if Model data is to be compared [Default=YES] 

If 'NO' Model data will !! NOT !! be compared 

If 'ProtoTypeOnly' only the prototype data will be compared 

If 'SolidBodyAnalyseOnly' only the volume, moment of inertia and moment of gravity for reference data will be compared

21.05.2019 3,1489 A.Stein Import Sites/Data 

Import

UpdDb=Yes New: Now its possible to use generic as DatasourceType in SiteDef 

You can use custom scripts for different functions in the JobServer (for example for the DataImport to JobMgr) 

 

Issue is now solved by code changes

17.05.2019 3,1489 S.Gueth JobControl UpdDb=No Change: fixed bug, where under certain circumstances the free memory of the client was not measured correctly 

Issue is now solved by code changes 

please update JobServer and JobClient

14.05.2019 3,1489 S.Gueth Settings CheckBox Check.Settings New: added new option 'CGMNewerThenTif' for '04.2 Generate tif' in CheckBox Settings Manager 

if set,  CB.tif files will only be generated when there is no tif for the cgm file or if the cgm file is newer then the 

coresponding tif file

10.05.2019 3,1488 S.Gueth Settings CheckBox Check.Settings New: setting '05.8 CB Prototype Volume diffs to Excel' added to CB Settings manager 

If activated, an excel file will be generated, where all prototype volume differences differences are collected 

you can find the excel file in the following dir: 

#DataRootDir#\#Site#_DataCollection\GeometricVolumeAnalyse_CheckBoxDataCollection.xlsx 

for definition of #DataRootDir#, please check '03.1 Data Root Dir' in CheckBox config settings

08.05.2019 3,1489 S.Gueth CheckBox Change: fixed a bug in CheckBox Manager  

where coresponding tif files migth not be found correctly when there are more then one sheets per specification
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03.05.2019 3,1489 J.Fes 5143 Import Ver.Info Change: When import/Update via Site/Data Import -> Import Extended -> Import.Site.Data: 'controled by Release Date'  

See also 'IContr:Ir.ReleaseDateBegin'  

 

Import behavior changed at the end of import process  

 'IContr:Ir.ReleaseDateBegin' is set to youngest found IR.LastMode  

 'IContr:Ir.ModDateBegin' datum is not changed  

 'IContr:Ds.ModDateBegin' datum is not changed  

 

This optimization minimices the Import/Update duration when using this methode.    

 

Enhancment is implemented by code extension

24.04.2019 3,1489 J.Fes Import Sites/Data 

Import

UpdDb=Yes New: Do Update IR Rank analyse on import/update can be now switch ON/OFF 

By default it is switched ON via value true.   

If set to true (default), IR Rank is analysed during data import 

If set to false, IR Rank will not be analysed and set to 0 

 

Settings are avilabel for each TC-Site via: 

Sites/Data Import -> open Edit Site def. dialog   

  -> Import Stettings 3  

   -> 4 - Import eXtendet  

    -> 11 - O.Imp.Msg WRN/ERR analyse true/false

24.04.2019 3,1489 J.Fes Import Sites/Data 

Import

UpdDb=Yes New: O.Imp.Msg WRN/ERR analyse on import/update can be now switch ON/OFF 

By default it is switched ON via value true.   

If set to true (default), O.Imp.Msg WRN/ERR is analysed during data import 

 

Settings are avialbel for each TC-Site via: 

Sites/Data Import -> open Edit Site def. dialog   

  -> Import Stettings 3  

   -> 4 - Import eXtendet  

    -> 11 - O.Imp.Msg WRN/ERR analyse true/false

02.04.2019 3,1489 J.Fes CheckBox Ver.Info New: CheckBox compairs now DisplayedTextValues.  

if pre and post CheckBox data contains DisplayedTextValues data 

 

Hint:DisplayedTextValues will be extracted if NX9 and NxCheckBox_XX_V.2.0.1.24 or higher  

Is used during NXCheckBox extract process.   

 

Important: 

If DisplayedTextValues is found in both NxChecbBoxData.xml files then DisplayedTexts values will be compared. 

In this case TextInfo.Texts analyse is then not used anymore (skiped).  

Reason for this change is that DisplayedTexts is the better - enhanced text compair methode. 

 

Enhancement implemented by code extensions

02.04.2019 3,1489 J.Fes Settings CheckBox Ver.Info 

Check.Settings

Change: CheckBox analyse enhanced now you can us following settings 

  - AssocEnt analyse can be deactivated  

  - AssociativesNum analyse can be deactivated 

  - Remove all references from text 

 

Hint in some project cases it is helpfull do use this settings 

because software changes in NX Versions result in some data no longer being comparable.    

Enhancements were introduced by programming

27.03.2019 3,1489 S.Gueth ObjectJobResults New: when you select a process group cell in the Objects grid of the JobServer 

and you click on J.Link / J.Log button -> the last result link / job log file for the coresponding process column will be 

opend

26.03.2019 3,1489 S.Gueth 6152 Settings Check.Settings Change: changed 'Host Memory Usage Settings' in JObManager settings from percentage to absolute values 

Memory usage check returns OK, if the current available free Memory is higher then the given Value (default 2000mb) 

Memory usage check returns ERR, if the available free memory is lower then then given Value (default 1000 mb)

26.03.2019 3,1489 S.Gueth Settings CheckBox Check.Settings New: added setting '02.10 Clean Up CB Files when Compair is OK' in CheckBox config settings 

Defines if extracted NXCheckBox files (xml, cgm, tif, txt) should be deleted when CheckBox Compair is OK (result code is 0 and 

result has no warning)
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21.03.2019 3,1489 S.Gueth Settings New: added function for CheckBox CleanUp -> 'by CB Compair Result' 

deletes all CheckBox, tif, cgm and syslog files where latest CB compair result in JobManager is OK 

  -> where Result Code is 0 and has no WRN

20.03.2019 3,1488 S.Gueth GUI JobControl 

Settings

UpdDb=Yes 

Check.Settings

New: added new Filter in JobControl Rules for Object Save Version 

 -> JobControl Rules 

      -> Job Def Extended 1 

          -> sel:O.Saved.With.RelVer

20.03.2019 3,1488 S.Gueth GUI ObjectList New: added filter for Object.Save.Version to JobManager Objects List Filter 

  -> Objects List 

      -> Spec 

          -> O.Save.Vers:

19.03.2019 3,1488 S.Gueth 6241 Import Sites/Data 

Import Settings

UpdDb=Yes 

Check.Settings

New: TC - NX release version on import/update can be now switch ON/OFF  

By default it is switched ON via value true.   

If set to true, NX release version will be imported from teamcenter and stored in O.SaveVersion in JobManager 

If TC read performance is low please switch off NX release version. 

 

hint: table PNX0APPLICATIONINFOSTORAGE and PUGPARTATTRIBUTES need to be available in teamcenter 

 

Settings are avialbel for each TC-Site via: 

Sites/Data Import -> open Edit Site def. dialog   

  -> Import Stettings 3  

   -> 4 - Import eXtendet  

    -> 10 - get NX release version on import/update ON/OFF

08.03.2019 3,1488 S.Gueth Settings CheckBox Check.Settings New: setting '05.6 CB Attribute diffs to Excel' added to CB Settings manager 

If activated, an excel file will be generated, where all Attribute differences are collected 

you can find the excel file in the following dir: #DataRootDir#\#Site#_DataCollection\Attribute_CheckBoxDataCollection.xlsx 

for definition of #DataRootDir#, please check '03.1 Data Root Dir' in CheckBox config settings

04.03.2019 3,1488 J.Fes JCT Ver.Info Change: Job.Process header informations new formated.  

Now you have better overview about the JobProcess Details and Versions. 

Now Action.SubActionSettingsXML is now also includet Process header 

#Example: 

JCT.Version.....................: 2.12109.3001.2014 

Action.Version..................: V2019-03-30.04/J.Fes 

Action.Name.....................: ActionName_2013_10 

Action.SubAction................: SubActionName 

Action.SubActionSettingsXML.....: SubActionSettings.xml  

Job.Name........................: TC83_PU_AP_N_07500_addPLM 

Job.Start.......................: 30.01.19 15:01

28.02.2019 3,1488 J.Fes CheckBox Ver.Info Doc: Checks NOW if mapped and dublicated empty Attributes are found in CB-Data.xml  

  

Example:  

 - we find in CB-Data.xml attributes Material='' NX_Material='Mat001'   

 - and Attribute Mapping condition defines to mapp 'Material' to: 'NX_Material'   

 - after Mapping the Attributes we see folowing values: 

 - *1 NX_Material='Mat001' 

 - *2 NX_Material='' 

  

The updated algorithem removes the empty attribute *2 NX_Material=''  

If new setting: 'PH.Attribute Mapper ignore dublicated and empty attributes=false'  

  

Please Check new setting 'PH.Attribute Mapper ignore dublicated and empty attributes'  

Methodes are implemented by code changes

22.02.2019 3,1488 S.Gueth CommandLineArgs 

Admin

New: start JobClient in Debug mode: set command line parameter /JobClientStartMode DebugMode 

start JobClient in Debug mode: set command line parameter /JobClientStartMode TestAndDebugMode

22.02.2019 3,1488 S.Gueth Settings Check.Settings New:

06.02.2019 3,1488 S.Gueth Settings JCT Check.Settings New: Job Control Activ Status Rules can now be defined in Result Classifications 

If a result classification matches, the defined 'Job Control Activ Status Rules' will be triggered

11.01.2019 3,1488 J.Fes ObjectList UpdDb=Yes Change: Object List Item + Ir + DS release status supports now 255 chars. 

Change is done via upsize data colume from 32 to 255 chars Update Database schema is required
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19.12.2018 3,1488 J.Fes UpdDb=No Change: JobClinet start Performance improved 

There for we enhanced methodes to get Local Resource informations for Drives CPU and Memory 

Addition we now reading Local JobInformations only if needet.  

Improvment is done by code changes

11.12.2018 3,1488 S.Gueth GUI New: parameter /DrawingIndexSearchUIShow for JobServer 

if set, a special gui will be showed, only for drawing indexing search

08.12.2018 3,1488 S.Gueth 6104 Settings CheckBox Check.Settings New: added 'MD.Volume 01 Check Method' in Check Box Compare Settings 

defines the check method for the volume compare 

Both.................: Volume will be compared by absolute values and percentage values (see rules: MD02.Volume and 

MD03.Volume) 

Volume_Value_Dif.....: Volume will be compared by absolute values (see rule: MD02.Volume) 

Volume_Percentage_Dif: Volume will be compared by percentage values (see rule: MD03.Volume) 

Ignore...............: Volume compare will be ignored

28.11.2018 3,1487 S.Gueth Settings JCT Check.Settings New: -Action "CustomCmdTools_2016_04" -SubAction "VPMapProTextExportFromTif" 

subaction for exporting texts from tif files via vmap pro

28.11.2018 3,1487 S.Gueth Settings JCT UpdDb=Yes 

Check.Settings

New: -Action "CBTools_2012_05" -SubAction "CBMoveCBFilesToCBArchiv" 

added parameter 'CBDrwIdxSearchData_Import' 

If this parameter is set for eatch Part the displayed text of every entity  

will be imported into JobMgr.DB as drawing indexing search data. 

The imported drawing texts and can be searched via JobManager UI.  

This enhanced methode gives you the possibility to find the parts where these drawing texts are contained.

15.11.2018 3,1487 J.Fes Scripts/Params. Ver.Info Change: Parameter settings for NX-Refile and NX-PartUpdate updated  

if JC.Script(cmd) matches    parameters are shown for      

  - *Refile*Nativ*\*    ->   RefileNativ 

  - *Refile*SAP*\*      ->   RefileNativ 

 

  - *RefileNX*\*        ->   RefileTc 

  - Rf*\*               ->   RefileTc 

 

  - *PartU*Nativ*       ->   PartUtilNativ 

  - *PartU*SAP*         ->   PartUtilNativ 

  -  

  - *PartU*TC*          ->   PartUtilTC

31.10.2018 3,1486 S.Gueth 6056 CommandLineArgs 

JobControl JCT

UpdDb=Yes New: -Action "JobControl_2018_10" -SubAction "ControlActivStatus" 

Controls Active Status for JobComputer JobRules JobGroups and Sites 

Parameters: 

-JobRoot_DP   "c:\temp\xx"						 #Doc: root dir of current running job 

-Type         "JobComputer|JobGroup|JobRule|Site"  #Doc: defines the type Of the job control active status 

-Name			"addPLM-*;JF-21"					 #Doc: defines the name Of the job control type, you can define multiple names seperated With ; 

And you can use wildcards (*) 

-Status		"ON|OFF|Activ|Inactiv"				 #Doc: defines the status Of the job control that should be Set, you can Set On / OFF Or 

Activ / Inactiv 

-Description	"test description"					 #Doc: defines a description / note, that will be displayed In the JobServer at 

JobControlInfo
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23.10.2018 3,1481 J.Fes 1145 JobControl JCT New: extract a customized import list for job data to process 

-Action "JobDataExtract_2013_10" -SubAction "InputListExtract" 

 cmd Example: -format "#ItemId#_REV:_#Rev#_Type:_#ObjectType#" -JobRoot_DP "C:\temp\job1" -inputList_DPNE 

"#JobRoot_DP#\inputList.txt" 

 

 format.: defines the content of each inputlist, you can use these variables: 

 #ItemId# 

 #IrId# 

 #Rev# 

 #ObjectId# 

 #ObjectName# 

 #ObjectType# 

 #ObjectOwningSiteID# 

 #ObjectFromSiteID# 

 #ObjectCliName# 

 #ObjectCliNameForNX# 

 #ObjectFs_Vol# 

 #ObjectGroup# 

 #ObjectOwner# 

 #ObjectPuid# 

 #IrNameCLI# 

 #ObjectCreateDate# 

 #ObjectFs_DPNE# 

 #ObjectLastModDate# 

 #ObjectLastModUser# 

 #ObjectUgMaster_Type# 

 #ProcStateCol01# .. #ProcStateCol20#  

 #ProcStateColRf# 

 #ProcStateColMc# 

 .... 

#New: 3.1481;23.10.2018;New: List extract support's now also following valiables   

 #ObjectUgMaster_APLevel# 

 #ObjectUgMaster_CompCount# 

 #ObjectUgMaster_CompCountUnique# 

 #ObjectUgMaster_Lev1CompN# 11.09.2018 3,1475 S.Gueth GUI ObjectList New: added Pivot functionality 

Pivot data can be filtered and displayed in Objects List tab 

Pivot statistics can be exported via Excel

31.08.2018 3,1475 S.Gueth JCT Change: TCData Quality Check: renamed 'PFRefFolder' check to 'PFCheck'

30.08.2018 3,1475 S.Gueth JCT Change: -Action "TCDataQuality_2016_09" -SubAction "TCDataQualityCheckVer1" 

cumulated all 5 part family checks of ir to 1 result

27.08.2018 3,1475 S.Gueth Settings JCT Check.Settings New: added 'Import CB Drawing Data to JobMgr DB' to CheckBox settings manager config 

If set to true, CheckBox drawing data will be imported into JobManager database

10.08.2018 3,1474 J.Fes Import Sites/Data 

Import

UpdDb=Yes New: During Import/Update Sync last modification date of dataset is also used

23.07.2018 3,1472 J.Fes JCT Ver.Info Change: -Action "RefileNative_2016_02" -SubAction "PartByPart" 

If option -convert_mcs has been used then filename parameter -convert_mcs=<filename> 

has been incorrect generated. 

Issue is now solved by code changes

21.06.2018 3,1468 S.Gueth Settings CheckBox Check.Settings New: -Action "CBTools_2012_05" -SubAction "CBMoveCBFilesToCBArchiv" 

Export CheckBox duration times to excel file 

Check CBMgrConfig Settings: 

'CB Duration To Excel File' 

'CB Duration Excel File (full path and name)'
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30.05.2018 3,1468 J.Fes Import Sites/Data 

Import

UpdDb=Yes Ver.Info New: Import updatet: During Import an 'NX Partfamily Master' the PF-Master-Member check will be called.  

'PF-Master-Member check' will list all Partfamily Members and reports status of Partfamily Members 

Example: 

 |........................................................................................... 

 | PF-Master-Member check for...: PFMaster/A(= PF - Master) 

 | PF-Members...................: ItemId/ RevId                 Result 

 | PF-Member  1/2 ..............: PFMember-1/A                  WRN_361_PFMemberFolderRef 

 | PF-Member  2/2 ..............: PFMember-2/A                  OK 

 |........................................................................................... 

 | PF-Master-Member check result: PFMaster/ A(= PF - Master) 

 | PF-Member (n)................: 2 

 | PF-Member (n) has Issues.....: 1 

 | PF-Master Result.............: WRN_366_PFMasterMemberHasWRN;WRN_361_PFMemberFolderRef 

 |........................................................................................... 

 

Hint: if you want to redo the PF-Master-Member check please  

Import manually the PF-Master Object

30.05.2018 3,1468 J.Fes Import Sites/Data 

Import

UpdDb=Yes Ver.Info Change: Import updatet:  

 

During Import folowing WRN and ERR are now proved: 

 

 WRN_100_BOMAnaylse_LevMax       appear if during 'AP-BOM Analyse' max levels is exceeded 

 WRN_110_BOMAnaylse_CompMax      appear if during 'AP-BOM Analyse' max comp count is exceeded 

 WRN_120_BOMAnaylse_TimeMax      appear if during 'AP-BOM Analyse' max duration is exceeded 

 

 ERR_130_BOM_isSelfRef           appear if during 'AP-BOM Analyse' returns that BOM is selfreferncing   

 ERR_131_BOM_SubAp_isSelfRef     appear if during 'AP-BOM Analyse' returns that a Sub of BOM BOM is selfreferncing   

  

 WRN_140_DSHasMultiIrRefs        appear if found that a Dataset has refernces in mulible revisions 

 ERR_150_IrHasDsWithSameName     appear if found that a revision has Datasets with same name of same type 

  

 ERR_200_DateTimeIsNull          appear if found that Date Time Data are not set.  

 ERR_201_DateTimeFormatWrong     appear if found that a DateTime format has wrong format 

 WRN_202_RelDateIrToStatusObjDif appears when last release date of IR and release date of  

                                 work Space object (IR) are different (New: 3.1463;30.04.2018;S.Gueth) 

 ERR_203_RelDateIrIsMissing      appears when last release date of IR (work space object) exists and  

                                 release Date of status object IR Is empty (New: 3.1463;30.04.2018;S.Gueth) 

 ERR_204_RelDateWSOIsMissing     appears when last release date of IR (work space object) is empty  

                                 and release date of status object IR exists (New: 3.1463;30.04.2018;S.Gueth) 

  

 ERR_301_DSIsMissingFile         appear if found that Dataset has no 'CAD-Part' File in named refernce 

 ERR_302_DSHasMutiCADFiles       appear if found that Dataset has more then 1 'CAD-Part' File in named refernce 

  

 Partfamily Members #New: 3.1464;11.05.2018;J.Fes 

 WRN_361_PFMemberFolderRef       appear if Partfamily Member Item is not below 'PFMaster-Item-folder' 

 WRN_362_PFMasterFolderRef       appear if Partfamily Master has no Partfamily 'PFMaster-Item-folder'  

 WRN_363_PFMasterNoPFMember      appear if Partfamily Master is missing Partfamily Members 

 WRN_364_PFMasterMemberFolderRef appear if Partfamily Master and Members is missing 'PFMaster-Item-folder' 

 WRN_365_PFMasterMissing         appear if Partfamily Members is missing Partfamily Master 

 WRN_366_PFMasterMemberHasWRN    appear if Partfamily Members of PartFamiliy Master has warings

30.05.2018 3,1467 S.Gueth ObjectList Change: -Renamed Button "Open NX" in Objects List to "Open File" 

this button will open all NX Datasets with NX Router 

and all other files will be opend with windows default application

24.05.2018 3,1466 J.Fes TaskScheduler UpdDb=Yes Ver.Info New: TC - Volume Revoke Grand process avilabel 

for setup and usage please setup TaskSheduler 

 following is required: 

 - JobMgr Version - 3.1466;24.05.2018 or later 

 - installed and setup scripts  

 - 10-JobScripts\VolumeRevokeGrant_TC  

 - setup please review \Documentation\JobManager_VolumeRevokeGrand_TaskShedulerSettings.txt 

Issue is now solved by code changes

18.05.2018 3,1464 S.Gueth Scripting Settings Check.Settings New: variable ${JobMgr_Test} = ‘ON‘ will be set in *.ps1 script, when debug mode is on activated in JobClient

18.05.2018 3,1464 S.Gueth Scripting Settings Check.Settings New: variable ${JobMgr_Debug} = ‘ON‘ will be set in *.ps1 script, when debug mode is on activated in JobClient

17.05.2018 3,1465 J.Fes ObjectList Ver.Info Change:
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17.05.2018 3,1464 S.Gueth JobControl Change: if the path to JobServer Settings xml file is not available on the JobClient, JobClient won't stop anymore 

JobClient will now print the following message: 

ERR: JobServerSettings Load: please check if path to JobServer Settings xml file is available! 

     JobServerSettings Load: Waiting 10 seconds --> try to reload settings

16.05.2018 3,1464 A.Stein Import ObjectList Ver.Info New: Now it is possible to import all components of an assembly from native nx-data 

see Object List -> Extra -> Import Data of Items/IRs

16.05.2018 3,1464 A.Stein Import ObjectList Ver.Info New: Now it is possible to import all components of an assembly from native nx-data 

see Object List -> Extra -> Import Data of Items/IRs (incl. Assembly Components)

16.05.2018 3,1464 A.Stein Import ObjectList Ver.Info New: Now it is possible to import all components of an assembly from native nx-data 

see Object List -> Extra -> Import Data of Items/IRs

16.05.2018 3,1464 A.Stein Import ObjectList Ver.Info New: Now it is possible to import all components of an assembly from native nx-data 

see Object List -> Extra -> Import Data of Items/IRs (incl. Assembly Components)

15.05.2018 3,1464 S.Gueth Import Sites/Data 

Import Settings

Check.Settings New: -TC - Dataimport: Release Status Import All can now be switch ON/OFF during import  

By default it Is switched OFF via value false.    

 

Settings are avialbel for each TC-Site via 

Sites/ Data Import -> open Edit Site def. dialog    

             -> Import Stettings 3   

              -> 4 - Import eXtendet   

               -> 8 - Import all release states ON/OFF

11.05.2018 3,1464 J.Fes Import UpdDb=Yes Ver.Info Change: PartFamily anlayse during import/update has been improved 

Now it is anlayse that PartFamily Master contains PartFamily folder ('PFMaster-Item-folder') below Item of PartFamily 

ItemRevision 

Now it is anlayse that PartFamily Member Item referenced in PartFamily-Folder ('PFMaster-Item-folder') 

 

Issue is now solved by code changes

11.05.2018 3,1464 J.Fes Import Settings Ver.Info New: TC - Dataimport Partfamily-Analyse during import/Update can be now switch ON/OFF  

By default it is switched ON via value true.   

If TC read performance is low please switch off Partfamily Analyse. 

 

Settings are avialbel for each TC-Site via: 

Sites/Data Import -> open Edit Site def. dialog   

  -> Import Stettings 3  

   -> 4 - Import eXtendet  

    -> 7 - Partfamily-Analyse on import/update ON/OFF

09.05.2018 3,1463 S.Gueth Settings JCT Check.Settings Change: -Action "TcExtractData_2013_10" -SubAction "TCDataExtract" 

Subaction renamed from "TCDataExtract_ForRefile" to "TCDataExtract"

04.05.2018 3,1463 S.Gueth Import Sites/Data 

Import Settings

Check.Settings New: site setting '6 - Compare IR WSO rel date and status obj rel date on import' added 

If set to true, release date of IR Work Space Object and last status object will be compared during import 

on deviation: WRN_202_RelDateIrToStatusObjDif will be set to import ERR/WRN

02.05.2018 3,1463 S.Gueth Settings JCT Check.Settings New: added 1.3.3 Check relese date WSO and last release dtae of status object 

If ON it checks if the release date of the IR worksapce object and the release date of the last status object of the IR are 

the same

30.04.2018 3,1463 S.Gueth JCT Change: ChecBox - Result Viewer did NOT displayed in all cases the .tif files  

when there are mor then 2 different extracts 

Issue is solved by code changes.

10.04.2018 3,1462 J.Fes JobControl Settings UpdDb=No 

Check.Settings

New: JobScripts parameters enhanced 

JobParameter supports now settings dialog for: 

 RefileTc RefileNativ PartUtilTC PartUtilNativ  

  

if 'JC.Script(cmd)' matches folowig values this dialog opens   

               

 JC.Script(cmd)         ->  Dialog:          

 *RefileNX*\* or Rf*\*  ->  RefileTc        

 *Refile*Nativ*\*       ->  RefileNativ     

 *PartUtil*TC*\*        ->  PartUtilTC      

 *PartUtil*Nativ*\*     ->  PartUtilNativ

29.03.2018 3,146 S.Gueth Settings JCT Check.Settings New: method M3_byAutomation added for parameter BOMCompairBOMRefFindMethode 

try to find coresponding BOM line first by 'M1_byBOMPuid' if not found by 'M2_byBOMData'

 27 / 73
Release Date/Time: 25.11.2025 08:48

Relase Version: 3.2000.2511.2025



PLMJobManager: What's New

Date Version User Issue-Nr Categorie Additional Info Type Description

26.03.2018 3,1459 S.Gueth Settings Check.Settings New: Compression Archive Format can no be set specifically for server and client in JobManager settings 

default for server is ZIP 

default for client is 7z

25.03.2018 3,146 J.Fes Import Sites/Data 

Import

Ver.Info New: Data Model: Customer Attributes. 

 

It does support's now also to read Item and ItemRev Attributes

06.03.2018 3,1456 S.Gueth Settings JCT Check.Settings New:

06.03.2018 3,1456 S.Gueth Settings JCT Check.Settings New: -Action "RefileTC_2012_01" -SubAction "evaluate" 

parameter: UGPartCheck (if set, UGPart named references will be checked) 

parameter: TSOCheck (if set, TSO Named refferences will be checked)

02.03.2018 3,1456 J.Fes ObjectList UpdDb=Yes Ver.Info New: Object list supports now new Columes 

- Obj.in.Gr(s).: contains Groups where Object are added into  

- Obj.in.Sel.Gr: contains only first Group (by alpha order)   

                 where Object is added into   

                    

#Example: Group G1 + G2 + G3 is selected                   

  ObjId   'in Groups'  'Obj.in.Gr(s)' 'Obj.in.Sel.Gr'                  

  Obj01   'G1,G2,G3'   'G1,G2,G3'     'G1'                  

  Obj02   'G2,G3'      'G2,G3'        'G2'                  

  Obj03   'G1,G3'      'G1,G3'        'G1'                  

  Obj04   'G3'         'G3'           'G3'                  

                    

                    

Notes:  

If you use have this colume visible in your ObjectList  

and you are NOT filtering via Groups 

and you do not use the Groups in the grid  

then please remove this Columes from Datagrid   

because dataread performance is slower.

27.02.2018 3,1454 A.Stein JCT Ver.Info New: -Action "NxDataProcessing_2013_09" -SubAction "NxImportFiles" 

now it is possible to import additional Files to TC 

via JobMgr cmd tools

27.02.2018 3,1454 A.Stein JCT Ver.Info New: -Action "NxDataProcessing_2013_09" -SubAction "NxImportFiles" 

now it is possible to import additional Files to TC 

via JobMgr cmd tools

08.02.2018 3,1453 J.Fes DB UpdDb=Yes Change: Process result data table extendet: 

Now data colume storing JobResult Links are extendet from 255 to 450 nvarchars 

This change is required because customer need long path names to JobMgrDataStore directory

07.02.2018 3,1453 J.Fes JobControl Ver.Info New: JobControl Rules enhanced  

Now you have the posibility in a JobRule to define extend JC.Script(cmd).ParamExt 

#Doc: Value will be appendet to refferenced J.Script/Param -> JC.Script(cmd).ParamExt 

#Doc: With this enhancemnt we provide easy definition of JobVariants

02.02.2018 3,1451 A.Stein Import New: 

Doc:

Clear Results 

    Dim ResGroupDefault As New ResultSecs_cls(AttrSync, 0) 

    '-- #Step: (only Optional) Create additional ResGroup  

    ' Dim ResGroup01 As New ResultSecs_cls(Gr01, -1) 

 

    '-- #Step: Create and add ResSection(s) to ResultSecsGr 

    Dim RSecMetaData As ResultSec_cls = Me.ResGroupDefault.AddNewResultSection(MetaData, 0) 

    Dim RSecAttrSync As ResultSec_cls = Me.ResGroupDefault.AddNewResultSection(AttrSync, 0) 

 

 

 

 

    ''' <summary> 

    ''' fucntion to execute attribute sync for all objects 

    ''' </summary> 

    ''' <remarks>  

    ''' #New: 3.145105.02.2018A.Stein
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02.02.2018 3,1451 A.Stein New: 

Doc:

Clear Results 

    Dim ResGroupDefault As New ResultSecs_cls(AttrSync, 0) 

    '-- #Step: (only Optional) Create additional ResGroup  

    ' Dim ResGroup01 As New ResultSecs_cls(Gr01, -1) 

 

    '-- #Step: Create and add ResSection(s) to ResultSecsGr 

    Dim RSecMetaData As ResultSec_cls = Me.ResGroupDefault.AddNewResultSection(MetaData, 0) 

    Dim RSecAttrSync As ResultSec_cls = Me.ResGroupDefault.AddNewResultSection(AttrSync, 0) 

    Dim RSecSetReleaseState As ResultSec_cls = Me.ResGroupDefault.AddNewResultSection(RelStatus, 0) 

 

 

 

 

    ''' <summary> 

    ''' fucntion to execute attribute sync for all objects 

    ''' </summary> 

    ''' <remarks>  

    ''' #New: 3.145105.02.2018A.Stein

02.02.2018 3,1451 A.Stein Import New: 

Doc:

Clear Results 

        'Dim ResGroupDefault As New ResultSecs_cls(AttrSync, 0) 

        '-- #Step: (only Optional) Create additional ResGroup  

        ' Dim ResGroup01 As New ResultSecs_cls(Gr01, -1) 

 

        '-- #Step: Create and add ResSection(s) to ResultSecsGr 

        'Dim RSecMetaData As ResultSec_cls = Me.ResGroupDefault.AddNewResultSection(MetaData, 0) 

 

 

 

 

 

        ''' <summary> 

        ''' fucntion to execute attribute sync for all objects 

        ''' </summary> 

        ''' <remarks>  

        ''' #New: 3.145105.02.2018A.Stein

30.01.2018 3,145 J.Fes Import Sites/Data 

Import Settings

UpdDb=Yes 

Check.Settings

New: Process Results Links now can be updated via 

Sites/Data Import-> Admin-> 2.1 - Update JobResult Links (!- dry run -!)  

Sites/Data Import-> Admin-> 2.2 - Update JobResult Links (!- Activ run -!) 

 

If this function is used  

Then existing JobLinks will be updatet in JobMgr.DB 

Update is using Replacment rules form ServerSettings --> 'Replace Rules for J.Links'  

Please review settings befor using

25.01.2018 3,1449 J.Fes JCT Ver.Info New: -Action "NxDataProcessing_2013_09" -SubAction "StepToNx" 

now it posible to convert step files to nativ NX.prt parts  

via JobMgr cmd tools

25.01.2018 3,1449 J.Fes JCT Ver.Info New: -Action "NxDataProcessing_2013_09" -SubAction "NxToTc_UG_Clone" 

now it is possible to import NX.prt files to TC 

via JobMgr cmd tools

22.01.2018 3,1448 J.Fes JCT Ver.Info Change: -Action MigIdeas2NX_2013_10 -SubAction "CMM_ResultEval" 

- Migration report evaluation enhanced 

 

- Migration report evaluation ResultCode (P.Res.Code)  

  will be set to to part types 'ProPrt' and 'IdeasPart' 

. 

- Migration report evaluation Message (P.Res.Msg.)  

  will be set to all part types  

  including ProPrt,ProAsm,ProDrw,IdeasPart,IdeasAssembly,IdeasDrawing
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22.01.2018 3,1448 J.Fes JCT Ver.Info Change: -Action MigIdeas2NX_2013_10 -SubAction "CMM_ResultEval" 

- Migration report evaluation enhanced 

 

- Migration report evaluation ResultCode (P.Res.Code)  

  will be set to to part types 'ProPrt' and 'IdeasPart' 

. 

- Migration report evaluation Message (P.Res.Msg.)  

  will be set to all part types  

  including ProPrt,ProAsm,ProDrw,IdeasPart,IdeasAssembly,IdeasDrawing

20.01.2018 3,1448 J.Fes JobControl UpdDb=Yes New: JobComputer definitions contains now new colume to select TC-Password file

18.01.2018 3,1447 J.Fes JobControl UpdDb=Yes New: Job Computers settings enhanced now it is posible to define a tc password file. 

If using TC.Passw.File then tc commanline tool may use password file (-pw ..) 

instead of using plain text password (-p ..) in command line. 

Hint: Please check if TC  

see 'Job Control' -> 'Job Computers' 

Issue is now solved by code changes

11.12.2017 3,1443 J.Fes CheckBox Ver.Info Change: -Action "CBTools_2012_05" -SubAction "CBMoveCBFilesToCBArchiv" 

NX.Sylog.END Analyse Enhanced 

For Objects the correct NX.Syslog.section END: is now found  

CheckBox returns now [NX.Syslog.END:OK]

11.12.2017 3,1443 J.Fes ObjectJobResults Ver.Info Change: -Action "ANY" -SubAction "ANY" 

If at final P.Res.Code = '' (empty = blank)     

then result is set to  

            P.Res.Code = 'UNK-01'

08.12.2017 3,1443 S.Gueth Settings JCT Check.Settings New: added new check to tc data quality: 

2.3 Check if Dataset Versions are refferenced by folders

01.12.2017 3,1442 S.Gueth Scripts/Params. New: added Drop Down button to JobScript coloumn in Scripts/Parameters in the JobServer 

on clicking this button, it will show you the documentation files of the current script

29.11.2017 3,1442 J.Fes CheckBox Ver.Info Compair Rule: Dimenson objects (Entity_Type26_SubType*) that is visible in the drawing are analyzed 

This Objects has values Status = 3 and ViewDependent <> '' (not empty) 

 

#Doc: this rule is defined since Version 2.0688; 23.09.2010

29.11.2017 3,1442 J.Fes CheckBox Ver.Info Compair Rule: draft objects (Entity_Type25_SubType*) that is visible in the drawing are analyzed 

This Objects has values Status = 3 and ViewDependent <> '' (not empty) 

 

#Doc: this rule is defined since Version 2.0688; 23.09.2010

28.11.2017 3,1442 J.Fes DB UpdDb=Yes Change: Object data tabel extendet:  

Now data colume for puid are extendet from 32 to 64 nvarchars 

This change is required because some application data ID are larger the 32 chars

28.11.2017 3,1442 J.Fes JCT CheckBox Ver.Info New: After converting cgm's to tif via %UGII_BASE_DIR%\NXPLOT\cgm2tiff.exe  

remaining file %tmp%\input.cgm -or- %temp%\input.cgm -or- %UGII_TMP_DIR%\input.cgm will be deleted. 

Is is needet to prevent getting mixed tif files if multible 

conversion jobs are running in the same time on the same JobClient." 

Enhancement implemented by code extensions

27.11.2017 3,1442 J.Fes JobControl Ver.Info Change: Issue: If data of 'Native Site' are processed 

then only 1 object to processed where contained in Job.   

 

Issue is now solved by code changes

21.11.2017 3,1438 J.Fes Import Ver.Info Doc: Import TC Data enhanced 

Anaylse Partfamily data enhanced 

Improvment:  

PFMaster - PFMember releation are now detected via 'IMAN_UG_part_family_link' 

This methode is better then old methode to find  

PFMaster - PFMembers releation find via folder 'Family Members' or 'Familienmitglieder'

17.11.2017 3,1437 J.Fes ObjectJobResults Ver.Info -Action "BOMCompair" -SubAction "EVALUATION" 

During compair BOMLines evaluation of Values enhanced 

If pre or post value is Nothing then evaluation is now evaluated as: 

 'OK' if pre=nothing and post=nothing 

 'ERR' if pre='has value' and post=nothing 

 'ERR' if pre=nothing and post='has value'
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14.11.2017 3,1437 J.Fes Import Ver.Info New: It is now posible to import metadata of 'JT' and 'STEP' datsets into PLMJobManager 

DataSetType supplemented by folowing entrys:  

 - 'File    DS.Type             NamedRef.Type' 

 - 'JT.SP   DirectModel         JTPART' 

 - 'JT.AP   DirectModelAssembly ConfiguredAssembly' 

 - 'STEP.SP STEP                STEP' 

 - 'STEP.AP STEP                StepAssembly'

09.11.2017 3,1436 S.Gueth JCT Doc: default result codes for BOM compair: 

BOM-101: BOM-1pre.xml exists 

BOM-102: BOM-2post.xml exists 

BOM-103: BOM-1pre.xml BOM-2post.xml exists 

BOM-109: Info last mod date of BOM 

BOM-110: BOM IR puid is consistend 

BOM-122: BOM IR Item name is consistend 

BOM-123: BOM IR Rev is consistend 

BOM-124: BOM IR FromSiteId is consistend 

BOM-111: BOM precise/imprecise is consistend 

BOM-112: BOM-Lines count 

BOM-113: BOM-Lines pre ref content 

BOM-114: BOM-Lines post ref content 

BOM-115: BOM-Lines Info about compair 

BOM-116: BOM-Lines Sequence Number compair 

BOM-117: BOM-Lines BOML_OcN_ptt_puid compair 

BOM-118: BOM-Line occurrence notes report 

BOM-118-UGN: BOM-Line BOM-Line occurrence notes UG Name report 

BOM-119: BOM-Line ItemName report 

BOM-120: BOM-Line ItemPuid report 

BOM-121: BOM-Line rev report 

BOM-125: BOM-Line qty_val compair 

BOM-126: BOM-Line trf_rot00 compair 

BOM-127: BOM-Line trf_rot01 compair 

BOM-128: BOM-Line trf_rot02 compair 

BOM-129: BOM-Line trf_rot10 compair 

BOM-130: BOM-Line trf_rot11 compair 

BOM-131: BOM-Line trf_rot12 compair 

BOM-132: BOM-Line trf_rot20 compair 

BOM-133: BOM-Line trf_rot21 compair 

BOM-134: BOM-Line trf_rot22 compair 

BOM-135: BOM-Line trf_per0 compair 

BOM-136: BOM-Line trf_per1 compair 

BOM-137: BOM-Line trf_per2 compair 

BOM-138: BOM-Line trf_tra0 compair 09.11.2017 3,1436 S.Gueth Admin Settings JCT Check.Settings Doc: option "Ignore all conditions" added in result classification rules 

If this property is set to true, then all conditions will be ignored and the result of the given rule will be used

08.11.2017 3,1436 J.Fes ObjectList Ver.Info Doc: In Objectlist process state did not displayed in all cases process status mapped value    

Issue is now solved by code changes

08.11.2017 3,1436 S.Gueth Settings JCT Check.Settings New: -Action "TCDataQuality_2016_09" -SubAction "TCDataQualityCheckVer1" 

Part Family Member (PFM) references will be checked in TC Data Quality check:  

See point 3.6 in data quality settings  

Results for this check are stored  on Item Revision  

error code 361: Partfamily Member Item is not below 'PFMaster-Item-folder' 

error code 362: Partfamily Master has no Partfamily 'PFMaster-Item-folder' 

error code 363: Partfamily Master is missing Partfamily Members 

error code 364: Partfamily Master and Members is missing 'PFMaster-Item-folder 

error code 364: Partfamily Members is missing Partfamily Master

17.10.2017 3,1433 S.Gueth 5546 Settings CheckBox Check.Settings New: Settings for BOMCompair in CheckBox settings: 

1. Trans.Matrix: transformation deviation absolute result rules 

2. Trans.Matrix: rotation deviation absolute result rules 

defines result classification rules for transformation and rotation deviation in the translation matrix

09.10.2017 3,1433 J.Fes JCT Ver.Info Change: -Action "GB_SAPIntegration_2017_01_03" -> SAPChkInUnlogEvaluate 

Methode during SAPChkInUnlogEvaluate enhanced  

In case process step 'SAP CheckIn Unlog' returend no result  

then Result.Code = RFSAP-0002 and Result.Msg = ' .. [CI:ERR:NOT Processed]'
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09.10.2017 3,1433 J.Fes JCT Ver.Info Change: -Action "GB_SAPIntegration_2017_01_03" -> RunConnector 

Methode during RunConnector enhanced  

In case RunConnector returns exit code = 100  

then we retry to Run Connector but allover may 3 times

18.09.2017 3,1429 S.Gueth Settings JCT CheckBox Check.Settings New: added BOM data settings into CheckBox settings 

defines in which way the BOM data should be compared

13.09.2017 3,1428 S.Gueth Scripts/Params. 

Settings JCT

UpdDb=Yes 

Check.Settings

New: Instead of setting parameters for a cmd tools action and subaction in the job script 

you can now define them in the JobManager at: 

 Scripts/Param. -> CMD.Tools.Process.Parameters 

this will generate an xml file with the specified settings 

then you only have to set the xml file name as parameter when you call the cmd tools in the script 

Example: 

JobManagerCMDTools.exe -SubActionSettingsXML SubActionSettingsXmlFileName.xml

30.08.2017 3,1428 J.Fes ObjectList Ver.Info Issue JobMgr did show an 'ERROR Message Box' if no 'f.Site' was selected in case of use:  

 'Object List'  

    |-> 'EXTRA'  

         |-> View all datasets of NX Assembly (analyze by:[BOM structure])  

         |-> View in Datagrid where IRs 'is used' (analyze by:[BOM structure])  

         |-> List in Textbox where IRs 'is used' (analyze by:[BOM structure])  

         |-> Import data of Items/IRs  

         |-> Import data of Items/IRs (incl. Assembly Components) 

  

Now an Information is printed into TextBox

30.08.2017 3,1428 J.Fes Import Sites/Data 

Import

UpdDb=Yes Change: If during data Import/Update Status 'X.PLM.ERR' has been assigned (because an PLM issue happend)  

then status has been assigned to all datasets of IR.   

Behavior is now changed that only the Dataset with the 'PLM issue' get the status 'X.PLM.ERR'

29.08.2017 3,1427 S.Gueth JCT UpdDb=No New: Subaction 'JobData4ResultsReadFromFile' for Action 'JobDataEdit_2012_09' 

sets the process result from a csv file to the coresponding object in the job packet 

example csv file: 

#PUID#;#ResultCode#;#ResultMsg#;#ResultLnk#;#ResultMsgExtendet#;#ResultHasWRN#;#ProcessTimeStart#;#ProcessTimeEnd# 

"B4cJeALIYonpGC";"0";"OK";"";"OK 3 IRS Renamed";"False";"30.01.2017 12:31:21";"30.01.2017 12:34:45" 

"BwUJeALIYonpGC";"0";"OK";"";"OK A001->001";"False";"30.01.2017 12:31:21";"30.01.2017 12:34:45" 

Date format:  dd.MM.yyyy HH:mm:ss

19.08.2017 3,1424 J.Fes ObjectList Ver.Info Change: Application behavior canged 

In 'Obect List' n.Obj was automaticly set 

if an file has been used as the soure to find objects. 

New behavior is now that n.Obj is not anymore changed if an file is used.

19.08.2017 3,1424 J.Fes JCT Ver.Info New: -Action "RefileTC_2012_01" -SubAction "EVALUATE" 

Evaluation is now using _Rf20_RefileJob_2.log for evaluation  

  if _Rf20_RefileJob.log is incomplead  

Background:   

  When refile process failes then _Rf20_RefileJob.log is incomplead 

  please use .\10-JobScripts\RefileNX11\ClientScripts\RfExecute.cmd  

  Version: 19.08.2017

15.08.2017 3,142 J.Fes GUI Ver.Info Change: If Syslog Text Box is was emptied then  

also a new Logfile is generated. 

Hint: all previous logfiles will be keeped.

14.08.2017 3,142 J.Fes ObjectList Ver.Info New: Context menue extended with new entry  

'copy ItemID to clipboard Shift Strg + C' 

this new function allows you to copy parsed ItemId

10.08.2017 3,1419 S.Gueth 5433 Scripts/Params. 

Settings

Check.Settings New: added BOM compair to refile process 

set parameter JobMgr_BOMCompair in refile script to ON
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07.08.2017 3,1419 J.Fes JCT Ver.Info New: -Action "RefileTc_2012_01" -SubAction=EVALUATE"  

has a additional Paramter -UpdateImanFileProps_EXE_DPNE "%JobRoot_DP%\..\BinL\UpdateImanFileProps.exe" 

if this option has a value and points to Program UpdateImanFileProps.exe 

then Process UpdateImanFileProps will be executed.  

To trigger the action please add to RfCustomSetEnv.cmd  

set JobMgr_RfExtEvalROpt=-UpdateImanFileProps_EXE_DPNE "%JobRoot_DP%\..\BinL\UpdateImanFileProps.exe" 

 

if you want to use additional settings then use option: 

 -UpdateImanFileProps_Options -config=''%JobRoot_DP%\..\BinL\UpdateImanFileProps_config.txt''

07.08.2017 3,1419 J.Fes JCT Ver.Info New: -Action "RefileTc_2012_01" -SubAction=EVALUATE"  

has a additional Paramter -UpdateImanFileProps_EXE_DPNE "%JobRoot_DP%\..\BinL\UpdateImanFileProps.exe" 

if this option has a value and points to Program UpdateImanFileProps.exe 

then Process UpdateImanFileProps will be executed.  

To trigger the action please add to RfCustomSetEnv.cmd  

set JobMgr_RfExtEvalROpt=-UpdateImanFileProps_EXE_DPNE "%JobRoot_DP%\..\BinL\UpdateImanFileProps.exe" 

 

if you want to use additional settings then use option: 

 -UpdateImanFileProps_Options -config=''%JobRoot_DP%\..\BinL\UpdateImanFileProps_config.txt''

04.08.2017 3,1416 S.Gueth GUI TaskScheduler 

Settings

Check.Settings New: Clean Up of JobManager data, process data and CheckBox data is now available 

1. via JobManager gui: 'Extra' -> 'JobServer / CheckBox data clean up...' 

2. via Task Sheduler.: 'JobServerCheckBoxCleanUp.vb' 

 

JSSyslog CleanUp.....: defines if the JobServer syslog files should be cleaned up  

                       -> all files older Then 30 days will be deleted 

ProcessData CleanUp..: defines if ProcessData Zip/7z files should be cleaned up  

                       -> all files, that have no refference In JM database will be deleted 

CBData CleanUp.......: defines if the CheckBox data in the given CheckBox data root dir should be cleaned up 

   

                       Clean up by CB xml file: 

                       the process is looking for all xml files that are not refferenced in JM database (as result link) 

within the specified site id's 

                       if there is no refference, the process is also looking for corresponding cgm, tif and syslog files  

                       -> all these files will be deleted 

   

                       Clean up by Item Revision Object: 

                       the process is looking for folders that contains cb xml files 

                       the item revision object will be identified by the folder structure 

                       -> example C:\CBData\Root\ ... \ItemID\Rev\CBExtract.xml 

                       if this object does not exist in the JobManager db within the specified site id's 

                       -> the whole folder (where the xml file is located) within subfolders will be deleted

06.07.2017 3,1412 A.Becker ProcessGroups UpdDb=No Change: When a process state name contains an asterix (*) or a questionmark (?) 

this procState will be automatically declared as QueryOnly 

And will not be displayed within the ProcessState editor window.

06.07.2017 3,1413 J.Fes Import Sites/Data 

Import ObjectList

UpdDb=Yes Change: PLM Structure Error default value changed from:'X.TC.Struc.ERR' to 'X.PLM.ERR'  

During updating Object Data process status will be set from 'X.PLM.ERR' to 'N' 

If value for colume 'O.Imp.Msg WRN/ERR' do not contains text 'ERR' anymore.

20.06.2017 3,1412 J.Fes Settings JCT Check.Settings New: BOMCompair Options enhanced option:  

-BOMCompairForProcess  

 valid values are: P1_TcSiteCons (Default) // P2_CMM

19.05.2017 3,1406 J.Fes Settings JCT Check.Settings New: BOMCompair Options enhanced with 2 more options  

-BOMCompairDoCompairOCN with option: 

   ON  = sets to compair OCN (Default) 

   OFF = sets to disable compair OCN 

-BOMCompair BOMRef Find Methode with option: 

   M1_byBOMPuid = sets to find ref BOMLines via BOMPuid   

   M2_byBOMData = sets to find ref BOMLines via BOMData ir_puid and pseq + order number  

   M3_byAutomation = sets to find first like 'M1_byBOMPuid' if not found then via 'M2_byBOMData' (Default)

27.04.2017 3,1403 J.Fes CheckBox Ver.Info Change: CheckBox settings enhanced  

It is now possible to define 'File Name Scheme' for CheckBox Filename conventions
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25.04.2017 3,1401 J.Fes Import UpdDb=Yes Ver.Info New: It is now posible to use oracle optimicer hints in JobMgr .sql   

See settings Site/Data Import-> 

Start Dialog Edit Site def. --> Import Settings 3 

 4 - Import eXtendet 

     4 - use Oracle optimizer hint' '/*+ parallel (n) */' 

     5 - use additional Oracle optimizer hints 

         #Doc: see https://docs.oracle.com/cd/B10500_01/server.920/a96533/hintsref.htm

17.04.2017 3,14 J.Fes ObjectList UpdDb=Yes Ver.Info New: It is now posible for TC Sites to list or view Ir's where used in BOMS 

see Object List -> Extra -> View where IRs 'is used' (analyze by:[BOM structure])   

see Object List -> Extra -> List where IRs 'is used' (analyze by:[BOM structure])

14.04.2017 3,14 J.Fes Import Sites/Data 

Import JobControl 

Settings

Passwords are encrypted stored in JobMgr database. 

JobServer sends password also encrypted to JobClient 

If you now insert a password into JobMgr then it is required  

to enter the full password form the beginning.  

 - PLEASE Note: A before stored password cannot be edit because it is already encripted: --!!. 

   !! - Value of an before stored password cannot be edit - !!  

   !! - because if value is already                       - !!.

13.04.2017 3,1318 J.Fes ObjectJobResults 

Settings

Check.Settings New: Now it is posible to customice JobComputers header text  

vor columes x.Custom01 .. x.Custom04

13.04.2017 3,1318 J.Fes JobControl UpdDb=Yes Doc: JobComputer settings removed unused Data columes  

- [OsUser]  - [OSPassword] - [OSDestrib_DP]

10.04.2017 3,1318 J.Fes Install and Setup Ver.Info Change: JobSever SQL DB connection supports now 

windows user authentication mode

05.04.2017 3,1313 J.Fes Import Sites/Data 

Import

Ver.Info Change: During Import TC.Data to JobMgr  

 - data of: 'IContr:Ir.ModDateBegin' and - 'IContr:Ir.ReleaseDateBegin' 

are in some cases not correct set/updated.  

Issue is now solved by code changes

24.03.2017 3,1309 S.Gueth JCT New: added MigrationReportEval_cls class for CMM eval process 

to get status value from cmm MigrationReport xml file 

value is parsed from: Migration > Session > Report > Status > OperationStatus 

if status is 'failure' --> res code RPTS-01 will be set

24.03.2017 3,1309 S.Gueth JCT New: added MigrationReportEval_cls class for CMM eval process 

to get status value from cmm MigrationReport xml file 

value is parsed from: Migration > Session > Report > Status > OperationStatus 

if status is 'failure' --> res code RPTS-01 will be set

24.03.2017 3,1309 S.Gueth Settings JCT Check.Settings New: -Action "CMM2NX_2021_06" -SubAction "CMM_ResultEval" 

New parameter CMM_REPORT_DIR and CMM_REPORT_TARGET_DIR added 

CMM_REPORT_DIR.......: path to the directory where the cmm reports 

                       will be sored into generated with CMM Process 

CMM_REPORT_TARGET_DIR:path to the root directory where the cmm reports will be stored  

                      during CMM Process evalueation with JobMgrCmdTools

24.03.2017 3,1309 S.Gueth Settings JCT Check.Settings New: -Action "MigIdeas2NX_2013_10" -SubAction "CMM_ResultEval" 

New parameter CMM_REPORT_DIR and CMM_REPORT_TARGET_DIR added 

CMM_REPORT_DIR.......: path to the directory where the cmm reports 

                       will be sored into generated with CMM Process 

CMM_REPORT_TARGET_DIR:path to the root directory where the cmm reports will be stored  

                      during CMM Process evalueation with JobMgrCmdTools

23.03.2017 3,131 J.Fes JCT Ver.Info New: MigIdeas2NX_2013_10.CMM_ResultEval.CMMProcessesStop extended 

new options avilable 

 -StopProcessesTCServer  

 -StopProcessesCMM  

#Doc: If Parameter is set then stop of processes will be done 

#Doc: Default is not to stop the processes 

 

also XCADServices will be stopped
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23.03.2017 3,131 J.Fes JCT Ver.Info New: MigIdeas2NX_2013_10.CMM_ResultEval.CMMProcessesStop extended 

new options avilable 

 -StopProcessesTCServer  

 -StopProcessesCMM  

#Doc: If Parameter is set then stop of processes will be done 

#Doc: Default is not to stop the processes 

 

also XCADServices will be stopped

23.03.2017 3,1308 S.Gueth Settings CheckBox Check.Settings New: CheckBox Compare for PH.PatternArchiving and PH.PatternShading added 

you can change the setting 'PH.is Pattern do check' in the CheckBox Settings 

to define if the check should be executed or not 

!attention!: check will only be executed when pattern data is available on both CB extracts

21.03.2017 3,1308 S.Gueth Admin Settings Check.Settings New: Environment variable 'JobMgr_WIMode' will be set in JobClient before executeing a job 

possible values: [NotSpecified|Normal|Minimized|Hidden]

21.03.2017 3,1308 S.Gueth 5118 GUI New: key 'Spacebar' in JobClient 

Switches JobClient to previous job client mode, when client is currently in pause mode

16.03.2017 3,1308 S.Gueth CheckBox New: New Check added if current dataset is a pattern part or not 

this information is added to P.Res.Msg.Ext.Data  

#Example: [PH:isPatternPart:ON|OFF]

16.03.2017 3,1308 S.Gueth Settings CheckBox Check.Settings New: added CheckBox compare in drawing data for pattern parts 

this check is enabled by default and can be disabled by changing the 'DR.Pattern Condition:Do Compare' setting in the CheckBox 

Settings

15.03.2017 3,1308 S.Gueth Admin Ver.Info Change: changed whats new excel file from .xls to .xlsx

10.03.2017 3,1307 S.Gueth JCT New: Subaction 'AttributeSync' in Action 'CustomCmdTools_2016_04' 

Process to sync specific NX dataset attributes to tc ir object

09.03.2017 3,1308 J.Fes Admin Ver.Info New:

20.02.2017 3,1302 S.Gueth CommandLineArgs JCT New: parameter 'StepExportViaUGExport' in Action 'NxDataProcessing_2013_09', Subaction 'StepExport' 

if set, step export will be executed via ug_export (not via teamcenter)

20.02.2017 3,1303 J.Fes Install and Setup Ver.Info Change: JobMgr SQL scripts is now unsing SQLcmd.exe methodes. 

Usage of SQLcmd.exe replaces usage of OSQL.exe

20.02.2017 3,1303 J.Fes Install and Setup Ver.Info Change: JobMgr check's now if SQLcmd.exe  is installed on Computer 

If SQLcmd.exe  is not installed on computer a error messagebox will be shown.

08.02.2017 3,1299 J.Fes Scripts/Params. Ver.Info Change: JobScripts methodes redesigned.   

If the JobData as text files need to be add to the JobPacket   

then please add to job main script:  

 - for ObjectsList..........:  set JobAddFile_ObjectsList_txt=true 

 - for ObjectsListAllDetails:  set JobAddFile_ObjectsListAllDetails_txt=true

07.02.2017 3,1299 J.Fes ObjectList ObjectData selection enhanced 

Now it is possible to set object selection based on displayed data in data grid. 

 

This selection Methode is now avilabel for folowing data columes: 

 - O.Name 

 - Register P.Data 

   - Packet.N 

   - On.Comp. 

   - Res.Code 

   - Res.Msg 

   - Res.MsgE (eXtendet)

07.02.2017 3,1299 J.Fes JobControl Ver.Info Change: JobServer and JobClient stopt processing if temp dir was cleand during running application. 

Issue is now solved by code changes.
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20.01.2017 3,1293 J.Fes Import Sites/Data 

Import

Ver.Info Change: TC.Data import dataset version count was disabled in case 

 folowing setting was disabled: 

 Sites/Data Import  

   |-> Import Setting 1 -> Import Data Conditions -> Import DS Full File Names  

       |-> Import Data Conditions -> Import DS Full File Names  

           |-> Import Data Conditions  

               |-> Import DS Full File Names = false (disabled)  

  

This behavior is a illogical behavior. 

 

Now JobMgr Dataset version generation is now only depeding on setting: 

  Sites/Data Import -> Import Settings 3 -> 4 - Import eXtendet -> 3 - DataSet Version count Enable/Disable 

    |-> Import Settings 3  

        |-> 4 - Import eXtendet 

            |-> 3 - DataSet Version count Enable/Disable 

 

Issue is now solved by code changes

19.01.2017 3,129 J.Fes JobControl UpdDb=Yes New: JobProcessing enhanced. It is now posible to import JobResults results 

via identifing the Data by @ObjectFromSiteID, @ObjectClass, @ObjectName 

Please note this funtion may be only used in database containing unic names by @ObjectFromSiteID, @ObjectClass, @ObjectName 

 

In programming JobMgr.CMD tools please use:  

 ObjectData_cls.ObjectSpecialEditRuleSet = ObjectSpecialEditRule_enum.ObjectfindBy_FromSiteClassObjectName

03.01.2017 3,1285 J.Fes JobControl Ver.Info New: New NX10 refile parameter -set_new_dataset_owner 

is now avilable via refile parameter editor

01.01.2017 3,1284 J.Fes JCT Ver.Info Change: -Action "AppUid_2012_02" -ParseAppUidResultsFile  

Evaluation of results is now matching the processed datasets 

Evaluation of process returns for a processed Dataset P.Res.msg = "AppUid:OK:Upgraded"   

Evaluation of process returns for a all other Object P.Res.msg = "AppUid:OK"

22.12.2016 3,1283 J.Fes 4027 Import Ver.Info Change: Import TC.Data via Item-List printed always all found IR's after each anayse of Item. 

This Issue did leads to a long import process time, if many Items was in the Item-List. 

Issue is solved by code changes

21.12.2016 3,1282 J.Fes 4028 Import Sites/Data 

Import

Ver.Info Doc: During Process Sites/Data -> Import 10 - Sync.Site [Items Only] an Exception did happend.  

This Software Issue lead to unwanted deletion of Data in JM.DB. 

Issue is solved by code changes 

 

Improvment: Software stops now Sync.Site processing  

if reading data from TC.DB or JM.DB lead to an Exception or Error

21.12.2016 3,1282 J.Fes Import Sites/Data 

Import

Ver.Info Change: TC Site/Data Import/Update did not updatet data in all cases.  

Issue is now solved by code changes

14.12.2016 3,1297 J.Fes Import Sites/Data 

Import

Ver.Info New: Enhanced setting for import multisite data 

It is now posible to eXlude for Objects the add of 'SiteId' 

to 'Exported Site List' via ExportRecorde.ExportReason 

 

see: Sites/Data Import  

       |-> Import Settings 3  

            |-> 3 - Import Multisite settings eXtende  

                |->  2 - Export Recorde eXclude via Export Reason

12.12.2016 3,1296 J.Fes JCT Ver.Info Change: -Action MigIdeas2NX_2013_10 -SubAction ChangeOwner_ResultEval   

add for CMM processing  

It do check result's of process: ChangeOwner 

Check condition OK: Dataset.Owner is not like any value of -ChangeOwner_FinalNotToLike  

Check condition ERR: Dataset.Owner is like any value of -ChangeOwner_FinalNotToLike

12.12.2016 3,1296 J.Fes JCT Ver.Info Change: -Action MigIdeas2NX_2013_10 -SubAction ChangeOwner_ResultEval   

add for CMM processing  

It do check result's of process: ChangeOwner 

Check condition OK: Dataset.Owner is not like any value of -ChangeOwner_FinalNotToLike  

Check condition ERR: Dataset.Owner is like any value of -ChangeOwner_FinalNotToLike
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07.12.2016 3,1293 J.Fes Import Sites/Data 

Import

UpdDb=Yes New: It is now posible to refresh JM.DB Data that has O.Need.Upd flag 

 

This new function can be used 

 

Interactiv: 

----------- 

Sites/Data Import -> Import.Site.Data  

  |-> during this sync process it is first used all other import actions follows 

Sites/Data Import -> Sync.Site.Data-> 40 - Sync.Site [Data with O.Need.Upd>0]  

  |-> Only Data with O.Need.Upd>0 will be refereshed  

 

Tasksheduler: 

------------- 

Script: S:DataImport_Tc_DataSetsAndIrs.vb Parameter: /SiteList=HIL_QS /Methode=Sync_NeedUpdateAndEnd 

  |-> Only Data with O.Need.Upd>0 will be refereshed

07.12.2016 3,1291 S.Gueth 110 Admin Settings 

CheckBox

Ver.Info 

Check.Settings

New: 

Doc:

das ist neu 

#Doc: test1 

#Doc: test2

06.12.2016 3,1289 S.Gueth GUI Import Sites/Data 

Import Settings

Check.Settings New: New button 'TC Multisite Check' in 'Sites/Data Import' tab 

execute TC Multisite Check directly for a specific site 

all objects with state N,M or A that are in the Site Group def of the selected site will be processed

06.12.2016 3,1291 J.Fes Import Sites/Data 

Import

Ver.Info New: Sync.Site.Data new Sync Methodes avilable  

Sync.Site.Data has now 4 Options to Sync Data between JM.DB and TC.DB 

- 10 - Sync.Site [Items Only]  

- 20 - Sync.Site [Ir Only] 

- 21 - Sync.Site [Ir + Import.Site.Data]  #New:06.12.2016 

- 30 - Sync.Site [Items/Ir + Import.Site.Data] (Default) 

- 40 - Sync.Site [Data with O.Need.Upd>0] #New:06.12.2016

06.12.2016 3,1289 S.Gueth Import Sites/Data 

Import TaskScheduler 

Settings

Check.Settings New: added "Clients to execute check" option to "Site Groups definition" 

this option defines the clients that are allowed to execute the multisite check (wildcards like * can be used) 

this option is valid for TC Multisite Check via 'TaskScheduler' or 'Sites/Data Import' tab

28.11.2016 3,1288 J.Fes Import Sites/Data 

Import

UpdDb=Yes New: If dataset has a PLM Structure Error then all Datasets of IR will be set  

for Processgroups P01..P20+PRf to status='X.PLM.ERR' if there status was before = 'N'  

Application Change is done in T-SQL Script:  

 .\01-BinServer\Resources\JobMgrSQL\JobMgr_30_ApplProceduresObjects_Import_DataSets_and_IRs.sql

24.11.2016 3,1287 J.Fes ProcessGroups Ver.Info New: In some cases ProcessGroup settings was not saved during Edit Process Status    

Issue is solved by code changes.

24.11.2016 3,1287 J.Fes JobControl 

ProcessGroups

Ver.Info New: It is now posible to move ProcessGroups 01..40 up and down.  

Info: JobControlRules ProcessGroups are also moving. 

Important current version do not moves existing Process Results n JobMgr.DB

24.11.2016 3,1286 J.Fes JobControl Ver.Info Doc: New Replacment #Var avialble for 

#40-JobServerScripts_DP#     -> Location for JobServer.net Scripts 

#40-JobServerScriptsL_DP#    -> Location for JobServer.net Local on JobServer

16.11.2016 3,1283 J.Fes JobControl Ver.Info New: You can now define that a Job  

Add 'Site Definition' of JobComuters default SiteDef 

see Tab: Job Control  

    -> Edit JobContol Rule  

       |-> Job Definition Extended  

           |-> 2 Sites  

               |-> Add 'Site Definition' of JobComuters default SiteDef

15.11.2016 3,1281 S.Gueth CommandLineArgs JCT New: Parameter 'ObjectPUIDs' for subaction 'EditObjects' in action 'JobDataEdit_2012_09' 

Semicolon separated list of Object PUIDs 

only objects with the given puids will be edited

26.10.2016 3,1278 J.Fes Import Sites/Data 

Import

Ver.Info New: Enhanced settings for enable disable count of datasets  

Please see site settings:  

Sites/Data Import -> Import Settings 3 -> 4 - Import eXtendet -> '4.03 - DataSet Version count Enable/Disable'

14.10.2016 3,1276 J.Fes Import Ver.Info Doc: On Importing manuel (via Extras->Import data of Item / IR)  

Process Optimiced 

  See settings in:  

   Sites/Data Import -> Import Settings 3 -> 4 - Import eXtendet -> Import by list:force Import/Update
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14.10.2016 3,1276 J.Fes Import Ver.Info Doc: On Importing manuel (via Extras->Import data of Item / IR)  

Process Optimiced 

  See settings in:  

  Sites/Data Import -> Import Settings 3 -> 4 - Import eXtendet -> Import by list:force Import/Update

13.10.2016 3,1276 J.Fes Scripting TeamCenterMultiSiteCheck via Tasksheduler - Script is processing all data  

having status 'N' 'M' or 'U'

13.10.2016 3,1276 J.Fes Import Sites/Data 

Import

Ver.Info New: Enhanced settings for define how import behavior is during Import by list   

Please see site settings:  

Sites/Data Import -> Import Settings 3 -> 4 - Import eXtendet -> '4.02 - Import by list:force Import/Update'

13.10.2016 3,1276 J.Fes Import Sites/Data 

Import

Ver.Info New: Enhanced settings for define if Import.Site.Data is active/avilable   

Please see site settings:  

Sites/Data Import -> Import Settings 3 -> 4 - Import eXtendet -> '4.01 - defines if Import.Site.Data is active'

21.09.2016 3,1271 J.Fes Import Sites/Data 

Import

Ver.Info Change: New Option avilable for setup how MultiSite data are handelt. 

 

see:Sites/Data Register: 'Import Settings 3'  

                          -> 3 - Import Multisite settings eXtendet  

                           -> Multisite Import pSiteId behavior 

 

With this Option you can now define if you want to insert TC.Multisite pSiteId data 

If Site is not regestiert in JobManager Sites/Data

16.09.2016 3,1269 J.Fes JCT Ver.Info Change: If for NX Part no NX.sylog section is found then  

then JobLink is set to NX.syslog of Job

16.09.2016 3,127 J.Fes JCT Ver.Info Change: In case that a Demandload action during refile was prossesed then   

NX.syslog parser did not found the right syslog section for part. 

Issue is solved by code changes in JCT

24.08.2016 3,126 J.Fes Import Change: BOM selfref analyse returns now  

Item.ID of BOM where Start ITEM.ID is fond in lower structure

24.08.2016 3,126 J.Fes Import Change: BOM selfref analyse returns now  

Item.ID of BOM where Start ITEM.ID is fond in lower structure

19.08.2016 3,1258 J.Fes Import Sites/Data 

Import

Ver.Info New: Enhanced settings for enable debugging during Import process  

Please see site settings:  

Sites/Data Import -> Import Settings 3 -> 4 - Import eXtendet -> '4.17 - Debug during import'

19.08.2016 3,1258 J.Fes Import Sites/Data 

Import

Ver.Info New: JobServer Enhanced setting for import multisite data  

 

see: Sites/Data Import  

       |-> Import Settings 3  

            |-> 3 - Import Multisite settings eXtende  

                |->  1 - Multisite Import pSiteId behavior

15.08.2016 3,1256 J.Fes JCT Ver.Info New: Result classification methode extendet to parse results from Datalines via   

Now you are able to define 'left keyword' and 'right keyword' to parse result from DataLine. 

 

#Example: 

Text Line........: CSYS_Refile: 4711/A2/Energy regulator: Object names already 

exist:DATUM_CSYS_0_PLANE_XY,DATUM_CSYS_0_PLANE_YZ 

Result parse def.: #Txt.ParseLeft#=#regulator: #,#Txt.ParseRight#=#:# 

Result is final..: Object names already exist  

 

#Hint: 

If Only Txt.ParseLeft is defined then Result is parsed from left keyword until end of text Line.  

If Txt.ParseRight do not match in Text Line then Result is parsed from left keyword until end of text Line.

05.07.2016 3,1251 J.Fes JobControl Ver.Info New: Now ist is posible to include script or resource files into your JobScript 

 

#Example:  

 add to your JobStartScript folowing line definition: 

  set JobMgr_10-JobScriptsInc_01=_CustomDefaults\TcPrompt_Custom 

  set JobMgr_10-JobScriptsInc_02=_CustomDefaults\TcTool_Custom 

  

then all Script files in:  

 ..\10-JobScripts\_CustomDefaults\TcPrompt_Custom   

 ..\10-JobScripts\_CustomDefaults\TcTool_Custom 

 will be added into root dir of JobFiles
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04.07.2016 3,1247 S.Gueth Import Sites/Data 

Import TaskScheduler 

Settings

Check.Settings New: added "Sites to check" option to "Site Groups definition" 

this option defines the sites on which items will be checked 

Example: 

Members in site group: Site1, Site2, Site3 

Sites to check.......: Site1, Site3 

--> only objects of site1 and site3 will be checked with TC-multisite check

04.07.2016 3,1248 J.Fes JobControl Ver.Info Change: During Importing JobResults with multible JobServers import stoped with message  

The process cannot access the file because it is being used by another process. 

To solve the issue we handel for each JobServer one own directory 90-JobTempImportExecute\#ComputerName#_P#TcPeerPort# 

Issue is solved by code changes

30.06.2016 3,1248 J.Fes JobControl Settings Check.Settings Doc: JobPacket contains now TcPrompt_Custom.cmd file  

if exist in ..\10-JobScripts\TcPrompt_Custom.cmd 

This file can be used to orgenice teamcenter prompt for all Jobs

27.06.2016 3,1247 J.Fes CheckBox Ver.Info Doc: CheckBox Assembly Check enhanced it compairs 

Now it compairs also Handel and Inst.Handel 

CheckBox returns waring if Handel or Inst.Handel do not match

17.06.2016 3,1245 J.Fes Admin ObjectList UpdDb=Yes Doc: Removed Unused Data and settings   

SelectByMarker condition Function is replaced by  

Group selection methode

14.06.2016 3,1243 S.Gueth Settings JCT Check.Settings New: New Paramater for SubAction: DataShare in Action: TCMultiSite_2012_02_02 

-IgnoreMissingObjectsOnSourceSite 

if this option is set, then missing objects that exist on target site, but not on source site will be ignored

07.06.2016 3,124 J.Fes 2654 Import UpdDb=Yes New:

31.05.2016 3,1237 J.Fes Import UpdDb=Yes Ver.Info New: It is now posible to define witch dataset types will be imported  

into JobMgr.DB. 

See settings Site/Data Import-> 

Start Dialog Edit Site def. --> Import Settings 3 

then define witch Dataset Types are to import in to JobMgr.DB 

Avilable settings are: 

 -NX 

 -Ideas 

 -Catia 

 -ProE 

 

By default only NX Dataset types are switched on  

to enable DS.Types please set value to 'true'

04.05.2016 3,1235 J.Fes 2583 JobControl UpdDb=Yes New: JobControlRules extendet: 

It is now possible to control JobPacket containment based on 

values of ObjectData in Colume: O.AP.CompN.Unique 

 

Avilable conditions are: 

 - count of Assembly Object ComponentsN Unique 

   see setting: JobControlRule 'O.Max.Comp.Unique' 

 

 - sum of Assembly Object ComponentsN Uniqee 

   see setting: JobControlRule 'J.MaxSum.CompN.Unique'

29.04.2016 3,1234 J.Fes 2691 Import UpdDb=Yes Ver.Info New: TC Data Import enhanced. 

JobMgr.TC Data Import support's now also to Import/Update JobMgr Database  

This Import Methode uses the folowing rules:  

 - Updates existing JobMgr.DB data only if Ir.ReleaseDate or Ir.ReleaseState has been changed. 

 - adds 'NEW' Data to JobMgr.DB also if Data are not released 

 - Do NOT Updates existing JobMgr.DB data if Ir.LastModifyDate or ReleaseState has been changed.

 39 / 73
Release Date/Time: 25.11.2025 08:48

Relase Version: 3.2000.2511.2025



PLMJobManager: What's New

Date Version User Issue-Nr Categorie Additional Info Type Description

26.04.2016 3,1234 J.Fes 2722 Scripting Ver.Info Change: JobServer 'Scripting engine' supports now  

usage of external .dll's and resources 

 

to use it you need to define your JobServer custom script  

via JS: Task Scheduler -> Script -> C:SubDir\ScriptName.vb 

 

#Example:  

define in JS: Task Scheduler -> Script -> C:CustomDll_Example\CustomDll_Example.vb 

 

Click on Button Edit Script:  

It will create the directory: 

 -> ..\90-DATA\#CustomerNameShort#_SettingsGlobal\40-JobServerScripts\CustomDll_Example 

It will create in the directory the new Script: 

 -> CustomDll_Example.vb 

  

Put all .dll's and resources into this directory  

Example: CustomDll_Example.dll  , CustomDll_Example.pdb, CustomDll_Example.xml 

 

Add References to your your JS.script after section Imports 

Imports ..   

'References CustomDll_Example.dll 

 

With this Methode you can integrate external .dll in Jobserver TaskSheduler processes.

25.04.2016 3,12342 A.Becker Scripting New: Scripts can now reference external libraries without the need to copy the dll files into the application directory. 

It is required to create an individual subfolder for scripts with external assembly references. 

All referenced assemblies including their own dependencies have to be stored to the directory of the script.

15.04.2016 3,1234 S.Gueth 2625 TaskScheduler 

ObjectList Settings

UpdDb=Yes 

Check.Settings

New: TeamCenter Multisite Consistent Check (TC.MSC) can now be triggered directly from JobManager 

1. via Objects List -> Extra -> TC MultiSite Check 

2. via Task Scheduler -> Skript: MultiSiteCheck_Tc.vb 

Attention: Site Groups have to be defined in Sites/Data Import -> Admin -> 2 - Edit 'MultiSite-Groups' settings 

Results: 

MSC.00.OK  : Objects are in sync 

MSC.10.ERR : More then one OwningSite Object exist (Duplicated Items) 

MSC.11.ERR : No OwningSite Object exist 

MSC.12.ERR : Item with same ItemId and different puid 

MSC.13.ERR : Items have different Item types 

MSC.14.ERR : OwningSite-Item has no export record, but Items with same ItemId exist 

MSC.15.ERR : There is not only exactly one item for each export record 

MSC.16.ERR : The release statuses of items are different  

MSC.18.ERR : Item with same puid and different ItemId exist 

MSC.21.ERR : IRs on remote site are different then on OwningSite 

MSC.22.ERR : Release status of item revisions are differnet 

MSC.31.ERR : Datasets on remote site are different then on OwningSite 

MSC.32.ERR : Release status of datasets are different

13.04.2016 3,1233 J.Fes Import Sites/Data 

Import

Ver.Info New: Datamodel extendet JobManger Analyses now for 'NP' = NoPart Objects also BOM Data 

Part Type extendet with Name 'NPwB' NoPart with BOM

12.04.2016 3,1233 J.Fes ObjectList Ver.Info Change: Open NX - Part did not worked for TC - NX.Part 

Issue is solved by code changes.

01.04.2016 3,1233 J.Fes JCT Ver.Info New: Enhancmend FlipTheSwitch is now evaluating FlipTheSwitch Report

29.03.2016 3,1233 J.Fes 2688 JobControl Ver.Info Change: JobRule Condition: 'J.valid on Site' was not correct evaluated. 

Now a JobRule will be only used if JobClient Name and J.valid on Site matches exactly.  

Issue is solved by code changes.

23.03.2016 3,1233 J.Fes JCT Ver.Info New: JobClientTools extendet with -Action "RefileNative_2016_02" -SubAction "PartByPart" 

With this Methode it is possible to refile 'Native NXParts' with in the JobManager
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04.03.2016 3,1232 J.Fes ObjectList Ver.Info New: Count Only in 'Object List' implementet 

In some cases you want only the the amount of objects  

without displaying the data in the Data grid. 

For his we implemented the folowing methode 

 

Usage: 

------ 

 Hold shift key down during clicking on 'Search & List' Button 

 then JobServer counts only the object but do not list them in the datagrid.

02.03.2016 3,1232 J.Fes ProcessGroups UpdDb=Yes Change: New ProcessGroup ProcessGroupMc is now avialable. 

ProcessGroupMc is a special Process Group to use for TC-MultiSite Check's

02.03.2016 3,1232 J.Fes CommandLineArgs Ver.Info Usage JobServer /AutoStart Commanline args: 

 /AutoStart JobControl:A                   Start JobManager with active JobService   

 /AutoStart TaskScheduler:On               Start JobManager with active TaskSheduler   

 /AutoStart JobControl:A-TaskScheduler:On  Start JobManager with active JobService and TaskSheduler

28.02.2016 3,1232 J.Fes JCT New: SubAction "PLMxml_Export" in Action "TcPLMxml_Export_2016_02" 

Method to export 'TC-PLM.xml' files from teamcenter via Tool: PLMxml_Export.exe

24.02.2016 3,1231 J.Fes JobControl Ver.Info Change: Refile parameter editor supports now -debug=yes!no option.

16.02.2016 3,1231 J.Fes ObjectList Ver.Info New: Open NX 

Supports now also open native parts

08.02.2016 3,1231 S.Gueth JCT Change: Item name and ItenRevison name was added to the I IR BOM DS exctract and compare process for DataShare / DataSync evaluation

04.02.2016 3,1231 J.Fes ObjectList Ver.Info New: Editor to set Process Status of Objects are extendet 

 

Now it is posible to set Status of all Dataset includet in Item-Revisions of BOM's 

see new Option: 'inc.AP-BOM Component' 

 

Now it is posible to set Status of all Dataset includet in Items of BOM's  

see new Option: 'inc. Data of Item' 

to use this Option you need to use 'inc.AP-BOM Component' and 'inc. Data of Item' 

 

By default ProcessStatus values starting with 'X*' is more protected 

to force change the status in this cases use new Option 'edit e'X'cludes' 

see new Option: 'edit e'X'cludes'

22.01.2016 3,123 S.Gueth 2539 Settings Check.Settings Change: added "Import Licence" button in JobServer settings 

you can also import a licence file via drag and drop

22.01.2016 3,123 J.Fes Install and Setup Ver.Info Change: Unused ..12-Data\_Rf_MC_ConvertLog Direcory   

will be automaticly removed from System

22.01.2016 3,123 J.Fes Install and Setup 

Settings

Check.Settings Change: From this Version setting Dir_Root3_10JobLogArchivAlternative_DP need to update 

If rule was in use existing setting will be 1 time automaticly updated with subdir \JobManagerV2 

!!-- Please check settings after update --!!

14.01.2016 3,123 S.Gueth Settings Change: added Excel 2007 export format (*.xlsx) to excel export 

you can choose between Excel 2007 (*.xlsx) and Excel 97-2003 (*.xls) format 

*.xlsx is now the default export format

11.01.2016 3,123 S.Gueth/A.

Becker/J.Fe

s

2477 Install and Setup UpdDb=Yes Ver.Info Change: ******************** NEW Software Release PLMJobManagerV3 ********************* 

**                                                                           ** 

** Version change:                                                           ** 

**  - from: V2 PLMJobMangerV2 uses .NET Frame Work 2.0                       ** 

**  - to..: V3 PLMJobMangerV3 uses .NET Frame Work 4.5                       ** 

**                                                                           ** 

** Hints:                                                                    ** 

** ------                                                                    ** 

**  - The new Release requires installed .NET Frame Work 4.5                 ** 

**    on all Computers using JobServer or JobClient software components      ** 

**  - Apllication root diretory is now: ..\JobManagerV3                      ** 

**  - Older Version V2 based on .NET Frame Work 2.0 is still avilable on web ** 

**    http://download.plmjobmanager.com/JobManagerV2/V2-0001-LatestVersion/  ** 

******************** NEW Software Release PLMJobManagerV3 *********************

18.12.2015 2,1221 J.Fes JCT Change: IrInfoResolve_2011_06 Enhanced 

Now we support #BOMview Info and #BOMviewRevision Info
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16.12.2015 2,1221 J.Fes Install and Setup 

Settings

Check.Settings Change: Commandline parameter renamed  

from TCEGroup to TCGroup 

from TCEGroup to TCGroup

14.12.2015 2,1221 S.Gueth 2440 Settings JCT Check.Settings New: SubAction 'NXJournalExecute' for Action 'NxDataProcessing_2013_09' 

to execute an journal for NX 

for more info please have a look into the cmd tools docu of 'NxDataProcessing_2013_09'

11.12.2015 2,1221 S.Gueth Settings JCT Check.Settings New: DataShare - and DataShareEval processes can now be executed only for ItemRevisions 

just set the variable 'ObjectClass' in the TcSiteCons.cmd job script to 'ItemRevision' (default is 'Item') 

example: set ObjectClass=ItemRevision

04.12.2015 2,1221 J.Fes JobControl Ver.Info Change: JobControl sort order based on Dataset Types improved 

If JobRoule includes Datasets of IRs then order of: 

 

NX Datasets are: 

 - UGMASTER      

 - UGALTREP     

 - UGMANIFESTATION     

 - UGPART    

 - all other NonMaster DataSet Types like UGSCENARIO..CAEGEOM..NXMotin ...  

 

IDEAS Datasets are: 

 - IdeasPart 

 - IdeasAssemblUGPART    

 - IdeasDrawing 

 

ProE Datasets are: 

 - ProPrt 

 - ProAsm    

 - ProDrw 

 

Catia Datasets are: 

 - CATPart 

 - CATProduct    

 - CATDrawing

25.11.2015 2,1221 J.Fes JobControl Ver.Info Change: Refile Option dialog enhanced 

- refile options now orgeniced by captures. 

- Captures are show with 'gold' BackColor 

- NX10 refile options added  

- Filter in options are posible

25.11.2015 2,1221 J.Fes Import Sites/Data 

Import

Ver.Info Doc: ItemId search supports now wildcards  

If searching value of ItemIds contains wildards then all   

Items and Irs are listed.  

  

for example you are able to import all Items and IR's  

via 4700*

24.11.2015 2,122 J.Fes JobControl Ver.Info New: JobControl Object selection methodes enhanced  

Now you can select all Data of Item via new option: ALL_of_ITEM 

See: JobContol Rules sel:O.Special

19.11.2015 2,122 A.Becker ObjectJobResults UpdDb=No New: JobLog Link can be direct opened from a 7-Zip file.

16.11.2015 2,122 J.Fes JobControl Settings Check.Settings New: New Option to control how JobData handelt if a ne Job is created. 

see: -> Edit JobControl Rule  

     |-> Job Definitionen Extended   

      |-> 3 Job Managment Extendet  

       |-> 1 New Job Process Data Handel (Default is AddEdit2JobNew)

10.11.2015 2,1219 A.Becker UpdDb=No New: JobClient writes log informations to %temp%\JobClient\JobClient.log (Levels info/warning/error/fatal). 

Fatal unhandled exceptions are logged to %temp%\JobClient_UnhandledException.log (But they should normally never occour).

09.11.2015 2,1219 S.Gueth JCT New: If there was no Refile Result found and no result from the nx syslog, then the process monitor log will be parsed 

This result will be written in the refile result message, Example: 

Result Message: [Rf:ERR:PM Terminated:none of the monitored files was written to within 600 sec.] 

Result Code is: JM-999070
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07.11.2015 2,1219 J.Fes Import Sites/Data 

Import

Ver.Info New: Sync.Site.Data compairs now also ExportRecorde ExportRecordeData 

If TC.DB and JM.DB Export Recordes differs then Data will updatet

07.11.2015 2,1219 J.Fes GUI Ver.Info Change: Outputformat of Exception messages optimiced 

- Output with is minimiced 

- Useless SourceCode pathes removed 

- Stack trace contains numers in front of message

06.11.2015 2,1219 S.Gueth GUI New: In the column "J.last Info" of the table "JobComputer Computers" in the  

JobServer you will now see the current system load of the client 

(CPU utilization, memory usage, free disc space state) 

if there is a warning or an error this column cell will get the  

coresponding background color: 

Sys load: OK  --> green 

Sys load: WRN --> cyan 

Sys load: ERR --> red

05.11.2015 2,1219 J.Fes JobControl Ver.Info Change: New behavior during creating Jobs. 

To reduce times for creating new Jobs we do create pre JobResults in this phase NOT anymore. 

Only Objects P.Status is changed.  

Hint: JobResults will be createt to JobMgr Database when JobResults returns from JobClients.

05.11.2015 2,1219 A.Becker 2411 ObjectJobResults UpdDb=No New: Implemented 7-Zip compression for job archive packages. 

For optimized archive size choose SevenZipPPMd implementation with Highest compression level. 

Important: 7-Zip will be used as default from now on. If you need ZIP archives, you have to change the compression settings.

21.10.2015 2,1219 J.Fes JCT Ver.Info Change: If Result Classification Custom rues are used (via: -ResultClassificationCustom_DPNE ..)   

and one of the Results are interpreted as a Warning Objects.P.Res.Has.WRN is set to true

16.10.2015 2,1218 A.Becker GUI New: When you press the reset filter button while holding the shift button,  

all filters are then reset (including object id and object group field)

14.10.2015 2,1218 J.Fes Settings CheckBox Check.Settings Change: Property 'MD.Volume Deviation Percentage Result Rules' 

Update of default values to: 

 OK.....: 0,000% - 0,005% 

 WRN....: 0,005% - 0,050% 

 ERR....: 0,050% - ....

06.10.2015 2,1218 J.Fes Import Sites/Data 

Import

Ver.Info Change: Issue.: Sync.Site Data process stopt because of SQL CommandTimeout's  

         during reading ItemData form TC.DB 

Change: Now SQL command is using Site defined 'Command Time Out settings [sec]'

05.10.2015 2,1217 S.Gueth JobControl Settings Check.Settings New: JobClient - JobServer checks now if the Memory usage of JobClient is not to high. 

If the Memory usage is to high, JobClient recives !! -NO new Job- !! 

Message is shown in JobClient and in JobServer 

 

See also settings in JobServer Settings

05.10.2015 2,1217 S.Gueth JobControl Settings Check.Settings New: JobClient - JobServer checks now if the CPU utilization of JobClient is not to high. 

If the CPU utilization is to high, JobClient recives !! -NO new Job- !! 

Message is shown in JobClient and in JobServer 

 

See also settings in JobServer Settings

05.10.2015 2,1217 J.Fes Import Sites/Data 

Import

Ver.Info Change: On 'Sync.Site.Data' did not delete non existing ITEM Data from JobMgr.DB 

Issue are solved by code changes.

21.09.2015 2,1217 J.Fes ObjectList Ver.Info New: Edit Process status: Supports now selection of data via 'Grid-Cells'. 

This enhancment improves selection of data to edit the process status.

16.09.2015 2,1217 J.Fes Import Sites/Data 

Import

UpdDb=Yes New: OwingGroups supports now SubGroups GR1.GR2.GRn

02.09.2015 2,1217 A.Becker ObjectList UpdDb=No New: The column chooser of the data grid can be filtered.

02.09.2015 2,1217 A.Becker ObjectList UpdDb=No New: Object list can be populated from selected controls. 

The object list editor provides new functions to modify elements.

02.09.2015 2,1217 A.Becker ObjectList UpdDb=No New: Object list can be populated from selected controls. 

The object list editor provides new functions to modify elements.

28.08.2015 2,1217 S.Gueth 2396 Settings JCT Check.Settings New: Enhancement of DataShare Eval Prozess 

you can now define DataSet relation Exclude Lists and DataSet Type Exclude Lists 

these lists will be defined via the new ActionSettings_cls in the cmd tools 

a file with the name #Action#_Settings.xml has to be in the JobRoot_DP

27.08.2015 2,1217 A.Becker GUI ObjectList UpdDb=No Change: The Search-and-List process is partly moved to background. 

While the database query runs, the process can be cancelled by the user.
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27.08.2015 2,1217 A.Becker ObjectList UpdDb=Yes New: The new ObjectGrouping feature allows to remember and select sets of objects using custom groups.

27.08.2015 2,1217 A.Becker ObjectList UpdDb=Yes Change: The Performance of object listing via InputLists is highly improved now.

21.08.2015 2,1217 S.Gueth JobControl Scripting 

Settings

New: JobClient can start PowerShell script files (*.ps1) directly

10.08.2015 2,1216 S.Gueth 2349 JobControl New: Enhancement: Improving performance to generate faster Job's  

Therefor a extension ist programmed that commit of 'JobResults'  

is now running in a extra thread. The thread is running parallel  

to the JobControl Services and improves the generation of new Job's.

10.08.2015 2,1216 S.Gueth 2349 JobControl New: Enhancement: Improving performance to generate faster Job's  

Therefor a extension ist programmed that commit of 'JobResults'  

is now running in a extra thread. The thread is running parallel  

to the JobControl Services and improves the generation of new Job's.

07.08.2015 2,1216 S.Gueth Settings JCT Check.Settings New: Parameter "ExecuteMacroViaUGRouter" in Action "NxDataProcessing_2013_09_02", Subaction "NXMacroExecute" 

defines if the macro should be executed via UGRouter.exe 

NX will be closed on start when it was allready open 

NX has to be started new each time via UGRouter exe to execute the macro

03.08.2015 2,1216 J.Fes JCT Ver.Info New: Refile of Datasets (JobMgr_RfDataSets=ON) extendet. 

Now Refile 'Error explanation: Text is now parst from Rf.log file. 

 

P.ResCode = Rf-DS 

P.Res.Msg = Text after 'Error explanation:  

#Example Data of Rf.log files: 

Failed to refile @DB/4711/A/specification/4711-A. 

Error explanation: The dataset has a newer version in Teamcenter than in this session 

** Refiling Complete ** 

 

Value of result Message 

P.Res.Msg = [Rf.ERR:The dataset has a newer version in Teamcenter than in this session]

03.08.2015 2,1216 J.Fes JCT Ver.Info New: Refile of Datasets (JobMgr_RfDataSets=ON) extendet. 

Now Refile 'Error explanation: Text is now parst from Rf.log file. 

 

P.ResCode = Rf-DS 

P.Res.Msg = Text after 'Error explanation:  

#Example Data of Rf.log files: 

Failed to refile @DB/4711/A/specification/4711-A. 

Error explanation: The dataset has a newer version in Teamcenter than in this session 

** Refiling Complete ** 

 

Value of result Message 

P.Res.Msg = [Rf.ERR:The dataset has a newer version in Teamcenter than in this session]

16.07.2015 2,1215 J.Fes ObjectList Change: DataColume in DataGrid renamed  

from: O.Type(SP/AP) 

to..: O.SP/AP/NP

13.07.2015 2,1215 J.Fes ObjectList Ver.Info New:

13.07.2015 2,1215 J.Fes DB Settings Ver.Info New: New Function in JobServer: Create quick a full backup of JobMgr.DB. 

See: Extra->Setup->Setup database->database maintain->25 - Create a new backup of JobMgr.DB 

 

Note: Function will only be executed on JobMgr-SQL Server.

02.07.2015 2,1215 S.Gueth 2389 Settings CheckBox Check.Settings Change: The MD.Volume values will now be converted from unit cm^3 to unit mm^3 

Hint: The values are not changed in CB.xml files. The values are there still in unit cm^3

02.07.2015 2,1215 S.Gueth 2389 Settings CheckBox Check.Settings Change: Changed default values for "MD.Volume Deviation Result Rules" in CB Settings from cm^3 to mm^3 

OK:  0,000 mm^3 - 0,001 mm^3  

WRN: 0,001 mm^3 - 0,010 mm^3 

ERR: 0,010 mm^3 - ...

24.06.2015 2,1215 J.Fes 1182 JCT Ver.Info New: Refile evaluation support's now also motion part's
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24.06.2015 2,1215 S.Gueth 2386 Settings JCT Check.Settings Change: Enhanced generation of input file for 'DataShare', 'DataSync' and 'FlipTheSwitch' process  

IMPORTAND: in Action 'TcMultiSite_2012_02' and Subaction 'DataSync|DataShare|FlipTheSwitch'  

the parameters 'DataSync_ItemList_DPNE|DataShare_IRList_DPNE|FlipTheSwitch_IRList_DPNE' changed to 'InputList_DPNE' 

please check this in your script 

new parameters: 

'ClassOutType' : defines for which type the input list should be exported, default: I (Item) 

'ClassOutContent' : defines which content should be exported to the input list, default: ID

19.06.2015 2,1215 S.Gueth Install and Setup Doc: With Version 1.0.1.7 the JobManagerUpdate program can be updated by itself

19.06.2015 2,1215 S.Gueth Install and Setup 

Settings

Check.Settings New: It is possible now to set a password in the JobManagerUpdate program  

to decrypt password protected zip files 

Just open JobManagerUpdate.exe > Setup > Settings > Zip File Settings and edit Password

17.06.2015 2,1214 S.Gueth 2383 Settings CheckBox New: added "EN.ViewDependent Mappers" in CheckBox Settings 

defines ViewDependent mappings for all entities 

 if the ViewDependent name contains the string of 'Text 1' or 'Text 2'  

then it will be replaced with the string of 'Map Alias'

17.06.2015 2,1214 S.Gueth 2383 Settings CheckBox New: added "EN.Text Mappers" in CheckBox Settings 

defines Text mappings for all entities 

 if the text contains the string of 'Text 1' or 'Text 2'  

then it will be replaced with the string of 'Map Alias'

16.06.2015 2,1214 J.Fes Import Sites/Data 

Import

Ver.Info SQL to analyse Presice BOMS are updated 

Now we using in 'BOMc_Precise.SQL' Script  

 PSTRUCTURE_REVISIONS   

With this change we are able to read also BOM's that missing  

 POM_BACKPOINTER releations.

09.06.2015 2,1213 J.Fes Import Sites/Data 

Import Settings

UpdDb=Yes 

Check.Settings

New: Object data contains now for ItemRevision (IR) and Dataset (DS) data  

new columes: 'Ir.Rank' 

 - Ir.Rank  determined via 'Latest by IR Creation Date' or 'Latest by AlphaRevOrder'     

 

Please check settings in:  

 Sites/Data Import -> Edit Site def. --> Site Import Setting 1    

                   -> Imoprt Data Conditions -> Lastest Item Revison Rule  

 

Hint: If you change setting of 'Lastest Item Revison Rule' 

      Please Update data via: 

 Sites/Data Import -> Imp.Extended -> 'Updated.Site Ir.Rank via Rev.Rule'

05.06.2015 2,1212 S.Gueth 2379 JCT New: It is now possible to add a customer NxSyslog parser in the refile process. 

Methode is desinged for parsing customer data from NX.Syslog files.  

Results are contained in P.Result.Msg and own in a new section: [CustomKey:..] 

 

For usage:  

1. Rename in dir  

   ..\10-JobScripts\RefileNX##\ClientScripts\Resources 

   File.: RfNxSylog_ResClRules_Custom_template.xml 

   to...: RfNxSylog_ResClRules_Custom.xml 

 

2. Edit settings in: RfNxSylog_ResClRules_Custom.xml 

 

3. define in Job script: 

   set ResultClassificationCustom_DPNE=%CmdCurRoot_DP%\Resources\RfNxSylog_ResClRules_Custom.xml 

   or: 

   set ResultClassificationCustom_DPNE=#JobRoot_DP#\Resources\RfNxSylog_ResClRules_Custom.xml
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29.05.2015 2,1212 J.Fes JobControl Ver.Info New: It is now posible to define how many Job's of o specific JobRule 

may run on a JobClient.  

Please define it in JobControl -> JobRules -> JobComputer  

Syntax...: ComputerName1:n[:NoFurtherJob];ComputerName2:n[:NoFurtherJob] 

 

Example 1: Computer1:2;Computer2:5 

Example 1: Computer1 runs max 2 Jobs of JobRule 

Example 1: Computer2 runs max 5 Jobs of JobRule 

 

Example 2: *:1 

Example 2: All Computer runs 1 Job of JobRule 

 

Example 3: Computer1:1:NoFurtherJob;Computer2:5:NoFurtherJob 

Example 3: Computer1 runs max 1 Jobs of JobRule  

Example 3: Computer2 runs max 5 Jobs of JobRule 

Example 3: Behavior like Example 1 but if computer runs n JobMax then NO further job is searched in other JobRules

28.05.2015 2,1212 S.Gueth 2375 JCT New: a syslog section file will now be written for each refiled object 

this file is also available via J.Link

26.05.2015 2,1212 J.Fes Import Sites/Data 

Import

Ver.Info New: New TC.Site Data Import Dialog created. 

Now it is posible to Import TC.Site Data in TimeFrames begin/end. 

With this methode it is posible to import Data form TC with more then 1 JobServer.

20.05.2015 2,1212 J.Fes JobControl Ver.Info New: in Job's selecting Items now function to   

add 'IR' Data to JobPacket is avialble. 

Enhancment is Done by code changes.

12.05.2015 2,1212 S.Gueth Settings JCT Check.Settings New: PLMPerformanceAnalyse: parameter: "IgnoreMultipleLoggedInUsers" 

determines if multiple logged in users with same username on the same pc should be ignored or not (default is false, should 

not be ignored)

06.05.2015 2,1212 S.Gueth JCT New: SubAction "DxfDwgExport" in Action "NxDataProcessing_2013_09" 

Method to export Dxf or Dwg files

06.05.2015 2,1212 S.Gueth JCT New: SubAction "StepExport" in Action "NxDataProcessing_2013_09" 

Method to export Step files

06.05.2015 2,1212 S.Gueth JCT New: -Action "NxDataProcessing_2013_09" -SubAction "ParaSolidExport" 

Method to export ParaSolid files

21.04.2015 2,1211 S.Gueth Settings JCT Check.Settings New: SubAction "Refile_Part" in Action "RefileTC_2012_01" for refiling single dataset parts 

to use it, set following in JM->Script/Param.->JC.Script(cmd).ParamExt: 

set JobMgr_RfPart=ON

21.04.2015 2,1211 S.Gueth Settings JCT Check.Settings New: SubAction "Refile_Part" in Action "RefileTC_2012_01" for refiling single dataset parts 

to use it, set following in JM->Script/Param.->JC.Script(cmd).ParamExt: 

set JobMgr_RfPart=ON

16.04.2015 2,1211 J.Fes GUI Ver.Info Change: JobServer Titel Version info changed to new format 

Syntax is now: VX.YYYYY (Build:DD.MM.YYYY) 

Example:       V2.12117 (Build:16.04.2015)

15.04.2015 2,121 J.Fes Scripting Ver.Info Change: Renamed function:  

from: IRs_and_Datasets_ImportFromTcDB_DoImportForIR  

to..: IRs_and_Datasets_ImportFromTcDB_DoImportForIR_Control

14.04.2015 2,121 J.Fes Scripting Ver.Info Change: Code changes on Class Datasets_and_Irs_cls 

General: 

 Property DataType now changed generic types 

 Please change in JS.Scripts  

 for example:  

 from: IrExportRecord.Value = "MyValue" 

 to..: IrExportRecord = "MyValue"

26.03.2015 2,121 S.Gueth JCT Change: TCRefile: If no result in Refile JobLogFile was found, but everything in NX.Syslog is OK, then the object will get a warning 

(not an error)  

Res.Msg: [Rf:WRN:No refile results in RefileJobLogFile found!][Rf.NX.Syslog:LoadUp:OK,LoadDisp:OK,Save:OK,SecEnd:OK] becomes 

WRN in JobManager

26.03.2015 2,121 J.Fes Import Sites/Data 

Import

Ver.Info On Importing manuel (via Extras->Import data of Item / IR)  

If you add only the item name to the input dialog then all data of Item and IR will be imported.

26.03.2015 2,121 J.Fes Import Sites/Data 

Import

Ver.Info On Importing manuel (via Extras->Import data of Item / IR)  

If you add only the item name to the input dialog then all data of Item and IR will be imported.
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24.03.2015 2,121 J.Fes CheckBox Ver.Info Change: Outputformat of CheckBox result report enhanced 

- Parthistory lists now matching matching parthistory 

- Parthistory shows now which of the parthistory entries presents   

  the last interactive save action (Last int. save)

18.03.2015 2,121 J.Fes JCT Ver.Info Change: -Action MigIdeas2NX_2013_10 -SubAction Status_remigrate_ResultEval 

If no data from TC extracted for a remigrated Object then the following message is added to the P.Res.Msg: 

[Status:ERR:no status info extracted form TC. Please !Chk data in TC!]

18.03.2015 2,121 J.Fes JCT Ver.Info Change: -Action MigIdeas2NX_2013_10 -SubAction Status_remigrate_ResultEval 

If no data from TC extracted for a remigrated Object then the following message is added to the P.Res.Msg: 

[Status:ERR:no status info extracted form TC. Please !Chk data in TC!]

09.03.2015 2,121 J.Fes JobControl Ver.Info Change: Handling of exceptions and errors during generating JobPacket's is improved. 

 

If an exception or error appears a detailed message is printet  

in JobManager and on JobClient: 

 - if JobScript template file is missing 

 - if an general exception happend 

 

Issues is solved by code changes.

09.03.2015 2,121 S.Gueth 2294 Settings CheckBox Check.Settings New: New setting 'PH.Attributes Mapper' in CheckBox settings manager. 

It can be used to map attributes having diffrent 'Attribute Titel' between NX versions

20.02.2015 2,121 S.Gueth JCT New: SubAction 'I_IR_BOM_DS_eval' for Action 'TcMultiSite_2012_02' 

compares two Items with its ItemRev, Bom and Dataset informations 

Section   Meaning            ResCode on Error 

    I..   Item               200 

    IR.   ItemRevision       300 

    BOM   Bill of Material   400 

    DS.   Dataset            500

20.02.2015 2,121 J.Fes Settings Ver.Info New: JobManager settings containing now a note field 

This can be used ta add notes belonging to the JobManger settings. 

 

see: JobMgr -> Extra -> Setup -> Settings -> Tab JobServer -> 01 Customer Notes -> 01 Customer Notes

16.02.2015 2,121 J.Fes Import Sites/Data 

Import

Ver.Info Change: During import in some cases Item.puid or Ir.puid value has been empty. 

Now data import checks if value is empty and try's to read the puid data again. 

#Hint: this issue is in evaluation phase.

16.02.2015 2,121 J.Fes GUI Ver.Info Change: JobManger did not write in all cases data to the JobManager log files. 

Issue is now solved by code changes.

16.02.2015 2,121 J.Fes CheckBox Ver.Info Change: Body.Density check was in case of specific regional settings wrong. 

Body.Density are now using Type decimal.  

With this change compairing results via Body.Density <= 0 are correct.

11.02.2015 2,121 J.Fes+S.Gue

th

JobControl Ver.Info New: JobClient - JobServer checks now if JobClient has enough Disk Space. 

If not enough Disk Space is avialble JobClient recives !! -NO new Job- !! 

Message is shown in JobClient and in JobServer 

 

See also settings in JobServer Settings

09.02.2015 2,121 J.Fes Import Sites/Data 

Import

Ver.Info Change: Multisite Export Recorde Data contains now 'only' SiteID's of Sites  

that are registerd in JobMgr Site list (see tab:'Sites/Data Import').

07.02.2015 2,121 J.Fes Settings CheckBox Ver.Info 

Check.Settings

New: New Setting:'AS.Comp.InstancName chars ignor list' available 

Now you can define a list of chars that are ignored during comparing Assembly Component InstanceName.

06.02.2015 2,121 S.Gueth JobControl Settings Check.Settings New: 93.04 Sites SQL Server CPU Utilization Settings' added in JobServer settings: 

Setup Sites SQL Server CPU Utilization Settings, for checking the lokal CPU utilization for the SQL Server of the TC Site  

 

These are general settings for all sites, but can be overwritten on each JobRule at: 

'JobControl Rules' -> 'Job Def Extended 2' -> 2.3 'Sites SQL Server CPU Utilization Settings'

06.02.2015 2,121 S.Gueth JobControl Settings Check.Settings New: Host Drive Settings settings added in JobServer settings: 

-- List of local disk to check disc space:  

   Setup witch local drives of the clients will be checked for the available free disc space 

-- Local Drives space check: OK lower bound (GB):  

   Setup the lower bound of the local disk space check, until it returns OK (default is 4GB) 

-- Local Drives space check: ERR upper bound (GB):  

   Setup the upper bound of the local disk space check, until it returns ERR (default is 1GB)
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04.02.2015 2,121 J.Fes JCT Ver.Info Change: -Action MigIdeas2NX_2013_10 -SubAction finalChk_ResultEval 

BOMCompair Rules Changed: 

If no 'BOM.xml pre' exist results is now set to ResultCode=0 Result.Status=D.WRN (Warning) 

Before this change it result was set to ResultCode=BOM-101 Result.Status=D.ERR (Error) 

Change done upon consultation Klaus Langer and Josef Feuerstein

04.02.2015 2,121 J.Fes JCT Ver.Info Change:

04.02.2015 2,121 S.Gueth 2286 JobControl New: JobClient reports the free space of the local drives 

Default Values: (editable in JobServer Settings) 

OK > 1 GB 

WRN between 0.1 and 1 GB 

ERR < 0.1 GB (connection to JS will be skipped)

03.02.2015 2,121 J.Fes JCT Ver.Info New: JobMgrDataOrg supports now also Nativ (File based) ObjectData    

 

Native Files are stored in following directory structure: 

#JobMgrDataRoot_DP#\#SiteId#\#ObjectFs_Vol#\#ObjectFs_NE#\..

03.02.2015 2,121 J.Fes Import Sites/Data 

Import

Change: If a Site is a nativ Site then ObjectFs_VOL value is the  

partial part of the full path to the File Object 

#Example: SiteDef.Nativ Root Dir: 'D:\NxData\Test1' 

          ObjectFs_DPNE.........: 'D:\NxData\Test1\Product1\MainParts' 

          ObjectFs_VOL..........: 'Product1\MainParts'

03.02.2015 2,121 J.Fes CheckBox Ver.Info New: CheckBox Tools Supports now nativ mode.

30.01.2015 2,121 J.Fes JobControl Ver.Info New: If a Job do not return any Job.Results then  

JobData will be set to following results: 

P.Res.Code.............: JM-999999 

P.Res.Msg..............: [ERR:Job did not returned any JobResults] 

P.Res.Status...........: D.U.ERR

29.01.2015 2,121 J.Fes ProcessGroups Ver.Info Change: Names and description of ProcessGroups settings are reorganized. 

ProcessGroup settings are now better to understand.

28.01.2015 2,121 J.Fes JobControl Ver.Info Change: JobResults contained in *_JobResultsGenericV1.Log did not worked anymore. 

Reason was because files with name pattern *_JobResultsGenericV1.Log was not extracted from Job.zip file.  

Issue is now solved by code changes.

23.01.2015 2,121 J.Fes+A.Bec

ker

JobControl Ver.Info Change: Local time of JobClient was wrong transverd to JobServer if a timesone has been in between. 

Issue is now fixed by code changes

22.01.2015 2,121 J.Fes Settings CheckBox Check.Settings New: New setting: Check behavior for Text that 'Empty or blanked' 

You now can define if 'Drafting.Text[s].Values' are both 'Empty or blanked' is to be checked 

By default 'Empty or blanked' is not checked

22.01.2015 2,121 J.Fes CheckBox Ver.Info Change: ChecBox - Result Viewer did NOT displayed in all cases the .tif files  

that belongs to the same .tif group. 

Issue is solved by code changes.

21.01.2015 2,121 J.Fes Import Sites/Data 

Import

Ver.Info Change: JobServer analyses ImPrecice BOM's by 

Now via Ir creation Date. Before it was analyses by max(IR-ID). 

Changes are done by updating BOMc_ImPrecise.SQL + BOMc_ImPrecise_TCUA.SQL

06.01.2015 2,121 S.Gueth 2285 Settings CheckBox Check.Settings New: Property 'MD.Volume Deviation Percentage Result Rules' in ModelData 

defines result classification rules for percentage volume deviation

05.01.2015 2,121 S.Gueth 2285 CheckBox New: Parameter 'CBMoveExtractedFilesToArchive' in CB config 

Defines if extracted CheckBox files (xml, cgm) should be moved to the archive or not 

Default is 'true' 

HINT: if 'false', then extracted files will be deleted

30.12.2014 2,121 J.Fes JCT Ver.Info Change: -Action MigIdeas2NX_2013_10 -SubAction Status_final_ResultEval  

In case a Item/Rev contains has 'NO' 3D cmm part (of Types:IdeasPart,IdeasAssembly,ProPrt,ProAsm).  

but contains 1 UgMaster then results are returned as OK.

30.12.2014 2,121 J.Fes JCT Ver.Info Change: -Action MigIdeas2NX_2013_10 -SubAction Status_final_ResultEval  

In case a Item/Rev contains has 'NO' 3D cmm part (of Types:IdeasPart,IdeasAssembly,ProPrt,ProAsm).  

but contains 1 UgMaster then results are returned as OK.

27.12.2014 2,121 J.Fes TaskScheduler Ver.Info Change: Issue: Tasksheduler Job's with defined TimePoints [TP=HH:MM][TP=HH:MM] dit not worked anymore. 

Issue is now solved by code changes in JobServer and JFProgLib.dll.

18.12.2014 2,121 A.Becker Settings UpdDb=No Change: User Settings are stored in a XML file instead of the windows registry. 

The file is located in the users directory within 01-BinServer.Custom 

Use the methods from the new UserSettings class to load or save values.
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17.12.2014 2,121 J.Fes JCT Ver.Info Change: -Action MigIdeas2NX_2013_10 -SubAction CMM_ResultEval 

Parsing of cmm logfiles enhanced for ProDrw  

Now in CMM.log we searching for Key: '   * Processing drawing:' + #ItemId#/#RevId#

17.12.2014 2,121 J.Fes JCT Ver.Info Change: -Action MigIdeas2NX_2013_10 -SubAction CMM_ResultEval 

Parsing of cmm logfiles enhanced for ProDrw  

Now in CMM.log we searching for Key: '   * Processing drawing:' + #ItemId#/#RevId#

16.12.2014 2,121 J.Fes ObjectList Ver.Info New: Filter for ObjectData extendet: 

Now it is also posible to search for data via 'Object Puid'

16.12.2014 2,121 J.Fes Admin Ver.Info Change: JobMgr Database Setup/Update 

New Setup avialble to run a Custom T-SQL Script List in JobMgr Database. 

 

Use Extra->SETUP->Setup database->Datbase Setup->21 - Database Custom Setup ... 

and select in  file dialog one of your custom T-SQL Script List File (*SQLScriptList.txt)

16.12.2014 2,121 J.Fes Admin Ver.Info Change: JobMgr Database Setup/Update 

If running a T-SQL script via Extra->SETUP->Setup database->Execute T-SQL Script (via Fileselect) ...  

then now JobMgr waits after executing the selected T-SQL script.

12.12.2014 2,121 A.Becker GUI ObjectList UpdDb=No New: GridLayout Customer Defaults for Objects List can be easy selected by a new control above the objects FilterPanel. 

It features Layout Default-Restore, Save/Restore custom layout, Quick Restore custom layout from dropdown.

12.12.2014 2,121 A.Becker GUI ObjectList UpdDb=No New: Objects Filter Customer Defaults can be easy selected by a new control above the objects FilterPanel. 

It features Layout Default-Restore, Save/Restore custom layout, Quick Restore custom filter from dropdown. 

In addition the last 10 filters used are automatically saved by a feature called RingBuffer.

12.12.2014 2,121 J.Fes JCT Ver.Info Change: -Action MigIdeas2NX_2013_10 -SubAction CMM_ResultEval 

In case a Item/Rev contains has 'NO' 3D cmm part (of Types:IdeasPart,IdeasAssembly,ProPrt,ProAsm). 

but contains 1 UgMaster then: 

Returns OK if 1 UGMASTER exist with name schema: ItemId-RevId 

Returns WRN if 1 UGMASTER exist other name schema: ItemId-RevId

12.12.2014 2,121 J.Fes JCT Ver.Info Change: -Action MigIdeas2NX_2013_10 -SubAction finalChk_ResultEval 

In case a Item/Rev contains has 'NO' 3D cmm part (of Types:IdeasPart,IdeasAssembly,ProPrt,ProAsm). 

but contains 1 UgMaster then results are returned as OK.

12.12.2014 2,121 J.Fes JCT Ver.Info Change: -Action MigIdeas2NX_2013_10 -SubAction CMM_ResultEval 

In case a Item/Rev contains has 'NO' 3D cmm part (of Types:IdeasPart,IdeasAssembly,ProPrt,ProAsm). 

but contains 1 UgMaster then: 

Returns OK if 1 UGMASTER exist with name schema: ItemId-RevId 

Returns WRN if 1 UGMASTER exist other name schema: ItemId-RevId

12.12.2014 2,121 J.Fes JCT Ver.Info Change: -Action MigIdeas2NX_2013_10 -SubAction finalChk_ResultEval 

In case a Item/Rev contains has 'NO' 3D cmm part (of Types:IdeasPart,IdeasAssembly,ProPrt,ProAsm). 

but contains 1 UgMaster then results are returned as OK.

09.12.2014 2,121 J.Fes JobControl Ver.Info Change: If JobServer start's with JobControl:A or JobControl:R  

then Titel of JobServer will contain string 'JobControler'  

 

If JobServer start's with TaskScheduler:ON   

then Titel of JobServer will contain string 'TaskScheduler'

05.12.2014 2,121 A.Becker GUI UpdDb=No Change: The application standard grid layouts can be updated using the View->Restore functions 

while holding the Shift-Key. This modifies the Action from Restore to Store.

05.12.2014 2,121 A.Becker GUI ProcessGroups UpdDb=No New: Added a new property [ProcStateKind] to the details of a ProcState. 

The value of this property modifies the behavior of the ProcState as follows: 

Normal: The same behavior like before 

QueryOnly: The ProcState cannot be selected to manually set a Process Status 

           Can be used for status which only will be set by processes for for combined query status like T;RUN;XX 

VisualSeparator: The name and display text become fixed and the ProcState is no more selectable by the user. 

                 The default separator colors are DarkGray/Transparent, but they can be overridden by custom color selection. 

                 The only purpose is to provide visual separations between groups of ProcStates.

04.12.2014 2,121 A.Becker GUI ObjectJobResults 

Settings

UpdDb=No New: The custom ProcStates can be edited direct from the View-Menu for the current procStateCol. 

After edit, the columns in the grid are updated instantly.

04.12.2014 2,121 A.Becker GUI ObjectJobResults 

Settings

UpdDb=No New: The custom columns for process results can be edited direct from the View-Menu for the current procStateCol. 

After edit, the columns in the grid are updated instantly.
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04.12.2014 2,121 J.Fes JCT Ver.Info New: -Action "NxDataProcessing_2013_09" add new -SubAction "NXMacroExecute" 

With this Tool you can run an NX.macro on each NX.Dataset it is containd in the JobPacket. 

Details see: ..03-

BinPublic.ClientServer\JobManagerCmdTools_Docu\30.NxDataProcessing_2013_09\NxDataProcessing_2013_09_01_docu.txt

04.12.2014 2,121 A.Becker GUI UpdDb=No Change: New structure for grid layout saved files. The extension changed from .xml to .jsgl (JobServer GridLayout) 

Multiple custom table layouts can be saved with given names. 

Each Grid has its own folder under 01-BinServer.Custom\_CustomDefaults\Settings\ 

Refer to detailed documentation in file:///V:\JobManager\ProgEntw\Ver03\JobManagerV3\10-Documentation.Application.Working\01-

Dokumentation-Entwicklung\JobManagerV3_EntwDokumentation_A.Becker.pptx 

See on page 01.12.2014 Entwicklung JobManager: Organizazion of saved GridLayouts

28.11.2014 2,121 S.Gueth JobControl JCT New: Added JobData4PostAction Class, to define PostActions that will be done in the JobServer after a Job was processed on the 

client 

for example: renaming of an object, deleting an object etc...

05.11.2014 2,121 S.Gueth CommandLineArgs New: New command line argument "/WorkInstTitel" for JobClient and JobServer available. 

Specifies the 'JobServerWorkInstance' titel. 

#Doc Info: If not set, 'JobServerWorkInstance' from settings.xml will be used. 

 

#Exa: /WorkInstTitel P.System-01

05.11.2014 2,121 S.Gueth CommandLineArgs New: New command line argument "/TCPPort" for JobClient and JobServer available. 

Specifies the port on that JobClient's connecting to the JobServer.  

Doc Info: If not set, port from settings.xml will be used. 

 

#Example: /TCPPort 13001

05.11.2014 2,121 J.Fes GUI Ver.Info New: AdminMode is nwo avilable. 

To prevent unmeant changes in JobServer config settings a new AdminMode Button is  

added to the JobServer toolbar. 

Config settings are stored in Grids of 'Sites/Data Import' 'Scripts/Param' 'Job Control' 

If enabled you can edit the config settings in JobServer.  

If disabled you can NOT edit the settings in JobServer.

05.11.2014 2,121 J.Fes Install and Setup Ver.Info Change: Updating JS.Databases via executing SQL Scripts   

'logic' for continue runnig SQL Scripts Is changed 

 

 if clicking 'YES' each Scripts will be processed without stoping after executing 

 if clicking 'NO' after processing each Scripts process will 'stop'

03.11.2014 2,121 J.Fes JobControl Ver.Info Change: Usning in JobControl -> JobComputer Scripts lead in case that JobComputer Data was not saved  

to a Error. Issue is now saved by code changes

30.10.2014 2,121 J.Fes JobControl Ver.Info New: In JobScripts also Windows PowerShell Scripts *.ps1 can be selected. 

All Windows PowerShell Scripts (*.ps1) containd in JobScript directory  

will be filled out with the value of the placeholder variables. (placeholder Example: #03-BinPublic_DP# ..)

30.10.2014 2,121 J.Fes JCT Change: -Action MigIdeas2NX_2013_10 -SubAction FinalResultEval 

Excutes now also -SubAction BOMCompair 

After this Update Process BOM eXtract for JobData1ToProcess is needet before running -SubAction finalChk_ResultEval

30.10.2014 2,121 J.Fes JCT Change: -Action MigIdeas2NX_2013_10 -SubAction FinalResultEval 

Excutes now also -SubAction BOMCompair 

After this Update Process BOM eXtract for JobData1ToProcess is needet before running -SubAction finalChk_ResultEval

30.10.2014 2,121 J.Fes JCT Change: -Action MigIdeas2NX_2013_10 -SubAction CMM_ResultEval 

Excutes now also -SubAction BOMCompair 

After this Update -SubAction BOMCompair is NOT anymore needet please check Script's

24.10.2014 2,121 S.Gueth JCT Change: RfInputList_cls und RfInputListItem_cls eingeführt,  

um Item und Revision in der Inputliste miteinander zu vergleichen 

verhindert, dass doppelte cli namen mit einem anderen Trennzeichen in der Inputliste auftauchen

23.10.2014 2,121 J.Fes JobControl Ver.Info Change: If in JobControle Rule DS_of_IR was used with IncObjTypes then 

include objects was not added to JobPacket. 

Issue is now solved by code changes

17.10.2014 2,121 J.Fes ObjectList Ver.Info Change: to view file content via JobLink faild in case that path to file containd in JobLogFiles was to long. 

Issue is now solved via code changes.
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15.09.2014 2,121 J.Fes JobControl UpdDb=Yes New: JobControlRules extendet 

Now it is posible to define in JobControlRules 

to add 'IR' (or and) 'ITEM' data additional to the JobData. 

 

If you activate this Rule then additional to the selected JobData 

also 'IR' (or and) 'ITEM' DATA are addet to JobData1ToProcess.xml 

 

#Example: Use this rule 

if Job Selection is based on Datasets but also IR or ITEM Data is needet in the Job. 

 

#Doc Info: 

Please notice if rule is activated also Process Status is set to 

additional selected Data.

03.09.2014 2,121 S.Gueth JCT New:

03.09.2014 2,121 J.Fes ObjectList UpdDb=Yes Change: Performance to read and display Object data in register Objects List  

is improved 

 - via Sql  

   and  

 - Methodes to displaying the data in Objects datagrid.

14.08.2014 2,121 J.Fes Import Sites/Data 

Import

Ver.Info Change: Base Import Default Conditions changed  

 

ImportAssembMaxLev   from 20    to 30     Levels 

IImportAssembMaxComp from 25000 to 250000 Component's

14.08.2014 2,121 J.Fes TaskScheduler Settings Ver.Info 

Check.Settings

New: TaskScheduler extendet now you can define ReDo intervalls in TimeScheduler colume. 

#Doc: ReDo times are in seconds #Example: 10min * 60sec/min = 600sec 

 #Example: [WD=* TP=05:00] [WD=* TS=07:00-18:00 ReDo=600] [WD=* TS=18:00-05:00 ReDo=3600] 

                            |-> every Day betw. 07:00-18:00 ReDo every 10 min the defined Job.

11.08.2014 2,121 J.Fes ProcessGroups 

Settings

UpdDb=Yes 

Check.Settings

Doc: JobServer: Number of ProcessGroups increased to 20. 

 

Solving Issue: In somme cases changes on Process Groups was not saved to database.  

Bevor this change it was needet to reload Process Group settings befor edit settings. 

Issue is now solved by code changes.

11.08.2014 2,121 J.Fes Import Sites/Data 

Import

Ver.Info New: Data Model extendet: Now you can use Customer defined Attibutes. 

 

In Site definitions you can define settings for extracting  

Customer Attributes from TC.DB into JobMgr.DB. 

 

Use example: 

Reading Data from IR's Forms Attributes and import it into JobMgr.

30.07.2014 2,121 J.Fes Import Sites/Data 

Import

UpdDb=Yes New: Data Import Assembly-BOM analyse improved: 

    

 - Performance improved on reading BOM data from TC 

   by Grouping same BOM Lines into one BOM Line + reciving N.Counting  

    

 - Performance improved by using cashing BOMLine data during import. 

   With this change any already readed Data is not needet to  

   read again from TC Database. 

    

 - BOM Unique Components now also analysed   

   Now you can see how many 'Unique components' is contained in an assembly 

   see data in Register: Objects Lists colume 'O.AP.Unique' 

 

 First test on testsystems of addPLM shows performance improvments from 40% - 60%

21.07.2014 2,121 J.Fes CheckBox Ver.Info Change: CheckBox Extract contains in section [JC:] details about termination reason. 

#Example: [JC:ERR Terminated:runtime limit of 7200 seconds reached]

18.07.2014 2,121 J.Fes Import Sites/Data 

Import

UpdDb=Yes Change: Option ImportTcApBomLineUgGometryNo_DoCount removed  

This Option defined: 'Not to count BOM Lines having UGGeometrie NO occurences' 

Option was removed because no customer is using this.

 51 / 73
Release Date/Time: 25.11.2025 08:48

Relase Version: 3.2000.2511.2025



PLMJobManager: What's New

Date Version User Issue-Nr Categorie Additional Info Type Description

17.07.2014 2,121 J.Fes JCT Ver.Info New: -Action "CBTools_2012_05" -SubAction "CBMoveCBFilesToCBArchiv" 

NX.sylog Analyse Extendet with new Section: NX.Syslog 

if NX.Syslog contains on end 'replaced with' then 

 P.Res.Code  = NXSyslog-901  

 P.Res.MSG  += [NX.Syslog:ERR NX.Syslog contains on end 'replaced with']

09.07.2014 2,121 S.Gueth 2258 JCT New: Subaction 'BOMCompair' in MigIdeas2NX_2013_10 

Compairs BOM contend between 'Pre CMM' to 'Post CMM'   

key                 meaning                                                 ERR Result Code   

XmlPre              extracted BOM xml file pre cmm process         (OK/ERR) BOM-101       

XmlPost             extracted BOM xml file post cmm process        (OK/ERR) BOM-102       

BH-IR               BOM header: OK if Item Revision is matching    (OK/ERR) BOM-110       

BH-PS               BOM header: OK if BOM's is still Presice       (OK/ERR) BOM-111       

BH-BLPre            if BOM lines in pre BOM is missing in post BOM (OK/ERR) BOM-113       

                    in this case a BOM Line is not nexisting  

                    anymore after CMM 

BH-LC               BOM header: BOM lines count (pre:n<->post:n)   (is MSG) 0     

BH-BLPost           BOM lines in post BOM missing in pre BOM       (is MSG) 0     

                    in this case a BOM Line is added new after CMM  

BL-OcNs:ItemRev     BOM line: occurence notes                      (is MSG) 0     

BL-SqNr:ItemRev     BOM line: sequence number                      (is MSG) 0

30.06.2014 2,121 J.Fes JCT Ver.Info Change: -Action "RefileTC_2012_01" -SubAction "EVALUATE" 

Evaluation of Refile results did not worked correct 

if JobData contained national letters like ÄÖÜ äöü 

Issue is now solved by code changes 

 

#Doc: Problem was soleved by reading Textfile content  

      with Encoding: System.Text.Encoding.GetEncoding(1252)

30.06.2014 2,121 J.Fes JCT Ver.Info Change: -Action "RefileTC_2012_01" -SubAction "extract" 

Refile input list will now be written with: 

Encoding: System.Text.Encoding.GetEncoding(1252)

30.06.2014 2,121 J.Fes JCT Ver.Info Change: -Action "RefileTC_2012_01" -SubAction "EXTRACT" 

If Refile JobData contained only Nonmaster Object of IR then IR was not addet to 'RfInput list' 

Issue is now solved by code changes

26.06.2014 2,121 J.Fes JCT Change: If JobData is printet folowing extensions has been Done:  

- now you can see if printet are the content of 

    JobData1ToProcess.xml 

    JobData2Result.xml 

 

- now if JobResult has ProcessResultExtendedData then  

  ProcessResultExtendedData is printed in a second line

26.06.2014 2,121 J.Fes JCT Ver.Info Change: Action: -MigCmm3D2NX_2013_10 SubAction: -Status_final_ResultEval 

In case evaluation of having wrong Status after prosessing set final status 

Objects has been Returned with P.Res.State:D.WRN 

 

Now Result returns: 

 P.Res.State: D.ERR 

 P.Res.Msg..: [final:ERR][Status.Cmm3D:ERR:is wrong:Locked][NxObj:OK: NX.Dataset exist]

26.06.2014 2,121 J.Fes JCT Ver.Info Change: Action: -MigCmm3D2NX_2013_10 SubAction: -Status_final_ResultEval 

In case evaluation of having wrong Status after prosessing set final status 

Objects has been Returned with P.Res.State:D.WRN 

 

Now Result returns: 

 P.Res.State: D.ERR 

 P.Res.Msg..: [final:ERR][Status.Cmm3D:ERR:is wrong:Locked][NxObj:OK: NX.Dataset exist]
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17.06.2014 2,121 J.Fes JCT Ver.Info Change: Action: -MigCmm3D2NX_2013_10 SubAction: -InitalResultsEval  

In case that no correspondending Dataset containd in Extracted Tc Data was not found in JobManager.JobData1ToProcess  

then an MessageBox with message: "hier" comes up. 

Solution: 

MessageBox is replaced by a message in command windows: 

ERR: for extracted Tc Dataset:[#ObjectCliNameCompactInfoForOutput#] no correspondending Dataset found in JobData1ToProcess. 

ERR:  |-> results are useless and will be ignored. 

Problem is now solved.

17.06.2014 2,121 J.Fes JCT Ver.Info Change: Action: -MigCmm3D2NX_2013_10 SubAction: -InitalResultsEval  

In case that no correspondending Dataset containd in Extracted Tc Data was not found in JobManager.JobData1ToProcess  

then an MessageBox with message: "hier" comes up. 

Solution: 

MessageBox is replaced by a message in command windows: 

ERR: for extracted Tc Dataset:[#ObjectCliNameCompactInfoForOutput#] no correspondending Dataset found in JobData1ToProcess. 

ERR:  |-> results are useless and will be ignored. 

Problem is now solved.

17.06.2014 2,121 J.Fes JCT Ver.Info Change: -Action MigIdeas2NX_2013_10 -SubAction finalChk_ResultEval 

If Dataset names of a migrated NX Dataset was longer then 32 chars  

then the correspondending NX - Ideas or ProE Dataset did not matched.  

Out of this reason JobMgr always returned that the NX Dataset did not exist. 

Problem is now solved by code changes.

17.06.2014 2,121 J.Fes JCT Ver.Info Change: -Action MigIdeas2NX_2013_10 -SubAction finalChk_ResultEval 

If Dataset names of a migrated NX Dataset was longer then 32 chars  

then the correspondending NX - Ideas or ProE Dataset did not matched.  

Out of this reason JobMgr always returned that the NX Dataset did not exist. 

Problem is now solved by code changes.

12.06.2014 2,121 J.Fes JobControl Ver.Info Change: Deleting JobControl Rules Dit not worked in all cases. 

Problem is now solved by code changes

11.06.2014 2,121 S.Gueth Settings CheckBox Check.Settings New: CheckBox Config Parameter : 'CBDurationsAnalyse' 

If true, the duration for load, update, extract and the entire duration of the cb extract of each part file will be parsed and 

the result will be printed into P.Res.Msg.Ext.Data

06.06.2014 2,121 S.Gueth Install and Setup New: Database Settings insert, to create the database via PLMPerformance Analyse

09.05.2014 2,121 J.Fes JCT Ver.Info Change: MigIdeas2NX_2013_10.CMM_ResultEval  

Issue P.ResMsg contains wrong Message [CMM:DoExecute:YES..(!but is not yet done!)][..] 

is now fixed. 

Description of solution: 

If in *_cmm.log section for Dataset is found then 

P.ResMsg = '[CMM:DoExecute:YES]' ...  

If in *_cmm.log section for Dataset is !-NOT-! found then 

P.ResMsg = '[CMM:DoExecute:NO]' ...

09.05.2014 2,121 J.Fes JCT Ver.Info Change: -Action "RefileTC_2012_01" -SubAction "EVALUATE" 

Rf.NX.Syslog do not sets P.Res.Has.WRN = 'true' anymore

28.04.2014 2,121 S.Gueth 1145 JCT New: Parameter: -objectType for JobDataExtract                                      

only objects with the given object type will be extracted, seperate with ';' #Exa: (UGMASTER;UGPART)

28.04.2014 2,121 J.Fes Settings JCT Ver.Info 

Check.Settings

Change: if using -SubAction "CMM_InpListGen" with -force switch  

then folowing rules are active: 

 

forces all datasets to be included in 'Status_final_InpList' 

  1. even if: BomView analyse returns false 

 

forces all datasets to be included in 'Cmm_InpList' 

  1. even if: BomView analyse returns false 

  2. even if: corresponding NX Dataset exist 

  3. even if: cmmStatus is not OK
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28.04.2014 2,121 S.Gueth 2246 JCT SubAction "JTUpdateLogFileEval" in Action "NxDataProcessing_2013_09" log file parsing for jt update in teamcenter 

Parameters: 

-Action       "NxDataProcessing_2013_09"  

-SubAction    "JTUpdateLogFileEval"        analyses the jt process logfiles 

-JobRoot_DP   "#JobRoot_DP#"               JobRoot Directory 

-LogFilesDir  "#JobRoot_DP#\JtTCUpdate"    path to the directory where the jt_log are

28.04.2014 2,121 S.Gueth 2246 JCT New: Subaction "JTUpdateInputListGen" in "NxDataProcessing_2013_09" for input list generation for jt update in teamcenter 

Parameters: 

-Action                "NxDataProcessing_2013_09"  

-SubAction             "JTUpdateInputListGen"       generates the input list to extract jt files 

-JobRoot_DP            "#JobRoot_DP#"               JobRoot Directory 

-ObjectList_SP_DPNE    "c:\list_sp.txt"             path and name of the list for the single parts 

-ObjectList_AP_DPNE    "c:\list_ap.txt"             path and name of the list for the assembly parts

28.04.2014 2,121 J.Fes Settings JCT Ver.Info 

Check.Settings

Change: if using -SubAction "CMM_InpListGen" with -force switch  

then folowing rules are active: 

 

forces all datasets to be included in 'Status_final_InpList' 

  1. even if: BomView analyse returns false 

 

forces all datasets to be included in 'Cmm_InpList' 

  1. even if: BomView analyse returns false 

  2. even if: corresponding NX Dataset exist 

  3. even if: cmmStatus is not OK

25.04.2014 2,121 J.Fes 2249 ObjectList UpdDb=Yes New: Dataset List contains now new colume O.FS_LastModDate 

This colume contains the last modification date of file object. 

The file object is the last version in the named reference of Dataset.

22.04.2014 2,121 J.Fes ObjectJobResults Ver.Info Change: CMM Result Evaluation checks now if in 'Named Refrences' of NX-Dataset 

is an NX-Partfile referenced. 

P.Msg: [NxObj:ERR:NX.Dataset(UgPart) exist but:ERR_301_DataSetIsMissingFileObject]

22.04.2014 2,121 J.Fes ObjectJobResults Ver.Info Change: CMM Result Evaluation checks now if in 'Named Refrences' of NX-Dataset 

is an NX-Partfile referenced. 

P.Msg: [NxObj:ERR:NX.Dataset(UgMaster) exist but:ERR_301_DataSetIsMissingFileObject]

22.04.2014 2,121 J.Fes JobControl Ver.Info New: the folowing new variables can be used to get dir where CustomTcSQL are stored into  

 - #TcSQL_JS_DP# or #TcSQL_DP# can be used to point to Dir: ..\01-BinServer.Custom\_CustomTcSQL\#TcSiteId# 

 - #TcSQL_JC_DP#               can be used to point to Dir: ..\02-BinClient.Custom\_CustomTcSQL\#TcSiteId#

22.04.2014 2,121 J.Fes ObjectJobResults Ver.Info Change: CMM Result Evaluation checks now if in 'Named Refrences' of NX-Dataset 

is an NX-Partfile referenced. 

P.Msg: [NxObj:ERR:NX.Dataset(UgPart) exist but:ERR_301_DataSetIsMissingFileObject]

22.04.2014 2,121 J.Fes ObjectJobResults Ver.Info Change: CMM Result Evaluation checks now if in 'Named Refrences' of NX-Dataset 

is an NX-Partfile referenced. 

P.Msg: [NxObj:ERR:NX.Dataset(UgMaster) exist but:ERR_301_DataSetIsMissingFileObject]

16.04.2014 2,121 J.Fes JobControl New: JobControl Rules is extendet  

Now you can define in JobComputers Object selection rules for Volume and Group 

If JobComputers.JobR.sel.O.Group <> '' then this value replaces value defined in JobControlRule.sel.O.Group  

If JobComputers.JobR.sel.O.Vol <> '' then this value replaces value defined in JobControlRule.sel.O.Vol

16.04.2014 2,121 J.Fes JobControl Ver.Info Change: Filtering of JobControl Rules via JC.J.Rule.filter by:'J.JobName' 

is now working correct.

10.04.2014 2,121 J.Fes 2239 Import Sites/Data 

Import

Change: Import of Data from TC Database was not working if TC.Database is a MSSql Server  

Problem is now solved

10.04.2014 2,121 J.Fes 2240 Import Sites/Data 

Import

Ver.Info Change: JobServer nativ data import stopted with NullReferenceException 

Problem is now solved

02.04.2014 2,121 J.Fes 2231 TaskScheduler Ver.Info Change: Problem: Tasksheduler Redoes Job's in wrong intervals 

Issue is now solved by code changes in JobServer and JFProgLib.dll.
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24.03.2014 2,121 J.Fes JobControl New: During import JobResults only needed files are expanted from JobLog.zip files 

SearchNames are: 

 - *Result.xml 

 - *ToProcess.xml 

 - *PostAction.xml (#New: 2.1210;01.12.2014;J.Fes) 

 - *info.xml 

 - *.syslog 

 - *RunAfterImportOnJobServer.* 

 - *_JobResultsGenericV1.Log  (#New: 2.1210;28.01.2015;J.Fes)

20.03.2014 2,121 J.Fes ObjectList Ver.Info New: Changes on List of Dataset view  

New Colume: Ir.Rel.State  

New Colume: Ir.Rel.Date

20.03.2014 2,121 J.Fes ObjectList Ver.Info New: Changes on List of Dataset view  

Ren Colume: O.Rel.State.Date renamed to O.Rel.Date

14.03.2014 2,121 S.Gueth 1213 JCT New: SubAction CheckMateLogFileEval for Action LongTermArchivement_2014_02 

Analyse a Check Mate xml file for an Object and sets the status

07.03.2014 2,121 J.Fes JCT Ver.Info New: Print of JobResults now colores result date depending on ResultCode 

If ResultCode =  '0'  --> Result is printed in green color 

If ResultCode <> '0'  --> Result is printed in red color

27.02.2014 2,121 J.Fes JobControl Ver.Info Change: PartUpdate Process Group includes now only that Datasets Types of IR-'UGMaster'  

that are selected in JobControl Rule. 

please look settings in JobControl Rules of P.Rf 

 Tab: 'Job Definition' -> sel:O.Special: 'DS.all OF IR' -> Incl.O.Type(s)

27.02.2014 2,121 J.Fes JobControl Settings UpdDb=Yes 

Check.Settings

New: JobControl -> JobComputer settings extendet 

Now you can set for JobComputer's a JobRule.Name filter that defines  

who of the Rules are be used by this JobComputer 

Please look at: JobControl -> JobComputer -> New Colume: [J.Rule.filter by:'J.JobName']

26.02.2014 2,121 J.Fes 1181 Reports Ver.Info New: New Report: Report_305_List_of_all_happend_errors_GroupBy_Type_For_All_Sites avilable 

 

#Doc: This Report lists all happend Errors of all Sites with following Data Columes: 

O.S.Or.Rep Object.: 1-SO (SiteObj) 

O.Nx.Type.........: AP 

O.Type............: UGMASTER 

P.Res.Code........: 940007 

P.Res.Msg.........: ERROR Message 

R.Error.Count.....: 2

26.02.2014 2,121 S.Gueth 1214 JCT New: SubAction StepLogFileEval for Action LongTermArchivement_2014_02 

Analyse a Step log file for an Object and sets the status

26.02.2014 2,121 S.Gueth 1219 JCT New: SubAction MoveToArchive for Action LongTermArchivement_2014_02 

moves or deletes specified files to/from the archive 

protocoles every single step in an archive log file

07.02.2014 2,121 J.Fes CheckBox Ver.Info New: In special case syntax of CBExtract.csv file contains unexpected New Lines. 

New Parser is now correcting this problem. 

 

#Example: 

--------- 

Readet File Content: 

ObjectCLI;ResultCode;ResultMsg;xml_filename 

@DB/CB_TEST_AP01/A;949982; 

NX License Error:  License server system does not support this feature. [ -18 ] 

[2547];C:\Temp\JobClient\Tc83_CB1_ExtrNx75_00199_CustomerNameShort\JobTemp\CB_TEST_AP01_A_master.xml 

 

Parsed File Content: 

ObjectCLI;ResultCode;ResultMsg;xml_filename 

@DB/CB_TEST_AP01/A;949982;NX License Error:  License server system does not support this feature. [ -18 

][2547];C:\Temp\JobClient\Tc83_CB1_ExtrNx75_00199_CustomerNameShort\JobTemp\CB_TEST_AP01_A_master.xml

05.02.2014 2,121 J.Fes 1179 ObjectList Ver.Info New: ProE add Data Type  

 ProPrt (ProE-SinglePart) 

 ProAsm (ProE-Assembly) 

 ProDrw (ProE-Drawing)
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29.01.2014 2,121 J.Fes JCT Ver.Info Change: MigIdeas2NX_2013_10.CMM_ResultEval.CMMProcessesStop extended  

Please use Option -LogFile "#Log_DPNE#" to write  

ProcessTryKill informations into this File.

29.01.2014 2,121 J.Fes JCT Ver.Info Change: MigIdeas2NX_2013_10.CMM_ResultEval.CMMProcessesStop extended  

Please use Option -LogFile "#Log_DPNE#" to write  

ProcessTryKill informations into this File.

23.01.2014 2,121 J.Fes JCT Ver.Info Change: -Action "RefileTC_2012_01" -SubAction "extract" 

In Special cases IR data was not added to 'RfInput list'   

Issue is solved by code canges

20.01.2014 2,121 J.Fes JCT Ver.Info Change: MigIdeas2NX_2013_10.CMM_ResultEval  

P.ResMsg contained doubble Text 'CMMLog:'   

#Example: [CMMLog:[CMMLog:..]]  

Issue is now solved by code changes

20.01.2014 2,121 J.Fes JCT Ver.Info Change: CMM Process Result Evaluation filters now:  

from *_cmm.log the filename of TC-Server Process. 

and parses from this file name the TC-Server PID. 

#Example: 

find in _cmm.log file line: 

' Teamcenter Log File Name:  E:\TC_Temp\tcserver.exe21a815a7.syslog' 

                                          parsing:|....|  

                                  Convert.ToInt32('21a8', 16) = 8616 (=TCServer PID)  

If Process with the parsed PID exist's then this Process will be stopped.  

Thanks to: Waldemar Weber

20.01.2014 2,121 J.Fes JCT Ver.Info Change: CMM Process Result Evaluation filters now:  

from *_cmm.log the filename of TC-Server Process. 

and parses from this file name the TC-Server PID. 

#Example: 

find in _cmm.log file line: 

' Teamcenter Log File Name:  E:\TC_Temp\tcserver.exe21a815a7.syslog' 

                                          parsing:|....|  

                                  Convert.ToInt32('21a8', 16) = 8616 (=TCServer PID)  

If Process with the parsed PID exist's then this Process will be stopped.  

Thanks to: Waldemar Weber

10.01.2014 2,121 J.Fes Import Ver.Info Change: During Site DataImport Data of Colume: 'Imp.Data.IrLast.ModDate Start'  

It is now ensured that every 120 sec this data is update and saved in JS.Site Data

03.01.2014 2,121 J.Fes JobControl Ver.Info Change: JobServer Mode: 'Manuell' Button and function removed.

16.12.2013 2,121 J.Fes JobControl Ver.Info Change: JS JobControler outputs now more details if a JobClient runs in TestMode. 

Now all Job's that are skippt is reported into message window.

16.12.2013 2,121 J.Fes JCT Ver.Info Change: -Action "RefileTC_2012_01" -SubAction "EVALUATE" 

Rf.NX.Syslog reports now: 'Save:NO'  

if no save action found for Part.

12.12.2013 2,121 J.Fes JCT Ver.Info New: Evaluate refile results via JM.CmdTools is implemented. 

Parsing of RfNx.syslog is also implemented. 

 

Parsing of RfNx.syslog do not changes the ProcessResult Code . 

 

Output of Rf.Result Example: 

P.Res.Msg   [Rf:OK][Rf.NX.Syslog:LoadUp:OK,LoadDisp:OK,Save:OK,SecEnd:OK] 

             |       |-> Parsed Details from Rf.NX.Syslog file  

             |-> Parsed Details from Rf.Log.Files

04.12.2013 2,121 J.Fes Import Sites/Data 

Import

Ver.Info Change: With this version Item information is imported to JM.DB if at least one IR of Item contains Datasets. 

If you activate in Register: Sites/Data Import -> Site -> Register 'Site TC Import Settings 1'  

Option: Import 'all' Item Data [x] then all Item Data are imported to JM.DB 

        even if IR of Item do NOT contain any Dataset.

25.11.2013 2,12 J.Fes JCT Ver.Info New: -Action MigIdeas2NX_2013_10 -SubAction CMM_ResultEval 

Parsing of cmm logfiles is now integrated.

25.11.2013 2,12 J.Fes Reports Ver.Info New: New Volume Reports avilable: 

 - Report_102_VolumeStatistic_DSType_All   counts in group's Sites, Volumes, Types  

 - Report_103_VolumeStatistic_DSType_NX    counts in group's Sites, Volumes, only NX DataSets 

 - Report_104_VolumeStatistic_DSType_Ideas counts in group's Sites, Volumes, only Ideas DataSets
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25.11.2013 2,12 J.Fes JCT Ver.Info New: -Action MigIdeas2NX_2013_10 -SubAction CMM_ResultEval 

Parsing of cmm logfiles is now integrated.

23.11.2013 2,12 J.Fes JobControl Ver.Info New: JobControl:JobComputers list the Colume "Org.Notice"   

is now formated in large text syle.  

Now you can add new lines and font is set as courier new (Blockfont).

18.11.2013 2,12 S.Gueth Settings JCT CheckBox Check.Settings New: result classification rules for centre of gravity

18.11.2013 2,12 S.Gueth Settings JCT CheckBox Check.Settings New: Result Classification Rules for volume deviation is now avilable.

18.11.2013 2,12 J.Fes ObjectList Ver.Info New: In JobServer 'Object-Liste' Register  

Object's ID filter Dialog enhanced. This Dialog contains now a new button  

to save listed ID's into an file.

13.11.2013 2,12 J.Fes 1163 CheckBox Ver.Info Change: Parthitory check redesigned. Now CheckBox check if in both Parthistory's  

the last 'save action' was done by the same save version. 

 

Also we check now if the Date/Time of Parthistory has a exactly differenc of 0[min] or 60[min] 

This is required because since NX8.0 we found differnces of exact 60[min] in Date/Time stamp. 

 

#Example: see in line 3-5 60[min] diff in line 6-7 0[min] diff.   

   CheckBox.Data 1:[NX V4.0.4.2]                                        |CheckBox.Data 2:[NX V8.0.3.4]                                         

 

   ---------------------------------------------------------------------|------------------------------------------------------

---------------- 

   CliName.:@DB/041.231.104/C/master/                                   |CliName.:@DB/041.231.104/C/master/                                    

 

   PartHis.:~                                                           |PartHis.:93 12 Nov 13 14:57 NT x64 infodba NX 8.0.3.4 

- External User~ 

 1 PartHis.:92 12 Nov 13 13:44 NT Intel infodba NX 4.0.4.2 - External U~|PartHis.:92 27 Jun 13 12:07 NT x64 infodba NX 8.0.3.4 

(NX Manager ref~ 

 2 PartHis.:91 16 Apr 13 03:33 NT Intel infodba NX 4.0.4.2 (NX Manager ~|PartHis.:91 16 Apr 13 04:33 NT Intel infodba NX 

4.0.4.2 (NX Manager r~ 

 3 PartHis.:90 18 Apr 12 23:47 NT Intel nethh NX 4.0.4.2                |PartHis.:90 19 Apr 12 00:47 NT Intel nethh NX 4.0.4.2                 

 

 4 PartHis.:89 20 Apr 12 10:33 NT Intel nethh NX 4.0.4.2                |PartHis.:89 20 Apr 12 11:33 NT Intel nethh NX 4.0.4.2                 

 

 5 PartHis.:88 20 Apr 12 10:31 NT Intel nethh NX 4.0.4.2                |PartHis.:88 20 Apr 12 11:31 NT Intel nethh NX 4.0.4.2                 

 

 6 PartHis.:87 02 Feb 09 17:00 NT Intel nethh NX 4.0.4.2                |PartHis.:87 02 Feb 09 17:00 NT Intel nethh NX 4.0.4.2                 

 

 7 PartHis.:86 02 Feb 09 10:45 NT Intel sidlerc NX 4.0.4.2              |PartHis.:86 02 Feb 09 10:45 NT Intel sidlerc NX 

4.0.4.2

10.11.2013 2,12 J.Fes 1160 Settings CheckBox Check.Settings Change: Methode to analyze difference of ModelData.MomentOfInertia is now based on  

comparing vector distance beween SolidBodyData1.MomentOfInertia and SolidBodyData2.MomentOfInertia. 

More Details please refer dokument: 

file://download.plmjobmanager.com/JobManagerV3/V2-0002-AppResources/90-DATA/CustomerNameShort_SettingsGlobal/10-

JobScripts/CheckBox/Documentation.Application/CheckBox_02Analyse_JFES.pdf 

Page: Model Data: Comparing Moment Of Inertial 

  

#Hint: Before MomentOfInertia was analysed by checking XYZ differences.

08.11.2013 2,12 J.Fes ObjectList Ver.Info New: Selection of Objects is now working together with the type of 

Objects you like to select and view in the JobServer 'Objects List'. 

 

JS:'Objects List' -> C.Typ (DS/IR/I) 

If IR or DS is selected then IR's are the base of the selection 

If I(tems) selected then from the list the items are parsed  

out and his is then the selection base for the items to view.

06.11.2013 2,12 J.Fes JobControl UpdDb=Yes New: In JobControl Rules you can now defined for SelObjectsBy_ObjectSpecSelRule  

which status the Incl.Object's must have to include them in the JobPacket. 

Special Rules: If value is '=' or '' then the status is the same as defined in 'sel.O.P.Stat(N,M)'  

see: JobControl Rules field:'->Incl.P.Stat:'
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05.11.2013 2,12 J.Fes JCT Ver.Info New: New switch -MsgLog_DPNE "#JobRoot_DP#\JCCmdToolMsg_Log.txt" 

If this paramter is given then all messages printed by JC.CmdTools is appended to the given Message.log file.

03.11.2013 2,12 J.Fes ObjectList Ver.Info Change: Data columes of Register 'Objects(DS/IRS)' renamed: 

 

Data colume:                 has Caption:  

ProcessResultMsg          -> P.Res Msg 

ProcessResultExtendedData -> P.Res Msg.Ext.Data" 

ProcessState              -> P.Res State 

ProcessResultCode         -> P.Res Code 

ProcessResultHasWarning   -> P.Res Has.WRN 

ProcessResultLink         -> P.Res Lnk

31.10.2013 2,12 S.Gueth Settings CheckBox Check.Settings New: CheckBox Settings: define 'moment of inertia' result classifications

30.10.2013 2,12 J.Fes ObjectList Ver.Info New: Object's that has to be Exported can be searched via folowing conditions:  

 

O.Expo.Rec.Date<O.Last.ModDate 

O.Expo.Rec.Date is empty (Object has no Export Date) 

O.Expo.Rec is empty      (Object is not Expordet to any Other.Site)

30.10.2013 2,12 J.Fes ObjectList Ver.Info New: Object's can be searched via  

- Exported to Site  

- Last Export Date

24.10.2013 2,12 J.Fes ObjectList Ver.Info New: New dialog to select Object's via Objects ID's added to JobServer. 

 

This dialog shows an large input box to list Item or Ir id's  

to filter and view objects in JobServer. 

 

Also in this dialog you can now select an input file  

where Object id are stored in.

24.10.2013 2,12 J.Fes 1167 JCT Ver.Info Change: Status 'final InputList' added IR's even if IRs 'i-deas dataset' has NOT a corresponding 'NX Dataset' 

Problem is now solved. 

 

Second Repair: 2.1200;06.11.2013;J.Fes; 

If TcDataset was not in JobPacket includet the Data was wrong added into the packet 

Problem is now solved.

24.10.2013 2,12 J.Fes 1167 JCT Ver.Info Change: Status 'final InputList' added IR's even if IRs 'i-deas dataset' has NOT a corresponding 'NX Dataset' 

Problem is now solved. 

 

Second Repair: 2.1200;06.11.2013;J.Fes; 

If TcDataset was not in JobPacket includet the Data was wrong added into the packet 

Problem is now solved.

16.10.2013 2,12 S.Gueth CheckBox New: new parameter: CBConfigXml --> defines the settings file for CBSettingsManager 

 example 1: -CBConfigXml "CBMgrConfig.xml" (relative filename #JobMgr_Root_DP#\02-BinClient\CBMgrConfig.xml) 

 example 2: \\PLMServer\PLMShare\JobManagerV3\02-BinClient\CBMgrConfig.xml (filename with full path)

16.10.2013 2,12 J.Fes Scripting Ver.Info Change: Code changes on Class Datasets_and_Irs_cls 

IrFromSiteID is replaced by ObjectFromSiteID

15.10.2013 2,12 J.Fes JobControl UpdDb=Yes Ver.Info Change: If a Job containd a JobPlaner Object then an Exception  

has been issued during creating a new Job. Problem is now fixed by code changes 

#Doc Info: !!! Update of JobManager Database is required !!!

15.10.2013 2,12 A.Becker 1785 UpdDb=No Change: - Serialized byte array can be prepared, a following call of ToByteArray() will be satisfied from the previously generated 

data. 

 - The serializing and compressing methods are optimized for lower memory usage (avoiding temporary byte array copies, using 

streaming instead).

15.10.2013 2,12 A.Becker 1785 UpdDb=No New: The serialization process is time consuming. When done within the sending process, it has to be finished within the timeout 

while waiting for the StreamBeginMarker. 

This change enables the client to send KeepAlive packages to the server while serializing the data. 

Recommended values for the StreamBeginMarker Timeout are around 5-10 seconds now.

10.10.2013 2,12 J.Fes JobControl UpdDb=Yes Ver.Info New: JobObject Selection Methode extendet. Now you are able to select  

all specific DS Types of IR. Base of IR selection is DS. 

#Example: all UGMASTER + UPPART  DS of IR. Base selection for IR is UGMASTER Dastaset 

 

Update of Database is required
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30.09.2013 2,12 J.Fes ObjectList Ver.Info Change: Colume: O.ReleaseState renamed to O.Rel.State 

Colume: O.ReleaseDate  renamed to O.Rel.State.Date

23.09.2013 2,12 J.Fes 1152 CheckBox Ver.Info New: Option: 'Attr_WithNoRef_AndBlankValue_etimate_as added' to CheckBox 

Now you can define how to estimate:  

defines how to estimate: Attributes that did not find a referenced Attribut (with same Name) and value is Blank  

 - DiffReport_as_WRN: Differences will be reported as Waring. 

 - DiffReport_as_ERR: Differences will be reported as Error (default). 

 - DiffReport_NO....: Differences will NOT be reported. Nothing will be written to the report file.

23.09.2013 2,12 J.Fes 1153 CheckBox Ver.Info New: Parsing and compairing Text conatains Symbols is now implemented. 

For this new conversion Rule is desinged Software now converts for Example: '10$s' to '10<$s>'  

behause until ~NX4 Symbols are written in value: '10$s' in newer Versions are written in this Syntax 10<$s>

19.09.2013 2,12 J.Fes JobControl Ver.Info New: JobProcess Data data stored in JobData1ToProcess.xml file 

contains now: <ir_puid> Data 

- if an Dataset is selected ir.pruid is filled in 

- if an Ir is selected Item.puid is filled in 

- if an Item is selected ir_puid is filled in 

 

#Example section from JobData1ToProcess.xml file: 

 <ObjectIr> 

   <CharacterKey /> 

  <ItemName>55000000023803</ItemName> 

  <Rev>A2</Rev> 

  <ir_puid>w3ANHjmRwD$ZRC</ir_puid> 

  <ObjectFromSiteID>BLND6R</ObjectFromSiteID> 

</ObjectIr>

13.09.2013 2,12 J.Fes Install and Setup Ver.Info New: Type integration of i-deas / IdeasPart / IdeasAssembly / IdeasDrawing

13.09.2013 2,12 J.Fes JobControl Ver.Info Change: In some cases JobStatus was wrong interpretet. 

Issue is now fixed by code changes.

13.09.2013 2,12 J.Fes Import Sites/Data 

Import

Ver.Info Change: if ObjectFs_SizeBytes is not readed then value is empty

13.09.2013 2,12 J.Fes GUI Ver.Info Change: JobServer Titel Version info changed to new format 

Syntax is now: VX.YYYY (Build:DD.MM.YYYY:[Build.Nr]) 

Example:       V2.1200 (Build:12.09.2013:[5])

13.09.2013 2,12 J.Fes Import Sites/Data 

Import

Ver.Info Change: Dataset ReleaseState and ReleaseDate was not written to JM.DB Problem is now fixed.

12.09.2013 2,12 J.Fes Admin Ver.Info New: if an Exception happend then debug information's   

contains now sourscode file name and sourcecode line number. 

With this info we get better information's to fix issues in PLMJobManager Software.

20.08.2013 2,12 J.Fes Import Sites/Data 

Import

UpdDb=Yes Ver.Info New: Information about export recordes is now avilable 

for Items Irs and Datasets

19.08.2013 2,12 J.Fes Import Sites/Data 

Import

Ver.Info

16.08.2013 2,12 J.Fes Import Sites/Data 

Import

UpdDb=Yes Ver.Info New: Import of DataClass 'Item' now avialble

16.08.2013 2,12 J.Fes Import Sites/Data 

Import

UpdDb=Yes Ver.Info New: Import of DataClass 'Item' now avialble

12.08.2013 2,1199 J.Fes Import Sites/Data 

Import

Ver.Info Change: In Sites/Data colume 'note' is now a multiline cell

09.08.2013 2,1199 J.Fes ObjectJobResults Ver.Info New: JobLink support's now direct access to JobLog Files  

Therefor a new syntax is desinged: #JobLog_lnk#\JobLog_PP\File_NE 

                                     |           |         |-> File in JobLog 

                                     |           |-> parcial path in JobLog 

                                     |-> definition for use of internal Link to JobLog.zip file

19.07.2013 2,1199 J.Fes JobControl Ver.Info New: New Option JobControl.ObjectSpecialSelectRule 'DS.all of IR (TC DataSets)' 

This Option can be used in JobControl Object Selection to select all Dataset's of Item Revision

17.07.2013 2,1199 J.Fes Settings Ver.Info Change: If settings are updated that relevant for the GUI are now  

directly updated.

08.07.2013 2,1198 S.Gueth JCT New: function to extract the refile objects into the input lists, seperated by OwningS and replica objects

08.07.2013 2,1198 S.Gueth JCT New: function to extract the refile objects into the input lists, seperated by OwningS and replica objects

 59 / 73
Release Date/Time: 25.11.2025 08:48

Relase Version: 3.2000.2511.2025



PLMJobManager: What's New

Date Version User Issue-Nr Categorie Additional Info Type Description

04.07.2013 2,1198 J.Fes Import Sites/Data 

Import

Ver.Info Change: if file system is a unix file system now 

correct path to the volume file is imported

04.07.2013 2,1198 J.Fes Import Sites/Data 

Import

Ver.Info Change: if file system is a unix file system now 

correct path to the volume file is imported

03.07.2013 2,1198 J.Fes ObjectList Ver.Info Change: On function Objects (DS/IRS) -> Extra View all Data of Assembly   

if more then one IR was requested. Statistic of Bom struture was wrong  

because Data of 'components total' and 'components different' was added by eatch analysed IR  

Issue is solved by code changes

27.06.2013 2,1198 J.Fes JobControl Ver.Info Change: If JobClient is in TestMode only JobRules are used that starts with 'T' as P.Status selection criteria. 

All JobContol.Rules that do !!-NOT-!! starts with P.Status = 'T' are skipped."

27.06.2013 2,1198 J.Fes CheckBox Ver.Info Change: if prepare.exe (TC.VIS) is used for converting .cgm to .tif  

and the files are located in UNC pathes then JCT replaces '\\' true '//' 

Reason is that prepare.exe do handels unc pathes wrong.

24.06.2013 2,1198 J.Fes CommandLineArgs Ver.Info New: -action IrInfoResolve_2011_06 updated it is now working again

22.06.2013 2,1198 J.Fes JobControl Ver.Info Change: Analyse of Refile extracts now additonal infos from _failed_refiles.log  

if more then one Line was written in _failed_refiles.log.   

 

Example: Content of _failed_refiles.log: 

@DB/66047700/A 

# Returned error-code: 100000023 - while saving data to Teamcenter: 

Cannot find related object "IRM" (in "IRM.PLME_string_02") on "???" of class "???" (tag 00000000) 

 

P.ResultMsg returns now:  

while saving data to Teamcenter: Cannot find related object "IRM" (in "IRM.PLME_string_02") on "???" of class "???" (tag 

00000000)

18.06.2013 2,1198 J.Fes CheckBox Ver.Info Change: CB.Extract Data new ProcessResult Section [SAVE:xx] / 'CBExtr-12' added 

Data are returned if CB option -SaveWorkPart was active during CheckBox data extraction

26.05.2013 2,1198 J.Fes 1129 JCT Ver.Info Change: If no CB.Results during CB.extraction was written to zzCBExport_Result.csv file then  

Evaluation of results have not been proccesed. 

Issue is now solved by code changes

22.05.2013 2,1196 S.Gueth Settings CheckBox Check.Settings New: New in CheckBox Settings: PPM_Deviation_AsWarning 

defines the max deviation, until the drawing compare is estimated as a warning, default is 250

21.05.2013 2,1198 J.Fes 1130 JobControl Ver.Info Change: JobResults of GenericJobResultsV2 (JobData2Result.xml) is now imported bevor 

JobResults of GenericJobResultsV1 (*JobResultsGenericV1.Log) is imported.

16.05.2013 2,1198 J.Fes CheckBox Ver.Info Change: Refdata not found was wrong assinged in case if CB1.NXVersion was CB2.NXVersion. 

Problem is now fixed.

03.05.2013 2,1196 J.Fes Import Sites/Data 

Import

Ver.Info Doc: During manuell TC: IR/DS import JS Checks now  

- If IR still contains: 'Dataset' and 'UG FileObject' in named references.  

- If no 'UGPART Dataset' and 'UG FileObject' in IR exist then JS removes IR and Dataset's from JM.DB.

19.04.2013 2,1196 S.Gueth 123 JCT New: CheckBox Settings: CBCmdProgDefs 

List of all CB Program definitions, which will be executed, if some image files are selected and the compare button is pressed 

 

Extention.: extention of the file, for that the program will be executed 

CmdProg...: full path to the program file 

CmdDefDir.: directory in which the program should be executed, you can set this directory in the options with #File_DP# 

CmdOptions: arguments for the program, the selected files you can set with: #File1_DPNE# #File2_DPNE# #File3_DPNE# ...

18.04.2013 2,1196 J.Fes 25 CheckBox Ver.Info New: CB.Compair Result now assembels used process version infos and transfers   

this data to process result Colume: 'P.Used.Prg.Vers' 

Example: P.Used.Prg.Vers: 

[Extr1.CADv:NX V7.5.1.5][Extr1.CBv:V2.0.1.5(NX7.5ff)][Extr1.CAD.FILEv:NX V7.5.1.5] 

  extract 1:|-> Used.NX Ver.   |-> Used.NxCB. Ver                     |-> Vers. of CAD.Files(was last saved) 

[Extr2.CADv:NX V7.5.1.5][Extr2.CBv:V2.0.1.5(NX7.5ff)][Extr2.CAD.FILEv:NX V7.5.1.5] 

  extract 2:|-> Used.NX Ver.   |-> Used.NxCB. Ver                     |-> Vers. of CAD.Files(was last saved) 

[Comp.JM.CBCv:V2013-04-21.01]    

 for CheckBox Compair:|-> Used JobManager CheckBox Compair Version (CBCv)
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18.04.2013 2,1196 J.Fes 25 CheckBox Ver.Info New: After NX.CB extract data now CB.CMD Tools reading form NX.syslog the used 

NX Version information and transfers this data to 

process result Colume: 'P.Used.Prg.Vers' 

Example: P.Used.Prg.Vers......: [Extr.CADv:NX 6.0.2.8 MP13, 21Apr11][Extr.CBv:V2.0.1.5(NX7.5ff)][Extr.CAD.FILEv:NX V4.0.1]

17.04.2013 2,1196 J.Fes Import Ver.Info Change: Tab: 'Sites/Data Import' Colume names renamed   

Names are now strutured by group: 

- Site........: SiteID/Descrption 

- IContr......: settings for Import Control like: 'DateModBegin' 'Update force'   

- Org-Info....: Org Info's 

- Setup-DB....: settings for Setup DB access like: DB.Provider (Ora/Mssql) ..  

- Setup-Imp...: settings for Import Conditions like Setup-Imp:Tc-Prj.Data 

- Setup-Native: settings for Setup a Native Site definition

16.04.2013 2,1196 S.Gueth JCT New: DataShare new parameters: 

-ImportUpdateListDir_DP 

-TCSiteId 

if they are set, the ImportUpdateList txt file  

for successfully processed items will be created

11.04.2013 2,1196 J.Fes CheckBox Ver.Info Change: Analysing of text containing relationships improved. 

now text containing relations attends replace rule from:'<W@?' to:'<W@'  

Example: <W@?RELATIONNAME> to <W@RELATIONNAME>

05.04.2013 2,1196 J.Fes Settings CheckBox Check.Settings Change: Setting Renamed from: ModelBodysCheck_Methode to:  

Zeile 2

02.04.2013 2,1196 S.Gueth ObjectJobResults 

CheckBox

New: If you click on J.Link and the result file is a valid checkbox result file,  

the CbSettingsManager will be opend with the  current result

01.04.2013 2,1196 J.Fes Import Sites/Data 

Import

UpdDb=Yes Ver.Info New: Import of Project Data for Item / ItemRev / Datasets avilable.

29.03.2013 2,1197 J.Fes Install and Setup 

CheckBox

Ver.Info Change: In JobServer Settings Mananger JobServer -> Extra -> Setup -> Tab:CheckBox !! is removed !! 

Please remind: 

CheckBox settings are now managed with external tool: "91-CheckBox (Settings and Compair Tool)" 

You can start the new tool via "_JobManager" Toolbar: 

-  _JobManagerV3 -> 91-TestSystem -> 91-CheckBox (Settings and Compair Tool) 

    --- Or --- 

-  _JobManagerV3 -> 91-ProdSystem -> 91-CheckBox (Settings and Compair Tool)

29.03.2013 2,1196 J.Fes JobControl Settings Ver.Info 

Check.Settings

New: Gitter Variablen erweitert es stehen jetzt folgende Variablen zur verfügung 

-#JobObjectsN#        = defined Object per Packet for this Job 

-#JobObjectApSumMax#  = defined max Summe of AP Comp. for this Job

28.03.2013 2,1196 J.Fes CheckBox Ver.Info Change: IssueJobMgr.Issue-110: Problem to find matching text for Entity 25/25 Text's   

is now solved

27.03.2013 2,1196 J.Fes ObjectList Settings Check.Settings Change:

26.03.2013 2,1196 S.Gueth JCT CheckBox Change: if there is no cgm to tif program it displays: 

[DC:ERR:CgmToTif Conver.Prg (%UGII_BASE_DIR%\NXPLOT\cgm2tiff.exe) Not Found]

25.03.2013 2,1195 J.Fes CheckBox Ver.Info New: ModelData.SolidBodyCheck Analyse of section PrototyeAnalysis integreted. 

Now comparing 'SolidBodies' consitensy is avilable

20.03.2013 2,1195 S.Gueth JCT Change: --> errors like MB:SUCCESS where removed, not it is only SUCCESS

20.03.2013 2,1195 S.Gueth JCT Change: --> errors like MB:SUCCESS where removed, not it is only SUCCESS

11.03.2013 2,1195 J.Fes JCT CheckBox Ver.Info New: All listed EntitisType25 SubTypes  'Ent25.Subtype(#Number#)'  

will -!!NOT!!- be compared [Default=List is empty] [Example:6 = UF_draft_crosshatch_subtype]

07.03.2013 2,1195 J.Fes Import Settings Check.Settings Change: It is now possible to use SyncSiteData during sync TC.DB and JM.DB via TaskSheduler task. 

to use this please add in Task.Job parameter /SyncSiteData=true

07.03.2013 2,1195 J.Fes Import Sites/Data 

Import

Ver.Info Change: SiteData 'DataSync' checks now if ItemId or RevId has changed. 

If yes data in JM.DB will be updatet.
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04.03.2013 2,1194 S.Gueth JCT CheckBox New: Section: P.ResultMsg            P.Res.Code 

P.ERR..: NO CB.Data extracted.: CBExtr-01 

PL.....: Loading Part.........: CBExtr-02 

UF.....: Update: All Features.: CBExtr-03 

UD.....: Update: Drawing views: CBExtr-04 

PH.....: Part Header Section..: CBExtr-05 

MD.....: Model Section........: CBExtr-06 

AS.....: Assembly Section.....: CBExtr-07 

DR.....: Drawing Section......: CBExtr-08 

EN.....: Entities Section.....: CBExtr-09 

CBxml..: write Section........: CBExtr-10 

CGM....: Gen CGM File.........: CBExtr-11 

Save...: Save Part............: CBExtr-12

04.03.2013 2,1194 S.Gueth JCT New: Neue Klassen CmdOutputParseObjects_cls und CmdOutputParseObject_cls, zum Parsen für das Data Share Output log

04.03.2013 2,1194 S.Gueth JCT New: sub ParseDataShareCmdOutputLogFile: to parse the cmd output logfile after the datashare process

04.03.2013 2,1194 J.Fes CheckBox Ver.Info Doc: - If using for TextCompairMethod = RemoveLeadingTrailingZeros. 

  Rule Results will be add to PartInfo section  

- If using for TextCompairMethod = AsText 

  Rule Results will be add to Ent25/Ent26 section

04.03.2013 2,1194 J.Fes CheckBox Ver.Info Change: If Txt.LTZ then 'Leading or Trailing Zeros' in Entity25 or Entity26 Text is found 

then Information is now add to section:[PI] Part Information."

04.03.2013 2,1194 J.Fes Settings CheckBox Ver.Info 

Check.Settings

New: see CheckBox.settings.DebugDetailsToCheckBoxCompairReport 

- if Value True:add Debugs to CheckBox Compair-Report 

- if Value False:NO Debugs in CheckBox Compair-Report 

- Default Value=False

04.03.2013 2,1194 S.Gueth CheckBox Change: Index was greater then List Index problem fixed.

01.03.2013 2,1194 J.Fes Settings CheckBox Ver.Info 

Check.Settings

Change: Now eatch TextBlock ist checked. 

LTZeros compensating is implementet. 

LTZeros = Leading / Traling Zeros compensating during comparing text.

25.02.2013 2,1194 J.Fes CheckBox Ver.Info Doc: TextCompair Entity 25 + 26 Information Text #CompRefId_ReplByJMCB# Removed

19.02.2013 2,1194 J.Fes JobControl Settings Ver.Info 

Check.Settings

New: In Custom Process Status definitions you are 

now able to define custom results for: 

[P.ResCode=??] [P.ResMsg=??] [P.ResWarn=1/0] [P.ResLink=Info..]

19.02.2013 2,1194 S.Gueth JCT New: -Action 'TcDataSync_2012_02' wurde in 'TcMultiSite_2012_12' umbenannt

19.02.2013 2,1194 S.Gueth JCT New: SubAction of 'TcMultiSite_2012_02' eingefÃ¼gt

18.02.2013 2,1194 J.Fes GUI ObjectList Settings Ver.Info 

Check.Settings

In JobServer Settings you can define 

if Datarows of Multisite/Replica Objects  

listet in Register: 'Objects List' datagrid will be colored.

15.02.2013 2,1194 J.Fes JobControl Ver.Info New: If JobClient is running in 'Debug' or 'Test' or 'DebugTest' Mode only '1' Job will be send to JobClient. 

This special rule prevents that during testings the user will be disturbed by getting other new Jobs.

14.02.2013 2,1194 J.Fes GUI Ver.Info New: Datagrid filter cell backcolor is set to gold if a filter value is aktive.

08.02.2013 2,1194 S.Gueth Settings CheckBox Check.Settings New: neues CheckBox Setting in Attributen 'Attr_value_compare_as_number_list'  

Die Atrribute werden darauf getestet, ob beide Values in einen Numerischen Wert geparst werden können, 

wenn das zutrifft, dann werden diese via Double Values verglichen, 

ansonsten werden diese als via strings verglichen.

05.02.2013 2,1194 S.Gueth Settings CheckBox Check.Settings

30.01.2013 2,1194 S.Gueth CheckBox New: neue Paramenter fÃ¼r den Checkboxvergleich, um die Beschreibung 

im div.txt File anzupassen, wenn 2 Verschiedene Teile verglichen werden  

Cb1DescShort, Cb1DescFull, Cb2DescShort, Cb2DescFull, CbReportDesc

30.01.2013 2,1194 S.Gueth GUI Settings Check.Settings #New: Property: JobServer_WorkInstanceForeColor to set Text fore color of JobServer

28.01.2013 2,1194 J.Fes JCT Ver.Info Change: -RecToAdd -RecCcAdd -RecBcAdd accepts user list 

Example: Firstname1.Name1@Company.com##Firstname1 Name1Firstname2.Name2@Company.com##Firstname2 Name2

23.01.2013 2,1194 S.Gueth GUI New: New Key-Action for JobClient: B = Break current JobServer connection
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22.01.2013 2,1194 S.Gueth CheckBox Result message for evaluating the CBExtract log has been adjusted. 

Example: "[PH:OK][MD:WRN:CB (NO error text found for error 96)][AS:OK][DR:OK][EN:OK]" 

WRN is output if the section is completed but contains an error, 

or if the section contains an error and the CB.xml is still written correctly 

could be written correctly. 

ERR is output if the section was not completed correctly and 

the CB.xml could not be written correctly. 

If a section does not exist, it is not output.

22.01.2013 2,1193 S.Gueth CheckBox Change: Ausgabeformat der Short Message wurde geÃ¤ndert: vorher: [MD:8 Msg:ERR:Vol] jetzt: [MD:ERR:Vol]  

Beispiel: [PH:OK][MD:ERR:Vol][AS:OK][DR:OK][EN25:OK][EN26:OK][DC:not.Proc][PF:OK][PI:WRN:MD:Density=0] 

            Get 

                '.Substring(Me.NameShort.Length) 

                If Me.ResultCode = 0 Then 

                    Return [ + Me.SectionMain.NameShort + : + Me.ResultMsgShort + ] 

                Else 

                    Return [ + Me.SectionMain.NameShort + : + Me.ResultMsgShort + ] 

                End If 

            End Get 

        End Property 

 

        Public Property ResultCode() As String 

        Public Property ResultCodeBinary() As Long 

        Public Property SectionMain() As New CheckBoxSections.Section_cls(, , 0) 

        Public Property SectionSub() As New CheckBoxSections.Section_cls(, , 0) 

 

 

        ''' <summary> 

        ''' gibt das Aggregierte Ergebniss in kurzform zurÃ¼ck  

        '''  #Example:[PH:OK][MD:OK][AS:OK][DR:OK][Pef:OK][PPM:OK] 

        ''' </summary> 

        ''' <value></value> 

        Public Property ResultMsgShort() As String 

            Get 

                Dim ResMsgReturn As String =  

                ' wenn mehrere Meldungen vorliegen dann diese anhÃ¤ngen 

                ' ApplDokuIntern: 2.068205.09.2010J.Fesangepasst so das jetzt auch kurz infos zu sehen sind

22.01.2013 2,1193 S.Gueth CheckBox New: In Checkboxsettings wurde die Option 'Density_is_0_AsErr' hinzugefügt. Diese gibt an, ob eine density = 0 als Fehler oder als 

Warnung gewertet werden soll. (Default is Fehler)

22.01.2013 2,1194 J.Fes JobControl Ver.Info Doc: if refile result file is not found Result is estimatet as R.Code=64 and R.Msg='Refiled Part File not found'

21.01.2013 2,1193 S.Gueth CheckBox New: Section Part Information eingefÃ¼hrt

15.01.2013 2,1193 J.Fes New: In den settings kÃ¶nnen jetzt die Pfade zu den OracleClientBin_Path Verzeichnissen angegeben werden.

18.12.2012 2,1189 J.Fes JobControl Ver.Info

18.12.2012 2,119 J.Fes Settings CheckBox Ver.Info 

Check.Settings

#New: Unterscheidung der Entity eingefÃ¼hrt fÃ¼r: 

 -EN25: 'Entity Data 25:Drafting' 

 -EN26: 'Entity Data 26:Dimensions'

14.12.2012 2,1185 J.Fes CheckBox Ver.Info Doc: - Example 1: NX8:'<W!123921@VWNAME>' ->  bis NX7.5:'<W@VWNAME>' 

- Example 2: NX8:'<WID1*0@DB_PART_NO>' -> NX6:'<W@DB_PART_NO>' 

  Durch diese Anpassung wird gewärleistet das Texte die Refferenzen beinhalten  

  und von den Versionen <=NX7.5 und von verglichen werden koennen"

02.12.2012 2,1176 S.Gueth JobControl New: </remarks>

24.11.2012 2,1169 J.Fes Settings CheckBox Ver.Info 

Check.Settings

New: Entities 25 UG_Darfting comparing added to CheckBox Compair.

24.11.2012 2,1169 J.Fes CheckBox Ver.Info Change: CheckBox Report contains now section lines. This lines helps to get better overview in CB Report File.

24.11.2012 2,1169 J.Fes CheckBox Ver.Info #Change: if Drawing Compair was not processed short value is: not.Proc"

20.11.2012 2,1166 J.Fes JobControl New: CB_GeometricCompare_cls</remarks>

15.11.2012 2,1162 J.Fes Settings CheckBox New: in CheckBox Settings you can disable the Check Of ViewAnchorPoints

14.11.2012 2,1159 J.Fes Settings CheckBox Ver.Info 

Check.Settings

New: Methode CLAs_Obj.TifMergCopyToTifMergCollectionIfPPMgt Avilable

14.11.2012 2,1159 J.Fes CheckBox UpdDb=No Ver.Info New: funtion to read CheckBox Results from CheckBox LogFile
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14.11.2012 2,1159 J.Fes Settings CheckBox Ver.Info 

Check.Settings

Methode CLAs_Obj.TifMergCopyToTifMergCollectionIfPPMgt Avilable"

09.11.2012 2,1154 J.Fes CheckBox Ver.Info New: Checking if Resets containing a valid volume.

02.11.2012 2,1149 J.Fes Settings Ver.Info 

Check.Settings

Check:'ObjectsWire_n' disablet by default (Result of CB.Meeting 6.11.2012)"

02.11.2012 2,1149 J.Fes Settings Ver.Info 

Check.Settings

"Check:'LayerObjects_n' disablet by default (Result of CB.Meeting 6.11.2012)"

02.11.2012 2,1149 J.Fes CheckBox Ver.Info Check.Settings;"Check:'ViewDependentObj' disablet by default (Result of CB.Meeting 6.11.2012)"

31.10.2012 2,1145 S.Gueth New: 

Doc:

Stand übernommen in:

31.10.2012 2,1145 S.Gueth New: 

Change:

2.118511.12.2012S.Gueth: #Change: added clip funktionality if the tif size is different

31.10.2012 2,1145 S.Gueth JobControl New: sub CutTifIfDifferent</remarks> 

        Public Sub CutTifIfDifferent(ByVal Tif1_DPNE As String, ByVal Tif2_DPNE As String) 

            'Dim Tif1_DPNE As String = C:\Users\Sascha\Desktop\zzCBMoveToArchiv_csvlog\300569403SHF044-001.FHZ01.B1F8L_----

_master_300569403SHF044-001_----_SH01_#CB6R - Kopie.tif 

            'Dim Tif2_DPNE As String = C:\Users\Sascha\Desktop\zzCBMoveToArchiv_csvlog\300569403SHF044-001.FHZ01.B1F8L_----

_master_300569403SHF044-001_----_SH01_#CB8F - Kopie.tif 

 

            Dim tif1 As System.Drawing.Image 

            Using Str As System.IO.Stream = System.IO.File.OpenRead(Tif1_DPNE) 

                tif1 = System.Drawing.Image.FromStream(Str) 

            End Using 

 

            Dim tif2 As System.Drawing.Image 

            Using Str As System.IO.Stream = System.IO.File.OpenRead(Tif2_DPNE) 

                tif2 = System.Drawing.Image.FromStream(Str) 

            End Using 

 

            Dim difHeight As Int32 = 0 

            Dim difWidth As Int32 = 0 

            Dim tifToResize_DPNE As String =  

 

            ' -- prüfen ob Bildhöhe ungleich 

            If tif1.Height <> tif2.Height Then 

                ' -- tif2 größer als tif 1 

                If tif2.Height > tif1.Height Then 

                    difHeight = tif2.Height - tif1.Height 

                    difWidth = tif2.Width - tif1.Width 

                    tifToResize_DPNE = Tif2_DPNE 

                    ' -- tif1 größer als tif 2 

                Else 

                    difHeight = tif1.Height - tif2.Height 

                    difWidth = tif1.Width - tif2.Width 

                    tifToResize_DPNE = Tif1_DPNE 

                End If 

            End If 31.10.2012 2,1145 S.Gueth JobControl New: function GetPPMFromPicture</remarks>

29.10.2012 2,1141 J.Fes JobControl Ver.Info New: Option -JobMgrDataOrg_BaseNameSchema RootPP1_N=CustomPP1_N verfügbar.

12.10.2012 2,1131 J.Fes JobControl Ver.Info Change: ProcessTimeStart ProcessTimeEnd umgestellt von Minuten genau auf Sekunden genau. Hierdurch wird jetzt der 'last process' 

Ergebnis richtig ermittelt. 

Zuvor ist es vorgekommen das wenn processe inherhalb der selben Minute ein object verarbeitet hat das das vorherige Ergebniss 

(und nicht das wirklich letzte) als 'last processed' ermittelt wurde.

12.10.2012 2,1131 J.Fes Import Sites/Data 

Import

Ver.Info Change: IrCreateDate IrLastModDate + ObjectCreateDate umgestellt von Minuten genau auf Sekunden genau."

12.10.2012 2,1131 J.Fes JobControl Ver.Info Doc: Beim Anlegen von JobRules werden die Daten der JobScripts für JobName + JobDescription automaisch  

übernommen wenn zuerst die JobScripts ausgewählt werden und dann gleich die neue JobRule gepeichert wird. 

Der JobName wird erstellt aus: JobScriptName_0n  

 

Die Speicherung der neuen JobRule wird ausgeführt wenn in eine andere Zeile des Datagrids geklickt wird."

12.10.2012 2,1131 J.Fes JobControl UpdDb=Yes New: JobPaket contains only Objektes of diffrent ItemRev.

12.10.2012 2,1131 J.Fes JobControl UpdDb=Yes New: JobPaket contains only Objektes of diffrent Items.
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12.10.2012 2,1131 J.Fes JobControl UpdDb=Yes New: JobPaket size control extendet with selections method:'sel:O.Status' 

This settings defines selectin definition for Objects with Status #New:[31.10.2011 J.Fes] 

If Value=empty then this Rule is Inaktive. If Vaule='' (2 >'< Chars)

12.10.2012 2,1131 J.Fes JobControl UpdDb=Yes New: 

Doc:

If Value>0 then this Rule is aktive

09.10.2012 2,1128 J.Fes Settings CheckBox Ver.Info 

Check.Settings

Change: New setting to control LayerObjects_n_DeviationMax.

09.10.2012 2,1128 J.Fes Settings CheckBox Ver.Info 

Check.Settings

New: Auswertung der Performance Daten können aus und eingeschaltet werden. Default = Aus

18.09.2012 2,1124 J.Fes JobControl Ver.Info Change: NX8 Refile format of "-out="%RfFailedLog_DPNE%" changed. Old Key 'ERR.Code:' changed to 'error-code:' "

13.09.2012 2,1116 J.Fes Settings CheckBox Check.Settings Change: Compair Checks now with setting: Settings_Obj.TotalFeatures_n_DeviationMax

13.09.2012 2,1116 J.Fes Settings CheckBox Check.Settings Change: Compair Checks now with setting: Settings_Obj.AliveFeatures_n_DeviationMax

30.08.2012 2,1114 J.Fes CheckBox Ver.Info

30.08.2012 2,1114 J.Fes CheckBox Ver.Info Change: Names of CheckBox Data Results changed _3Merge->_1Merge _1Dif.tif -> _3Dif _2DifHistoDat -> _3DifHistoDat

30.08.2012 2,1114 J.Fes CheckBox Ver.Info Change: Names of CheckBox Data Results changed  

      _3Merge       -> _1Merge

27.08.2012 2,1112 J.Fes Settings CheckBox Ver.Info 

Check.Settings

New: new CB Setting:'Refset_Feature3D_n_DeviationMax' defines max deviation until compairing 'Refset.Feature3D_n' is void as a Ok.

27.08.2012 2,1112 J.Fes Settings CheckBox Ver.Info 

Check.Settings

New: new CB Setting: 'ViewNotes_Dif_AsErr':Defines if ViewNotes diffs are estimated as Error.

27.08.2012 2,1112 J.Fes Settings CheckBox Ver.Info 

Check.Settings

New: new CB Setting: defines if 'ViewAnchorX.Y.Z' values not listed in NX8CBData.xml are estimated as Error.

24.08.2012 2,111 J.Fes JobControl Ver.Info Change:

20.08.2012 2,1105 A.Becker Scripting UpdDb=No New...: JobServer 'Scripting engine' support now additional Assemblies as References.  

Syntax: 'References Assembly.dll

20.08.2012 2,1105 A.Becker Scripting UpdDb=No New:In Scripten können zusätzliche Assemblies als Referenz angegeben werden.  

 Syntax: 'References Assembly.dll

19.08.2012 2,1104 J.Fes CheckBox Ver.Info Change: CBCompair_ResultAnalyse creates also tif files if required.

19.08.2012 2,1104 J.Fes Settings CheckBox Ver.Info 

Check.Settings

Change: CBCompair_ResultAnalyse creates also tif files if required.

16.08.2012 2,1103 J.Fes CheckBox Ver.Info Change: Names of CheckBox Data Results changed

19.07.2012 2,1086 J.Fes JobControl UpdDb=Yes New: Es können jetzt in den JobControl Rules via Extendet Process Controls Definitionen 

der Status anderer Process Gruppen mit geändert werden. 

#Syntax.: [RuleID=OK] [O.Type=*] [...] [P0#n#.Stat=#NewStatus#]. 

#Example: [RuleID=OK] [O.Type=*] [J.ResCode=0]  [J.ResMsg=*] [J.ResWarn=0] [P.Stat=D.OK] [P01.Stat=RUN] [P02.Stat=RUN]"

06.07.2012 2,1077 J.Fes ObjectList Ver.Info wird in der Id EingabeBox ein Return eingegben so wird das laden  

der Object Daten aus der Datenbank ausgeführt. 

Es hat den selben Effekt wie das anklicken des Knopf's 'Load List'"

03.07.2012 2,1072 J.Fes Import Sites/Data 

Import Settings

Ver.Info Neu: der Knopf J.Link verwendet die Ersetzungsregeln die definiert wurden in: ServerSettings.ReplaceRules

03.07.2012 2,1072 J.Fes Install and Setup DB Ver.Info #Neu: Standard DB Backupverzeichnis eingefügt ..\90-DATA\#Customer#_#WorkInst#\30-DataBase\24-JobServerDbBackup

21.06.2012 2,106 J.Fes CheckBox Ver.Info Ã„nderung: CB ResultFiles Trenner geÃ¤ndert von '_' auf '-' Bspl: alt: ug0000036000_NX75_CB3_CB2_Dif_Xml.txt -> 

ug0000036000_NX75_CB3-CB2_CBDif.txt

01.06.2012 2,1048 J.Fes JobControl Ver.Info Wenn im Job kein NX.syslog file enthalten war.  

wurde die TcSiteId nicht in allen Fällen korrekt ermittelt korriegiert

01.06.2012 2,1048 J.Fes Ver.Info Neuerung: beim dem Versuch den JobClient Computer zu Rebooten ist der JobClient hängen geblieben. Ursache: Down.exe fehlte im 

.\02-BinClient Verzeichniss. Korrigiert

05.04.2012 2,0987 J.Fes Scripts/Params. Ver.Info Neuerung: es steht die GitterVariable: #JobLogZipArchiv_DPNE# zur verfügung. Diese kann genutzt werden um z.B. in einer E-Mail 

auf den JobLogZipArchive File zu verweisen.

05.04.2012 2,0987 J.Fes JobControl Settings Ver.Info 

Check.Settings

Doc: Ablagestruktur von 90-DATA\#CustomerNameShort_WorkInst#\10-JobLogArchiv\ reorganiesiert. 

Die Logfiles werden jetzt in eigene Unterverzeichnisse je JobName abgelegt. 

Bestehendes 10-JobLogArchiv Verzeichnis inc. aller Logfiles einfach in Unterverzeichniss \10-JobLogArchiv\zz-

JobLogArchiv_Until2012-06-08 verschieben.

05.04.2012 2,0987 J.Fes JobControl Settings Ver.Info 

Check.Settings

Doc: Ablagestruktur von 90-DATA\#CustomerNameShort_WorkInst#\10-JobLogArchiv\ reorganiesiert. 

Die Logfiles werden jetzt in eigene Unterverzeichnisse je JobName abgelegt. 

Bestehendes 10-JobLogArchiv Verzeichnis inc. aller Logfiles einfach in Unterverzeichniss \10-JobLogArchiv\zz-

JobLogArchiv_Until2012-06-08 verschieben.
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03.03.2012 2,0974 J.Fes ObjectList Settings Ver.Info 

Check.Settings

Neuerung: Process State Edit Form überarbeitet"

20.02.2012 2,0962 J.Fes Install and Setup 

JobControl 

Scripts/Params. 

Settings

Ver.Info 

Check.Settings

Neuerung: #Root_DP#\03-BinPublic.ClientServer eingeführt. 

 In diesem Verzeichniss befinden sich Tools die von dem JobCLient's und von dem JobServer gleichzeitig verwendet werden. 

Beispiel: JobManagerCmdTools.exe

19.02.2012 2,0961 J.Fes JobControl Ver.Info New: JobLogFiles werden jetzt in Unterverzeichnissen abgelegt  

Example: ..\90-DATA\#Customer_WorkInst#\10-JobLogArchiv\#SiteId#_#JobContolName#\#JobName#.zip abgelegt  

Jobs die einen Error oder eine Exception währenden des Importvorganges hatten 

werden in das Verzeichniss ..\90-DATA\#Customer_WorkInst#\10-JobLogArchiv.ImportError\#JobName#.zip abgelegt"

13.02.2012 2,0951 J.Fes JobControl Settings Ver.Info 

Check.Settings

in JobScriptsNeuerung: wird im JobScript 

 set JobAddFile_JobData1ToProcess_xml=false 

 angegben so wird der File:[JobData1ToProcess_XML] nicht dem JobFile hinzugefuegt.

13.02.2012 2,0951 J.Fes JobControl Settings Check.Settings Change: Neuerung: wird im JobScript set JobAddFile_ObjectsProcessData_xml=false 

angegben so wird der ObjectsProcessData.xml nicht dem JobFile hinzugefuegt."

13.02.2012 2,0951 J.Fes JobControl Settings Ver.Info 

Check.Settings

in JobScriptsNeuerung: wird im JobScript 

 set JobAddFile_ObjectsListAllDetails_txt=false 

 angegben so wird der File:[#JobName#_ObjectsListAllDetails.txt] nicht dem JobFile hinzugefuegt.

13.02.2012 2,0951 J.Fes JobControl Settings Ver.Info 

Check.Settings

in JobScriptsNeuerung: wird im JobScript 

 set JobAddFile_ObjectsList_txt=false 

 angegben so wird der File:[#JobName#_ObjectsList.txt] nicht dem JobFile hinzugefuegt.

05.01.2012 2,0931 J.Fes JobControl Ver.Info Neuerung: SQL Query wird jetzt immer in die InfoSys mit ausgegeben

21.12.2011 2,0921 J.Fes JobControl Ver.Info Neuerung: Variablen ersetzung #TcSiteId# steht jetzt zur verfügung

19.12.2011 2,092 J.Fes ObjectList UpdDb=Yes Ver.Info Neuerung: die Objects Daten beinhaltet jetzt den Ir.Type

18.12.2011 2,0917 J.Fes ObjectList Ver.Info Neuerung: Performance Edit Processstatus/Mark.Object verbessert

28.11.2011 2,0907 J.Fes JobControl Ver.Info Neuerung: es gelten jetzt folgenden Regeln 

- Wenn ein Process als Me.ProcessResultCode = 0 And Me.ProcessResultHasWarning = false dann ist der P.Stat=D.OK 

- Wenn ein Process als Me.ProcessResultCode <> 0 dann ist der P.Stat=D.ERR 

- Wenn ein Process als Me.ProcessResultCode = 0 And Me.ProcessResultHasWarning = true dann ist der P.Stat=D.W

23.11.2011 2,0903 J.Fes JobControl Ver.Info Doc: ProcessProcState extended to 34 characters 

The process status is now displayed with P. + ProcessName. Example: P.Run.CB1.1 

Enhancement implemented by code extensions

17.11.2011 2,0901 J.Fes JobControl New: If the D=Debug mode is activated on the JobCLient. 

then the grid variable:#JobScriptParametersExtended# is automatically  

supplemented at the end with the entry 'set JobMgr_Debug=ON' 

 

If the T=Test mode is activated on the JobCLient. 

then the grid variable:#JobScriptParametersExtended# is automatically  

supplemented at the end with the entry 'set JobMgr_Test=ON' 

 

Enhancement implemented by code extensions

17.11.2011 2,09 J.Fes JobControl Ver.Info Neuerung: Beim arbeiten mit mehrere JobServern Processen wurden empfangene Pakete zwischen den den Jobserver Prozessen von den 

unterschiedlichen Jobserver Prozessen zufällig verarbeitet. 

Das wird jetzt dadurch vermieden das jeder Process einen eigenes Empfangsverzeichniss hat:...\90-

DATA\CustomerNameShort_WorkInst_TEST\90-JobTemp.BackFromClient\#ComuterName#_P#Protnummer#

15.11.2011 2,0898 J.Fes JobControl Ver.Info Neuerung: der process status kann nach ergebniss regeln bestimmt werden.

11.11.2011 2,0894 J.Fes JobControl Ver.Info New: F1 Help avilable

11.11.2011 2,0894 J.Fes JobControl Ver.Info Neuerung: F1 Hilfe verfügbar für JobContol.Rules. Edit via JobRule Editor

11.11.2011 2,0894 J.Fes JobControl Ver.Info Neuerung: F1 Hilfe verfügbar für JobContol.Rules. Edit via JobRule Editor

11.11.2011 2,0894 J.Fes CheckBox Ver.Info Neuerung: Ausgabeformat angepasst

11.11.2011 2,0894 J.Fes CheckBox Ver.Info Neuerung: Ausgabeformat angepasst

11.11.2011 2,0894 J.Fes CheckBox Ver.Info Neuerung: Ausgabeformat angepasst

08.11.2011 2,089 J.Fes Import Sites/Data 

Import

UpdDb=Yes Neuerung:Es können jetzt include Group Filter für den Import von TC.Daten definiert werden. z.B. Können hierdurch nur die 

Daten die der Gruppe 'Norm' gehören importiert werden.

08.11.2011 2,089 J.Fes Import Sites/Data 

Import

Ver.Info Neuerung: die Titelbezeichung geändert von 'Group' auf 'OrgInfo.Group' und von 'Note' auf 'OrgInfo.Note'
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31.10.2011 2,0884 J.Fes Import Sites/Data 

Import ObjectList

UpdDb=Yes Neuerung Es können jetzt Daten aus unterschiedliche Oracle Datenbanken abgefragt werden ohne zufor die Software neu zu 

starten. 

Zuvor war es erforderlich die Software neu zu starten wenn z.B. Daten aus TcDb2 abgerufen werden sollten jedoch zuvor Daten 

aus TcDb1 abgerufen wurden.

31.10.2011 2,0884 J.Fes Import Sites/Data 

Import ObjectList

UpdDb=Yes Neuerung Es können jetzt Daten aus unterschiedliche Oracle Datenbanken abgefragt werden ohne zufor die Software neu zu 

starten. 

Zuvor war es erforderlich die Software neu zu starten wenn z.B. Daten aus TcDb2 abgerufen werden sollten jedoch zuvor Daten 

aus TcDb1 abgerufen wurden.

31.10.2011 2,0886 J.Fes JobControl UpdDb=Yes Neuerung: Neue JobControl Regeln eingearbeitet 'sel:O.FsHitCountYN', 'J.Resource.Points', 'J.Res.P.State Value Rule'

31.10.2011 2,0886 J.Fes JobControl UpdDb=Yes Neuerung: Daten Feld grösse 'J.on Computers' geändert von 128 Zeichen auf 4000 Zeichen

30.10.2011 2,0882 J.Fes GUI Ver.Info Check.Settings;Neuerung: im Application Titel wird der wert von JobServer_WorkInstanceTitelName mit angezeigt.  

Hierdurch wird die es beim handhaben mit mehreren Umgebungen Übersichtlicher"

30.10.2011 2,0882 J.Fes Settings Ver.Info 

Check.Settings

"Neu: via settings kann der JobServer_WorkInstanceTitelName eingestellt werden"

30.10.2011 2,0883 J.Fes ObjectList Ver.Info Neuerung: Die Daten in der Spalte O.Nx.Type werden wie folgt eingefärbt: 

- 'SP' in Gelb  

- AP in DodgerBlue

27.10.2011 2,088 J.Fes GUI Ver.Info New:

26.10.2011 2,0879 J.Fes DB Import Sites/Data 

Import

Ver.Info Neuerung: der DBNetworkAlias kann jetzt via Dropdown Schalter ausgewählt werden. 

Die Namen werden aus dem file tnsnames.ora geparst und angezeigt. 

Die Datei tnsnames.ora muss jetzt mit ausgewählt werden.

25.10.2011 2,0878 J.Fes ObjectList Ver.Info Die Datenzeilen in 'Objects (DS/IRs)' bei Replica(non Owingsite) Objekten werden in Grau-Blau dargestellt.

25.10.2011 2,0878 J.Fes ObjectList Ver.Info Die Spalten [ProcStateCol] der Daten in 'Objects (DS/IRs)' werden in abhänikeit von ihrem Wert eingefärbt. Es gelten folgende 

Regeln: 

-Wert:N (Hellgrau) 

-Wert:A (Blau/Weis) 

-Wert:M (Cyan) 

-Wert:P (Orange) 

-Wert:D (Grün) 

-Wert:X (Rot) 

-Wert:*.Err (Rot) 

-Wert:*.Ok (Grün)

25.10.2011 2,0878 J.Fes ObjectList Ver.Info Neuerung: Beim klicken auf den Knopf in Search und List 'Objects (DS/IRs)' wird die Processspalte des aktuellen Prozesses 

automatisch eingblendet falls diese zuvor ausgeblendet war.

24.10.2011 2,0875 J.Fes ObjectList Ver.Info Aenderung: Farbsteuerun P.Status = 'M*' die Zelle wird jetzt in leicht dunklerem Cyan dargestellt

24.10.2011 2,0875 J.Fes ObjectList Ver.Info Aenderung: Farbsteuerun P.Status = 'M' die Zelle wird jetzt in Cyan dargestellt

13.10.2011 2,0869 A.Becker UpdDb=No New: Multiple files can be transferred from JobClient per job

19.09.2011 2,0849 J.Fes CheckBox Ver.Info Doc: Assembly ReferenceComponent (nur zur reference) wird jetzt ausgewertet

13.09.2011 2,0843 J.Fes Import Sites/Data 

Import

Ver.Info Wenn beim Import eine Exception auftritt so wird diese 

am Ende es Imports ausgegeben  

Meldung: [EXP: while Import Object:#IrCliNameFromSiteIdPuiDForOutput#]

13.09.2011 2,0843 J.Fes Import Sites/Data 

Import

Ver.Info

04.09.2011 2,0809 J.Fes ObjectJobResults Ver.Info Aenderung:MCS Report Parsing überarbeitet

04.09.2011 2,0809 J.Fes ObjectJobResults Ver.Info Aenderung:MCS Report Parsing Ã¼berarbeitet

03.09.2011 2,0808 J.Fes Import Sites/Data 

Import

UpdDb=Yes Import Performance Optimiert hierzu wurden 

 - Abgleich Methoden zum holen der Daten aus der JS DB verbessert. 

 - IR Daten werden jetzt nur noch beim ersten Dataset 'Importiert-Updatet'  

   wenn weitere Datasets der IR importiert werden so entfällt der 'Importiert-Updatet' der IR Daten.

30.08.2011 2,0803 J.Fes Import Sites/Data 

Import

Ver.Info Sync.Site.Data: Es wird jetzt auch verglichen ob IrOwningSite zwischen in TC.DB und JM.DB abweichend.  

Wenn ja dann werden die Daten dieser IR updatet

26.08.2011 2,08 J.Fes JobControl Settings Ver.Info 

Check.Settings

Aenderung:

22.08.2011 2,0797 J.Fes CheckBox Ver.Info

27.06.2011 2,0786 J.Fes ObjectJobResults 

Settings

Ver.Info + New.Settings(Scripts)in generischen JobResult Files können jetzt 

- an 7.ter Stelle der Parameter /SiteId mitgegeben werden Example:/SiteId=tceng 

Der Wert gibt an von welcher Site die ObjectDaten stammen
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27.06.2011 2,0786 J.Fes ObjectJobResults 

Settings

Ver.Info + New.Settings(Scripts)in generischen JobResult Files können jetzt 

- an 7.ter Stelle ObjectClass mitgegeben werden /ObjectClass=DS oder IR 

Der Wert gibt an ob das Object ein IR oder DS Objct ist

27.06.2011 2,0786 J.Fes ObjectJobResults 

Settings

Ver.Info + New.Settings(Scripts)In generischen JobResult Files können jetzt 

- an 7.ter Stelle ProcessProcStateCol mitgegeben werden /ProcessProcStateCol=ProcStateCol01..ProcStateCol10..ProcStateColRf 

 Der Wert gibt an unter welcher Processgruppe das Ergebniss gespeichert werden soll.

27.06.2011 2,0787 J.Fes JobControl Ver.Info New: Es ist jetzt moeglich das die Ergebnisse von Refile Prozessen 

und von weiteren Generischen Prozessen gleichzeitig eingelesen werden können.

25.06.2011 2,0782 J.Fes Ver.Info IrInfoResolve_2011_06 erstellt

18.06.2011 2,078 J.Fes JobControl Settings Ver.Info 

Check.Settings

JobControl --> Job Computers: --> C.works for Site Werte können jetzt via IN-LIST (TCSite1TCSite2) angegeben werden

13.06.2011 2,0771 J.Fes Import Sites/Data 

Import

UpdDb=Yes Ver.Info Buttom:Sync.Site.Data Updatet jetzt alle Irs + Datasets bei dem Ir.LastModDate  

zwischen Tc und JobMgr Db um 60 sec abweicht. Wenn ja dann werden die Daten dieser IR updatet

13.06.2011 2,0771 J.Fes Import Sites/Data 

Import

UpdDb=Yes Ver.Info Neuer Start Buttom:Syn.Site.Data im Register:[Sites/Data Import] eingefuegt

13.06.2011 2,0771 J.Fes Import Sites/Data 

Import

Ver.Info TC data containing "'" char in ItemId or IrId or in any names  

are now imported to JM.DB.

11.04.2011 2,076 J.Fes Settings CheckBox Ver.Info 

Check.Settings

Es kann jetzt festgelegt werden ob abweichungen beim ViewOutOfDateStatus als Error  

oder als Warning gewertet werden soll"

30.03.2011 2,0756 J.Fes JobControl Ver.Info Refile analysiert MC to AC konvertierung 

Optimierung der Ausgaben. 

Analysiert jetzt auch: Warning: 'Validation was skipped during conversion because referenced data was not loaded' 

 Alle Zeilen die convert_mcs Warning: * beinhalten

30.03.2011 2,0756 J.Fes JobControl Ver.Info Analysiert jetzt auch: Warning: 'Validation was skipped during conversion because referenced data was not loaded' 

 Alle Zeilen die convert_mcs Warning: * beinhalten"

07.03.2011 2,0748 J.Fes Import Sites/Data 

Import Settings

UpdDb=Yes Ver.Info 

Check.Settings

es steht unter den Sites/Dataimport eine Methode zur verfügung um Oracle Tabellen unter alternativen user abfragen zu können. 

 Hierfür steht das Feld Ora.TblNam.InfodbaReplace

25.02.2011 2,0744 J.Fes Settings CheckBox Ver.Info 

Check.Settings

beim Auswerten der PartHeader.CliName wird jetzt  

bei Native CB FileName.Ext fuer den Vergleich herangezogen

12.02.2011 2,0735 J.Fes JobControl 

ObjectJobResults

Ver.Info in den McsConvert LogFiles werden jetzt die Convert Sections für ein Part gefunden wenn z.B. folgende Namensaufbau 'Item/Rev-

AnyDescription:' festgelegt wurde. 

 siehe hierzu auch Definition in den CustomerDefaults für preferenc: Name=Assemblies_partDescriptiveName Value=$FILENAME

12.02.2011 2,0735 J.Fes JobControl 

ObjectJobResults

Ver.Info in den McsConvert LogFiles werden jetzt die Convert Sections fÃ¼r ein Part gefunden wenn z.B. folgende Namensaufbau 'Item/Rev-

AnyDescription:' festgelegt wurde. 

 siehe hierzu auch Definition in den CustomerDefaults fÃ¼r preferenc: Name=Assemblies_partDescriptiveName Value=$FILENAME

17.01.2011 2,0725 J.Fes GUI Settings UpdDb=No der aktive Debug Modus wird jetzt in der Regestrie gepseichert und ist nicht mehr abhänig von 

MyAppl_Settings.ServerSettings.JobServer_LogOnOff 

Info: MyAppl_Settings.ServerSettings.JobServer_LogOnOff wurde entfernt

29.12.2010 2,0713 J.Fes ObjectList Ver.Info DataSetType erweitert um: CAESOLUTIONCAEMESHCAEGEOM

07.12.2010 2,0708 J.Fes Settings CheckBox Ver.Info es kann jetzt festgelegt werden ob Komponenten mit Attribut UG_Geometry=NO miteinander verglichen werden sollen\wenn 

Me.Settings.AssemblyUG_GeometryNO_DoCompare 

-true=Komponenten vergleichen 

-false=Komponenten wird nicht verglichen (skip)

25.11.2010 2,0705 J.Fes ObjectJobResults Ver.Info wenn bei einem GenericProcess ein .\_convert_mcs.log file enthalten ist so wird dieser automatisch ausgewertet

18.11.2010 2,0702 J.Fes ObjectList Ver.Info Objecte können jetzt auch über ObjectCreateDate gesucht werden

27.10.2010 2,0697 J.Fes Settings CheckBox Ver.Info 

Check.Settings

legt die Liste der Modeldata Refset Namen fest die nicht verglichen werden sollen

25.10.2010 2,0695 J.Fes CheckBox Ver.Info Check.Settings;"die Parthistory's werden ausgewertet. 

Die Auswertung erfolgt durch vergleichen der Speicherversionen. 

Der Parthistory Check gilt dann als bestanden wenn die Daten die mit der neueren Version  

ermittelt wurden mindestens den mit dem gleichen Versionstand gespeichert wurden wie  

die Daten die mit der VorgÃ¤ngerversion ermittelt wurden. 

 

Regel: Wird ein Parthstory Error erkannt so wird das Part Automatisch auf exclude gesetzt. 

Siehe hierzu auch Settings.CheckBox CheckBoxPartHistoryCheck_AsErr"
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18.10.2010 2,069 J.Fes Reports UpdDb=Yes Ver.Info Report Layout und Print Engine implementiert

14.09.2010 2,0686 J.Fes ObjectList Ver.Info wenn der JobLink Button angeklickt wird und während dessen die shift Taste gedrückt wird öffnet sich der Exporer im 

Verzeichniss in dem das Dokument liegt und selectiert dieses.

14.09.2010 2,686 J.Fes ObjectList Ver.Info wenn der JobLink Button angeklickt wird und während dessen die shift Taste gedrückt wird öffnet sich der Exporer im 

Verzeichniss in dem das Dokument liegt und selectiert dieses.

03.09.2010 2,0678 J.Fes Settings CheckBox Ver.Info 

Check.Settings

umfangreiche anpassungen durchgefÃ¼hrt um die Vergleiche beim Kunden auf die Version angemessen einstellen zu kÃ¶nnen"

01.09.2010 2,0676 J.Fes Scripts/Params. Ver.Info Neue Gittervariablen #TcUser# und #TcUserPassword# verfuegbar

30.08.2010 2,0675 J.Fes JobControl Ver.Info Reboot des JobClients kann jetzt durch den JobServer ausgelöst werden.

30.08.2010 2,0675 J.Fes JobControl Ver.Info der JobClient kann jetzt via ctr+f FinishAndQuit oder via ctr+c FinishAndReboot beendet werden\Info via c kann innerhalb von 

60sec der bootvorgang abgebrochen werden

10.08.2010 2,0668 J.Fes Import Sites/Data 

Import Settings

UpdDb=Yes 

Check.Settings

es kann jetzt festgelegt werden ob AP's(Baugruppen) mit 0 Komponenten als SP(Einzelteil) gewertet werden. 

 siehe:Sites/Data Import 'Imp.Ap wi.CompN=0 As Sp' 

 #Info: alle Default einstellung AP=0 als AP werten bleiben bestehen."

02.08.2010 2,666 J.Fes Import Sites/Data 

Import ObjectList

Ver.Info Beim import via Objects (DS/IRS)->Extras->Import datasets.. 

können jetzt auch mehrere IR's angegeben werden!

28.07.2010 2,0661 J.Fes Import Sites/Data 

Import ObjectList

Ver.Info wenn IR und BOM Strukturen importiert werden wird nach dem Import  

das Ergebnis mit angezeigt

28.07.2010 2,0661 J.Fes Import Sites/Data 

Import ObjectList

Ver.Info

28.07.2010 2,0661 J.Fes Import Sites/Data 

Import ObjectList

Ver.Info

28.07.2010 2,0661 J.Fes Import Sites/Data 

Import ObjectList

Ver.Info

28.07.2010 2,0661 J.Fes Import Sites/Data 

Import ObjectList

Ver.Info

28.07.2010 2,661 J.Fes Import Sites/Data 

Import ObjectList

Ver.Info wenn IR und BOM Strukturen importiert werden wird nach dem Import das Ergebniss mit angezeigt

21.07.2010 2,0658 J.Fes JobControl Settings Ver.Info 

Check.Settings

die Vorgaben für die Zeitsteuerungen wurden für das den JobClient angepasst

15.07.2010 2,0652 J.Fes JobControl Ver.Info JobScript gets now folowing parameter transfered 

- %~1 TcUser  

- %~2 TcPassword

09.07.2010 2,0634 J.Fes Settings UpdDb=Yes neue #Var 

#JobComputers_tbl.Custom01# .. User02#

09.07.2010 2,0634 J.Fes Settings UpdDb=Yes neue #Var 

#JobComputers_tbl.ComputerFQDN#

09.07.2010 2,0635 J.Fes JobControl Ver.Info JobComputer's Spaltenüberschriften überarbeitet

19.06.2010 2,0627 J.Fes Scripts/Params. Ver.Info Change: ScriptEditor Projektfile wurde evtl. falsch gesucht 

Issue is now solved by code changes

03.06.2010 2,0623 J.Fes JobControl Ver.Info JobComputersScript_Execute 

wird jetzt mit AppWinStyle.NormalFocus ausgeführt

02.06.2010 2,0621 J.Fes CheckBox Ver.Info Entities 26 (dimension) text compair added.

02.06.2010 2,0621 J.Fes JobControl Settings Check.Settings JobClient_ReceiveCmdTimeOut default set to min 10 sec Default=120

11.05.2010 2,0616 J.Fes ObjectList Ver.Info NXsimulation eingefügt

04.05.2010 2,0614 J.Fes JobControl Ver.Info All converted constraints in this part were suppressed as they could not solve 

Ein Objekt bei dem ein Validation failed kommt  

wird das Objekt wie folgt gekennzeichnet: 

 - .ProcessResultHasWarning = True   

 - P.ResultMess: Rf.MC Convert Warning:[02]:[All converted constraints in this part were suppressed as they could not solve] 

Info: Analyse wird nur ausgefuehrt wenn der Refile mit Done und Error=0 durchgeführt wurde!
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04.05.2010 2,0614 J.Fes JobControl Ver.Info All converted constraints in this part where suppressed as they could not solve 

Ein Objekt bei dem ein "Validation failed" kommt  

wird das Objekt wie folgt gekennzeichnet: 

 - .ProcessResultHasWarning = True  

 - P.ResultMess: "Rf.MC Convert Warning:[02]:[All converted constraints in this part were suppressed as they could not solve] 

Info: Analyse wird nur ausgefuehrt wenn der Refile mit Done und Error=0 durchgefÃ¼hrt wurde!"

23.04.2010 2,0606 J.Fes ObjectList Ver.Info Suchfilter erweitert um Sucheigenschaft Proccesed.On.Compuer

15.04.2010 2,06 J.Fes JobControl Settings Ver.Info 

Check.Settings

in all script files that are located in the JobScript directory and files having the extensions *.cmd;*.bat;*.ps1;*.pl;*.txt 

the #GitterVar# are replaced

25.03.2010 2,0591 J.Fes GUI Import ObjectList Ver.Info Object Daten können über: [Object's having Import Error's] aufgelistet werden

25.03.2010 2,0591 J.Fes GUI ObjectList Ver.Info Object Daten können über: [Object's having FS HitCount's >0] aufgelistet werden

23.03.2010 2,0589 J.Fes TaskScheduler Ver.Info wenn die Objekte eines Task's keine 'UGMASTER' Objekte beinhaltet wird sofort Proc_NonMaster geschaltet. 

Vorteil: NonMaster Objete werden dann gleich bearbeitet. 

Info diese Regel wird nur dann beachtet wenn die zugehörige Prozessgruppe die Einstellung 

JobServerObject_UGMaster_Befor_UGNonMaster=true eingestellt wurde

23.03.2010 2,0589 J.Fes TaskScheduler Ver.Info wiederhol Task's werden jetzt korrekt ausgeführt

18.03.2010 2,0588 J.Fes JobControl Ver.Info Gitter Variablen erweitert es stehen jetzt folgende Variablen zur verfügung 

-JobRule.SelObjectsBy_*  

-#JobRule.TimeSchedule#  

-#JobRule.validForComputer#

22.01.2010 2,052 J.Fes JobControl Ver.Info Refile analysiert MC to AC konvertierung 

gibt die Details des betroffen Subsection aus

22.01.2010 2,052 J.Fes JobControl Ver.Info Refile analysiert MC to AC konvertierung 

gibt die Details des betroffen Subsection aus

18.01.2010 2,0566 J.Fes ProcessGroups 

Settings

Ver.Info 

Check.Settings

In den ProcessGroups können Rechte Bedingungen vergeben werden wer diese ProcessGroup im JobPlaner angezeigt bekommt 

siehe:JobServer Process Groups->ProcessGroup01..->UserAcceesRules.."

14.01.2010 2,0565 J.Fes JobControl Ver.Info Wird ein freies SQL Script für die Objekt selection verwendet so können jetzt  

Gittervariablen mit verwendet werden. 

Bspl.:#TcSiteId#=Site #ProcStateVal#=StartVal (N,M,A..)

14.01.2010 2,0565 J.Fes JobControl Ver.Info Gitter Variablen erweitert es stehen jetzt folgende Variablen zur verfügung 

-#ProcStateCol# ProcStateCol01..20 + Rf 

-#ProcStateVal# Start M,N,A 

-#ObjectType# UGMASTER.. 

-#ObjectClass# DS IR"

06.01.2010 2,056 J.Fes ObjectJobResults 

Settings

Ver.Info + New.Settings(Scripts)In Generischen JobResult Files können jetzt 

- an 7.ter Stelle JobServerExtendCommandsTrigger mitgegeben werden /ProcessStateSetTo=D.NX4 

 gibt vor welcher ProzessStatus gesetzt werden soll

16.12.2009 2,0558 J.Fes TaskScheduler UpdDb=Yes in den Task's kann fesgelegt werden welcher Computer einen bestimmten Task ausfuehern darf wenn es nicht der JobServer Comuter 

selbst ist 

Regel:Ist diese Eigenschaft leer so darf dieser Task nur vom JobServer Comuter ausgeführt werden

15.12.2009 2,0557 J.Fes JobControl Settings UpdDb=Yes 

Check.Settings

es können jetzt erweiterte JobScript Parameter einer Job-Script Paramerter definition hinterlegt werden.

12.12.2009 2,0555 J.Fes ObjectList Settings Ver.Info Object_open_via_NXRouter 

es wurde eine Exeption aus geloest wenn UGII_ROOT_DIR und ServerSettings.UGII_ROOT_DIR_SEARCH_P nicht gesetzt waren

12.12.2009 2,555 J.Fes ObjectList Settings Ver.Info Object_open_via_NXRouter 

es wurde eine Exeption aus geloest wenn UGII_ROOT_DIR und ServerSettings.UGII_ROOT_DIR_SEARCH_P nicht gesetzt waren

06.12.2009 2,0554 J.Fes GUI Ver.Info eine nicht abgefangene Exception die beim arbeiten mit der interaktiven Application auftritt wird jetzt abgefanngen und eine 

Meldung im jeweis aktiven Info Fenster ausgegeben

10.11.2009 2,055 J.Fes Scripting Ver.Info Scripting extended so that customer files can be added to the job 

Example: JobDef.JobFiles.JobCustomFiles.JobCustomFiles.Add(New 

JF.PlmJobManager.JobServer.JobManager_JobControlNextPaket_cls.JobFile_cls.JobCustomFileDef_cls("TEST", ".cmd"))"

05.11.2009 2,0549 J.Fes JobControl Ver.Info Objects select 'Bevor' 'After' werden jetzt vom JobControler berücksichtigt
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02.11.2009 2,0548 J.Fes Import Sites/Data 

Import Settings

UpdDb=Yes 

Check.Settings

in den SiteDef Connetion TimeOut Optionen ergänzt 

-DbConnectionTimeOut [default=60] 

-DbCommandTimeout [default=120]

02.11.2009 2,0548 J.Fes Import Ver.Info table mapping umgestellt von: 

-select count(*) from 

-select top 1 * from

24.10.2009 2,0545 J.Fes JobControl Ver.Info bei den JobRoules können jetzt via !NOT! Regel Computer ausgeschlossen werden. 

Example: via CName*!NOT!CName4CName2* 

Info: der !NOT! Part ist dominierend.

21.10.2009 2,0543 J.Fes JobControl Settings UpdDb=Yes 

Check.Settings

in den JobRules kann jetzt festgelegt werden wie PFM Parts selectiert werden (PFM.Ignor,PFM.No,PFM.Only)

16.10.2009 2,0541 J.Fes GUI ObjectList Ver.Info in der Oberfläche kann jetzt auch über den PFM Namen gefiltert werden\diese ermöglicht alle Parts einer PFM auflisten zu 

lassen

24.09.2009 2,0538 J.Fes JobControl Settings Ver.Info 

Check.Settings

SelObjectsBy_MaxComponents=0 SelObjectsBy_MinComponents=0 wird jetzt berücksichtigt 

JobControl Regeln prüfen bezüglich SelObjectsBy_MaxComponents SelObjectsBy_MinComponents

17.09.2009 2,0536 J.Fes JobControl Settings Ver.Info Dir_DataRoot_DP_91JobControl neu hinzugefügt 

 in diese Verzeichniss sind JobControls Files abzulegen 

 Einsatzbeispiel: Ablage von JobFiles die via JobServerScripte verarbeitet werden

24.08.2009 2,0534 J.Fes ObjectJobResults 

Settings

Ver.Info 

Check.Settings

(Scripts)Aus Generischen JobResult Files kann jetzt\- an 6.ter Stelle ein JobLink mitgegeben werden

24.08.2009 2,0534 J.Fes ObjectJobResults 

Settings

Ver.Info 

Check.Settings

(Scripts)Aus Generischen JobResult Files kann jetzt 

- an 5.ter Stelle angegeben werden ob das Ergebniss ein Warning hat (true or 1=has warning) (false or 0=no warning)

24.08.2009 2,0534 J.Fes Import Ver.Info Beim importieren der Daten aus TC in die JM.DB wird berücksichtigt  

das Datum und Zeit von IContr:Ir.ModDateBegin nicht vor dem Start des Importbegins liegt.

14.08.2009 2,0532 J.Fes Install and Setup DB UpdDb=Yes Optimice DB ReOrg. Datenbank Maintain eingebaut 

Siehe Extras->Setup->Setup Database->Database Maintain->23 - Optimice DB (compress DB and Reorg. Indices via OSQL)

12.08.2009 2,0531 J.Fes Install and Setup DB UpdDb=Yes Optimice DB Indices in Datenbank Maintain eingebaut 

Siehe Extras->Setup->Setup Database->Database Maintain->22 - Optimice Index (Reorg. Indices via OSQL)

12.08.2009 2,0531 J.Fes Install and Setup Ver.Info neuer Schater Upgrade Database erstellt 

Siehe Extras->Setup->Setup Database->Database Setup->Database Upgrade Database

21.07.2009 2,0528 J.Fes DB Import Sites/Data 

Import

Ver.Info Es wurde ein neuer Schalter für das testen der Verbindung zur TC DB erstellt

17.07.2009 2,0527 J.Fes Import Sites/Data 

Import Settings

Check.Settings Sites/Data Import Ora.Bin jetzt für 32+64 bit version verwendbar 

Settings wird im Feld Ora.Bin 'AUTO' eingegben so werden dem Suchpathd die Pfade der 32bit (..03-BinPublic\OraClient\32Bit) 

und 64bit (..03-BinPublic\OraClient\64Bit) DLL Verzeichnisse eingefügt.

17.07.2009 2,0527 J.Fes Install and Setup Ver.Info der installation für den SQL Server wurde der aktuelle Stand der Microsoft SqlSever Express 2005 (Service Pack 3) hinzugefügt 

Info: dieses kann für 32-Bit und 64-Bit installationen verwendet werden

17.07.2009 2,0527 J.Fes Import Sites/Data 

Import Settings

Check.Settings Sites/Data Import Ora.Bin jetzt für 32+64 bit version verwendbar 

Settings wird im Feld Ora.Bin 'AUTO' eingegben so werden dem Suchpathd die Pfade der 32bit (..03-BinPublic\OraClient\32Bit) 

und 64bit (..03-BinPublic\OraClient\64Bit) DLL Verzeichnisse eingefügt.

12.07.2009 2,0526 J.Fes ObjectList Ver.Info suchen über Process Warnings in den Object Process Listen ergänzt

12.07.2009 2,0526 J.Fes ObjectJobResults UpdDb=Yes Ein ObjectJobErgebniss als Warning kennzeichnen 

wenn ein Job zu einem Objekt ein Warning hat dann kann dieser dem Object Job Ergebniss hinzugefügt werden (value=true/false) 

(Bspl. MC-AC-Convert)

12.07.2009 2,0526 J.Fes ObjectJobResults UpdDb=Yes Link zu ObjectJobResult eingefügt 

dieser Link wird genutzt um Verweise zu JobErgebnissen zu organiesieren (Bspl. MC-AC-Convert) 

Develoment Hint use: JobLog_lnkGen(Results_fp.FileDef.File_DPNE)

12.07.2009 2,0526 J.Fes ObjectList Ver.Info Job Links können über die Oberfläche geöffnet werden

12.07.2009 2,526 J.Fes ObjectList Ver.Info Job Links können über die Oberfläche geöffnet werden

03.07.2009 2,0525 J.Fes JobControl UpdDb=Yes selection der Komponenten kann jetzt auch über die APLevels ausgeführt werden 

Hierfür wurden folgende Felder erstellt: 

-SelObjectsBy_MaxApLevels 

-SelObjectsBy_MinApLevels

02.07.2009 2,0524 J.Fes Ver.Info in der Dialogbox für das NX-Refile werden jetzt die gewählten Optionen nach dem drücken von OK korrekt übernommen

24.06.2009 2,0522 J.Fes Settings Ver.Info 

Check.Settings

clear this inputfield to get the default

24.06.2009 2,0522 J.Fes Settings Ver.Info 

Check.Settings

clear this inputfield to get the default
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21.06.2009 2,0521 J.Fes JobControl Ver.Info Extentet Replacment Variables 

-#TcSite.Id# 

-#TcSite.DBNetworkAlias# 

-#TcSite.DBProvider# 

-#TcSite.OracleBin# 

-#TcSite.OracleHome# 

-#TcSite.pName# 

-#TcSite.Tns_Admin# 

-#TcSite.UserName# 

-#TcSite.SiteAktive_bol# 

-#TcSite.pSite_ID# 

-#TcSite.pName# 

-#TcSite.ImportIrLastModDateBegin# 

-#TcSite.ImportIrLastModDateEnd# 

-#TcSite.ImportIrLastRelDateBegin# 

-#TcSite.NativeRoot_DP# 

-#TcSite.NativeMaskAp# 

-#TcSite.NativeFileSysUsing_bol# 

-#TcSite.NativeFileMaskExclude# 

-#TcSite.NativeFileMaskInclude# 

-#TcSite.SiteInfoWith_SiteId_and_pName#"

21.06.2009 2,0521 J.Fes JobControl Ver.Info Extentet Replacment Variables 

-#TcSite.Id# 

-#TcSite.SolutionType# 

-#TcSite.DBNetworkAlias# 

-#TcSite.DBProvider# 

-#TcSite.OracleBin# 

-#TcSite.OracleHome# 

-#TcSite.pName# 

-#TcSite.Tns_Admin# 

-#TcSite.UserName# 

-#TcSite.SiteAktive_bol# 

-#TcSite.pSite_ID# 

-#TcSite.pName# 

-#TcSite.ImportIrLastModDateBegin 

-#TcSite.ImportIrLastModDateEnd 

-#TcSite.NativeRoot_DP# 

-#TcSite.NativeMaskAp# 

-#TcSite.NativeFileSysUsing_bol# 

-#TcSite.NativeFileMaskExclude# 

-#TcSite.NativeFileMaskInclude# 

-#TcSite.SiteInfoWith_SiteId_and_pName#"

18.06.2009 2,052 J.Fes JobControl Ver.Info Refile analysiert MC to AC konvertierung 

Ein Objekt bei dem ein Validation failed kommt  

wird das Objekt wie folgt gekennzeichnet: 

 - .ProcessResultHasWarning = True   

 - P.ResultMess: Rf.MC Convert Warning:[01]:[Validation failed after constraint conversion] 

Info: Analyse wird nur ausgefuehrt wenn der Refile mit Done und Error=0 durchgeführt wurde!

18.06.2009 2,052 J.Fes JobControl Ver.Info Ein Objekt bei dem ein "Validation failed" kommt  

wird das Objekt wie folgt gekennzeichnet: 

 - .ProcessResultHasWarning = True   

 - P.ResultMess: "Rf.MC Convert Warning:[01]:[Validation failed after constraint conversion] 

Info: Analyse wird nur ausgefuehrt wenn der Refile mit Done und Error=0 durchgefÃ¼hrt wurde!"

16.06.2009 2,052 J.Fes DB UpdDb=Yes funktionen fuer die verwaltung des Updates der Datenbanken eingefuehrt 

 verfügbare funktionen: 

- zzzzDbMaintain_valueGet 

- zzzzDbMaintain_valueSave
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29.04.2009 2,0517 J.Fes JobControl 

TaskScheduler

Ver.Info - #JobPlaner_ProcessStepControl# 

- #JobPlaner_TimeSchedule# 

- #JobPlaner_Name# 

- #JobPlaner_NameDescription# 

- #JobPlaner_Description# 

- #JobPlaner_Note# 

- #JobPlaner_Order# 

- #JobPlaner_ProcessLastMsg# 

- #JobPlaner_ProcessLastRunEnd# 

- #JobPlaner_ProcessLastRunStart# 

- #JobPlaner_ProcessObjectsProcStateCol# 

- #JobPlaner_ProcessState# 

- #JobPlaner_ProcessStepControl# 

- #JobPlaner_ProcessType# 

- #JobPlaner_ReDo#"

20.04.2009 2,0512 J.Fes JobControl Settings Check.Settings JobServerGenNewJobTimeOut eingefuegt Info:Setzt die Timeoutzeit die der JobClient max wartet bis das der JobServer ein neuen 

Job erstellt hat

20.04.2009 2,0512 J.Fes Ver.Info :Bugfixder JobClient beendet sich nicht mehr, wenn der JobServer während der JobPaket generierung die Verbindung beendet!

14.04.2009 2,0512 J.Fes Import ProcessGroups 

Refactoring

Ver.Info JobServerObjectImportNewStatusSetTo ist jetzt als default=N, 

bei Bestandskunden (vor 14.04.2009) P.Gr.Editieren und Status der Objekte ändern von X auf N

14.04.2009 2,0512 J.Fes TaskScheduler UpdDb=Yes der Tabelle:'TaskScheduler_tbl' wurde das Feld:'ProcessStepControl' hinzugefügt

14.04.2009 2,0512 J.Fes ProcessGroups Ver.Info ueber die P.Gr kann jetzt gesteuert werden ob die UGMaster Objekte vor den UgNonMaster Objekten verarbeitet werden sollen., 

Hierdurch können die UGMaster Objekte vor den NonMaster Objekten verarbeitet werden!

13.03.2009 2,0506 J.Fes Ver.Info /IRIds_ObjectNames dient zur Ã¼bergabe der IR's aus dem TCE heraus

08.03.2009 2,0505 J.Fes ObjectList Ver.Info Objekte können jetzt nach Assemply Levels gegiltert werden

03.03.2009 2,0505 J.Fes ObjectList Ver.Info Es kann jetzt nach Site und Remote Objects gelistet werden (R+S,S,R)

24.02.2009 2,0504 J.Fes ObjectList UpdDb=Yes Suchen ueber Last Result Optimiert

16.02.2009 2,0504 J.Fes Import Ver.Info Default fuer Import Reconnet angepasst WaitTime=10Sec RetrysMax=3000

16.02.2009 2,0504 J.Fes Import UpdDb=Yes Beim importieren der Daten aus TC in die JM.DB wird automatisch  

Datum und Zeit von IContr:Ir.ModDateBegin auf die jüngste erfolgreich importierte IR gesetzt

14.02.2009 2,0504 J.Fes GUI Ver.Info ]es wird ein neues Logo in SplashScreen angezeigt Vorteil die Grafik ist einfacher Start bei Remote Umgebung besser

23.01.2009 2,0421 J.Fes GUI Ver.Info die Daten der Spalte [ProcessResultCode] werden in abhänikeit von ihrem Wert eingefärbt 

 -Wert=0 Grün 

 -Wert>0 Rot 

 -Wert<=0 Orange 

 -Wert=leer weiss

11.12.2008 2,0411 J.Fes Import Sites/Data 

Import

UpdDb=Yes Abfrage für die ermittlung des RelaseStatus und Datums
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